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zMUD allows you to connect to and play MUDs on the Internet, and provides you many useful tools, such as aliases, actions, macros, keys, buttons, scripts, maps, databases, etc, to make your MUD life easier and more profitable.  
Suggestions for improving zMUD are always welcome.  Support is available to both licensed and trial users on the Support Forums at http://www.zuggsoft.com/forum and via email at support@zuggsoft.com.  The latest version of zMUD can be found in the Download page at http://www.zuggsoft.com/zmud.
zMUD is designed for both the novice MUD player, as well as the advanced player.  For novice players, the built-in list of all MUD games on the Internet makes it easy to get started.  If you are a novice user, don't be intimidated by the large number of commands and features in zMUD.  These features will not get in your way, but they will be waiting for you when you become more advanced.
For advanced users, zMUD can be completely customized and scripted.  You can create "robot" programs that respond to conditions on the MUD and take action for you.  zMUD scripting can even be used to interact with other programs on your computer.  As a scriptable Telnet client, zMUD can be used to automatically monitor a network, control routers, and more.  Given the flexibility and power of zMUD, there is little you cannot accomplish.
For developers, additional tools are available for creating zMUD plugins, allowing you to expand the functions of zMUD beyond what is described in this help file.
This help file is designed to be a reference for zMUD, rather than a tutorial.  While several of the topics in the Getting Started section can be used as tutorials, official tutorials can be found on the Zuggsoft web site at http://www.zuggsoft.com/library.  This help file is also available online at http://www.zuggsoft.com/zmud/help6/helpset.htm.  The online version of the help file contains many screen shots that are not included with the Windows Help version due to space considerations.

Here is an overview of the major topics included in this help file:
Features
List of zMUD features
Getting Started
Information for new users
Preferences
Information on all preferences
Settings
Details about each type of setting and using the Settings Editor
Advanced Topics
Information for power users
Menu Reference
Reference for all menu commands
Command Reference
Reference and syntax for commands
Function Reference
Reference and syntax for built-in functions

MUDsWhat is a MUD?
MUD stands for Multi-User Dungeon, Multi-User Domain, or Multi-User Dimension. Regardless of what it stands for, a MUD is an online environment where multiple users are logged on and interacting with one and other. On some MUDs you only interact with other players that are logged on, similar to an online chat system. On other MUDs you can also interact with a game world where you can explore, fight monsters, and collect treasure, either alone or in the company of other players that are logged on. On some MUDs, the environment itself can be changed and expanded by the players themselves. On others, you must play the game long enough to advance to a Wizard level at which time you can add new areas to the game. Allowing players to change and add to the MUD world itself is one of the unique features that make MUDs so unique and fun. Every MUD you visit will be different in subtle or dramatic ways.
MUDs have been around since the early beginnings of the Internet. The first MUD was written by Roy Trubshaw and Richard Bartle at Essex University in 1979 on a DECsystem-10. For more information about the history of MUDs, take a look at The MUDdex (http://www.apocalypse.org/pub/u/lpb/muddex/) created by Lauren P. Burka.
For more information about MUDs, visit the incredible MUD Connector (http://www.mudconnector.com). This site has a detailed list of most every MUD on the Internet, along with every else you ever wanted to know about MUDs.
zMUD uses the MUD listing from the MUD connector as the database for its internal MUD Connection Wizard. You can select MUDs and view their description.  zMUD also allows you to search the MUD list for various keywords.  The entire MUD list can be quickly updated with records added or changed since your last update.

FeaturesfeaturesFeatures
zMUD has unique features for both beginning MUD players, as well as for power wizards builders and coders accustom to clients like TINTIN.  Don't be fooled by imitations; zMUD is the most standards-based and feature-rich MUD client available, with over 25,000 registered users, worldwide.  Here is a list of major features:
Standards
MUD Sound Protocol
Support for the MUD Sound Protocol (MSP) allows the MUD to trigger sound effects and background music. zMUD can play up to 16 sounds at the same time as the background music and can chain multiple sound effects together.
MUD Extension Protocol
Supports the MXP markup language, which, similar to HTML and XML, allows your to add rich content to your MUD screen.
MUD Client Compression Protocol
Supports the compression protocol, allowing you to play even faster than ever.
ANSI
full ANSI color support, and cursor support.  Colors are user-configurable.
VT100
full VT100 terminal emulation, including cursor movement and scrolling regions.  Great for MUDs with status lines
Telnet 
Works in both line-based MUD mode as well as character-based Telnet mode.  You can use zMUD to log into your Internet Provider’s UNIX shell account.  Supports Terminal Type, NAWS, and many other telnet options.
Proxy Support
Compatible with the SOCKS proxy standard.  Can also be used with dedicated Telnet proxy servers.
Compatibility
90% compatibility with TINTIN and TINTIN+ text-based clients.  Includes a TINTIN++ script importing and conversion facility.
Windows Compatible
developed and tested on Windows 2000.  Also tested and supported on Windows 95, Windows 98, Windows ME, and Windows NT 4.0.
Features
Automatic Mapping
Create a graphical map as you walk around the MUD.  zMUD was the first MUD client to include this feature, and is still the only client that supports mapping on any MUD.   The map handles 8 standard directions plus custom teleport directions, doors, multiple levels, one-way links, room colors, multiple zones, custom labels, and much more.  Double click on a room and it will automatically speedwalk you to the room from wherever you are using the shortest path!
Database
User-defineable database for storing information on equipment, monsters, other players, etc. Can be queried and scripted from the command line, or you can use the powerful GUI interface.
Buttons
User-definable button bar for executing commands, keeping track of character status, or controlling your character.
Gauges
Special gauge buttons allow you to visually monitor any variable or condition.
Connection Wizard
Uses the master MUD list from the MUD Connector to make it easy to browse all the MUDs on the Internet. Over 1000 MUDs in the list!  You can easily update this list, or add your own entries to it.
Character Database
Keeps a database of all of your MUD characters, and detailed notes for each one. Uses an Explorer-like interface to make it easy to select the character you want to play.
Multiplaying
Supports multiple characters in multiple windows and methods to send commands to different windows. Can also capture text and send it to a secondary window. Window captions can be placed on the left side to provide the maximum number of text lines.  Multiple windows can be docked together for the most flexible arrangement.  Once you get the windows the way you want them, a simple Save Layout remembers your arrangement for next time.
Macro keys
assign text or commands to any key combination on the keyboard
Aliases
assign text or commands to shortcut names to save typing
Triggers
execute commands based upon patterns received from MUD.  Sophisticated pattern matching functions are provided.
Variables
both text and numeric variables saved with your session
Functions
Built-in as well as user defined functions.  zMUD contains a powerful programming language.
Paths
let you record directions to MUD locations, and even play them back in reverse.  Called speedwalking in some clients.  Path commands can be customized.
Spam protection
prevents you from sending the same string to the MUD too many times and being flagged a spammer
Multimedia
Allows you to trigger sounds, MIDI, movies, etc.
Scripts
store commands in a text file and read them in as a script
Syntax checking and Debugging
A power syntax checker points out mistakes in your scripts.  Then use the debugger to single-step through your scripts, or set breakpoints and watch variables.
Tab completion
allows you to enter long strings of text by typing the first few characters and then pressing <TAB> to fill in the rest.  Shift-<TAB> recalls the last long word sent by the MUD that started with a given character.
History
command history of last commands with customizable storage limit
Logging
log your session to a file for review at a later time.  Log file supports ANSI color
Timer
a built-in timer allows you to take control of ticks
Status line
customizable line shows the status of variables and triggers
Customizable
colors, fonts, sounds, special characters can all be modified and saved.
Settings files
saves all settings (aliases, macros, etc).  You can have a single settings file for several characters.
Online Help
extensive online help system provides both reference and examples.  Context-sensitive command help is also a keystroke away.
Command Wizard
command and function wizards show zMUD programming syntax and help you create commands and functions
International Support
zMUD is designed to work with international keyboards, and non-English language MUDs.  zMUD itself has been translated into many different languages.  Check the www.zuggsoft.com web site for special versions for other languages.
Fast
Benchmarked against other Windows MUD and Telnet clients as the fastest scrolling client available.
GUI
provides both a GUI interface as well as a traditional command line interface.  Output can be scrolled and word-wrapped, and window can be frozen to prevent unwanted scrolling, and splitscreen shows scrollback at same time as live text.  Scrollback buffer can be as large as your computer's memory can hold.

LicensingregisteringLicensing
zMUD is available as a 30-day trial evaluation.  To use zMUD after 30 days, you must purchase it.  To purchase zMUD, click the Purchase button that appears on the Trial screen.  If you want to purchase zMUD and do not have a credit card, go to the BUY page on www.zuggsoft.com for more ordering options.
If you are having problems with your license, you can find solutions in the eLicense FAQ.
zMUD Copy Protection
zMUD uses the eLicense technology from ViaTech for its copy protection.  The eLicense technology controls the 30-day trial period for zMUD, as well as the purchased license.
eLicense uses sophisticated encryption and digital signature algorithms to protect the zMUD license. Attempts to modify the zMUD software, use an invalid registration code, or attempts to circumvent the copy protection can cause zMUD to stop functioning. In addition, such illegal activities may prevent the user from using zMUD or any future Zugg Software products in the future.  Tampering with the eLicense software can cause any other software on your system that uses eLicense to stop functioning.
Unlike zMUD versions 5.x, zMUD does NOT contact any remote server or send any information to any remote server.  The eLicense server is only contacted when you first use the Purchase button to buy zMUD, or when you Unlicense and Relicense an existing Order ID.  Once you have purchased zMUD, it will not communicate with the eLicense server again, until you Unlicense or Return the product.
zMUD MAY contact a remote server to determine if a new version of zMUD is available.  No information is sent to this remote server.  The remote server returns the latest version information, and zMUD than asks you if you want to upgrade.  This feature can be disabled in the zMUD Preferences.
Licensing
zMUD is licensed to a single user.  You may install zMUD on up to 3 different computer systems.  To use zMUD on more than 3 computers, you must purchase additional licenses.  Each additional license adds one more computer to your allowed number of copies.
You can move a license from one machine to another.  To move a license, right-click on the ZMUD.EXE file and select Unlicense.  Then use your Order ID to install a copy of zMUD on another computer.
Your zMUD licenses are tied to the specific computer zMUD was installed on.  If you copy zMUD to a different computer, zMUD will revert to Trial mode.  Before reinstalling Windows or reformatting your hard disk, you should Unlicense zMUD to prevent your license from being lost.  Zugg Software cannot restore licenses that are lost as a result of this.
To Unlicense zMUD, right-click on the ZMUD.EXE icon and select Unlicense from the eLicense options, or open the eLicense Control Panel, select Zugg Software, then right-click on zMUD.

Getting Startedgetting startedGetting Started
The very first time you start zMUD, you will need to read and accept the licensing terms.  After accepting the licensing terms, you are presented with zMUD’s main welcome dialog.  The first time you view this main window, a Getting Started message will be displayed.
Follow the instructions and click the New button to create a new character, or the OK button to go to the normal startup screen where you can manage your MUD characters.
The steps in getting started with zMUD are:
Network Setup
Quick Start
Basic usage
User Interface
Create a new character
Character Database
Using Sounds
Scripting
Introduction to Aliases
Introduction to Macros
Introduction to Variables
Global Settings
Introduction to Classes
Introduction to Triggers
Introduction to Buttons
Introduction to Multiplaying
Debugging Scripts
Introduction to the Database
Introduction to Mapping

Network Setup Proxy FirewallNetwork SetupNetwork Setup
To use zMUD, you must have a connection to the Internet.  Usually this connection is made through dialup software that uses SLIP or PPP protocols, but it might also be through a direct LAN connection.  If you can run other network software such as Web Browsers or email programs, your computer is probably set up properly to run zMUD.  If you have trouble connecting to MUDs using zMUD, consult some of the topics below for more help.
AOL Users
To use zMUD, your network software must support 32-bit programs.  Earlier versions of AOL software did not support this.  So, if you are having trouble using zMUD on AOL, make sure you are using AOL version 3.0 or higher.  When using more recent versions of AOL, you might need to turn off some of their firewall or blocking features.  These features can sometimes prevent connecting to your MUD server.
Proxies and Firewalls
Some people are connected to the Internet via a Proxy Server or Firewall.  Support for SOCKS4 and SOCKS5 compatible Proxy Servers, regular Telnet Proxy servers, and WWW Proxy Hosts is built in.  To configure zMUD for these types of connections, select the Preferences option in the Edit menu at the main Character screen, or select Preferences while inside zMUD.  Go to the Proxy settings page.  Select whether you are using a SOCKS4, SOCKS5, Telnet proxy, or WWW Proxy.  SOCKS4 is the preferred option and is supported by most modern firewalls.  Simply enter the hostname or IP address of the Proxy server, along with the port that its SOCKS4 service runs on, which is usually 1080.  If your server requires a username to connect, enter the proper name into the username field.
For a Telnet Proxy, enter the hostname or IP address of the Telnet Proxy server, along with the port that it is running on, which is usually port 23.  Then you need to specify the command needed by your Telnet Proxy to connect to an outside MUD.  Usually this command is just the MUD host name and the MUD port number, separated by a space.  Use the %host variable for the hostname and the %port variable for the port number.  Any other variables or zMUD functions may be used in this command to form a proper command to send to the proxy server to connect you.
Note that for any of the Proxy server setup to function, you must have DNS installed and running properly on your computer.  Check with your Network or System Administrator to ensure that this is set up properly.
Cannot Lookup IP Addresses
The Domain Name Service (DNS) provides a mechanism to convert hostnames into the numeric IP address needed for zMUD to connect to a MUD.  You must have DNS set up properly to use zMUD, or else you will have to specify the IP address manually in the Hostname field for the MUD in the Character database.  Most network providers set up the DNS server information automatically when you connect.  If you experience problems with this, contact your Internet Provider or your Network Manager.

Quick StartMUD listwizardwizard,connectauto loginloginlogin,autoQuick Start
To get started quickly, click the New button in the main Character window.  zMUD will read a list of MUDs contained in the MUDLIST.MDB file and display them on the left.  Simply select your favorite MUD from this list, or enter the Hostname and Port of the MUD you want to connect to in the boxes.  Then click the Connect button to save this character and connect to the MUD.
Connecting to a MUD
zMUD will attempt to connect to the MUD that you have selected.  Once connected, the MUD will normally ask for your username, followed by your password.  Once you have entered this information, zMUD will ask if you want to create an auto-loginThe first time you log into a new MUD, zMUD tries to automatically detect your character name and password information in order to create triggers to log you in automatically the next time.
If the information shown in this dialog is correct, click Yes and zMUD will create the autolog triggers for you.  If the information is wrong, click No.  If you just created a new character on this MUD, the prompts are different than those given when you log in with an existing character, click No and let zMUD detect the information again when you log in the next time.
If you want to prevent this dialog from appearing, click the Stop Asking button..

 trigger for this MUD.  If you select Yes, auto-login triggers will be created, and your character name and password will be saved to the character database.  Be sure and save your settings file before you exit so that this login trigger will get saved.
That’s all there is to it!  You are now connected and playing a MUD.  You can continue through this help section for more information to help you get started with zMUD.
Troubleshooting: If you have trouble connecting to a MUD and get the error message "can’t lookup address", then you probably have an incorrect nameserver setup.  Setting up a proper nameserver for your Internet connection is beyond the scope of this document, however, there is a work-around for this.  When using the Connection Wizard, both the host name and the host address are displayed.  If you are having trouble connecting to the name, simply click the USE button to use the address rather than the hostname.  This will prevent zMUD from trying to look up the address from a nameserver.  This will typically allow you to connect to the MUD.  If the MUD administrators ever change the address of their machine, your connection will stop working until you enter the new address.  Also make sure you are running network software that supports 32-bit programs.  For example, if you are an AOL user, you must use AOL version 3.0 or higher with zMUD.
Sample Files
The full version of zMUD ships with several sample files designed to illustrate some of the things you can do with zMUD.  Simply click the "Sample MUD" character icon in the main window, then click Offline.  Do not click Connect...there is no actual MUD associated with the sample files..  A sample MUD window will open, along with a sample map and sample database file.  You can explore the sample settings in this file to get ideas for triggers for your own MUD characters.

Basic Usagecommand entrylogging onBasic Usage
Once you are connected to the MUD, you will typically be prompted for your character name and password.  zMUD tries to auto-detect this, and will pop-up a dialog with your character name and password and ask if you want zMUD to create an auto-login trigger for you.  If you click OK, then the next time you log-in, zMUD will automatically enter your character name and password.  If you click Cancel, this trigger will not be created for you.  Of course, the next time you log in, zMUD will ask about creating the trigger again.  If you want to stop zMUD from auto-detecting your login process, simply go into the character database and fill in a value for your character name.
Note that the text you type appears in the bottom Command Line entry field.  When you press <Enter>, the text in this field is sent to the MUD.  It is also echoed to your text window if you have the Echo flag enabled (default is enabled) using the current command color (changeable in the Color preferences).
When you enter your password, it will also be echoed to the screen.  To prevent this, use the #PW command.  Type #PW and press <Enter>.  The password for this character that you entered in the Character Database will be sent to the MUD, but it will not be echoed to the text window.  Also note that # is the default command character and you can change this in the Preferences dialog as described later.
The Command Line
Once you have entered your character name and password, answer any other questions displayed by the MUD.  All of the text that you type will be shown in the command line.  You can use the <Backspace> key to edit this line.  You can also move the insertion point within the command line by clicking the mouse at the point you want to start typing.  If you have a separate set of arrow keys on your keyboard, you can use the right and left arrow to move within the command line.  Note that the keys on the numeric keypad have macros assigned to them by default so they cannot be used as arrow keys.  When you press <Enter>, the text in the command entry field is sent to the MUD.  If the Echo flag is enabled, it will be shown in the large text window in the current command color
You can enter multiple commands on the same line using the Separator character, which defaults to semi-colon (;).  Thus, eat bread;drink water will send the two commands eat bread and drink water to the MUD in quick succession.  Also, when commands are sent to the MUD from the command line, a newline (CR/LF) is always added to the end automatically.  
The command line can contain more than one line at a time.  As you type, the text will automatically word-wrap at the right-edge of the line and the command line will expand to show the entire text string.  Note that even though the text is displayed on a second line, it is still considered one line by zMUD and will be sent to the MUD as a single line.  To add an actual second line, press Ctrl-Enter to force a hard new-line in the command.  This works just like the command separator character.  To clear the line, press the ESC key.  Note that you can turn off the word-wrap setting in the Preferences.
Commands that you send to the MUD are stored in your Command History, which, by default, contains th last 20 command lines you have sent to the MUD.  With the cursor on the first line of the command line, press UP-Arrow to recall the last command you entered.  Press UP-Arrow again to recall the next command, and so on.  If the cursor is in the last line of the command line, pressing Down-arrow will move the opposite direction through the command history.  Or, if you have started typing a command, pressing Down-arrow will store the command in the command history without sending it.
The Down-arrow "save" feature is very useful if you are in the middle of typing a long message and you need to do something on the MUD quickly.  Just press Down-arrow to save your command in the command buffer without sending it, then type the command you need to send to the MUD quickly and press Enter.  Now that the command has been send, press Up-arrow to retrieve your long command and continue working on it, and press Enter when you are ready to send it to the MUD.
The Output Window
You can scroll the main MUD window by clicking the scrollbars to the right and below the main window.  You can also use the PgUp and PgDn keys on the keyboard (but again, not the number pad).  When you scroll the window, the screen is split, with the scrollback shown above and the live text from the MUD shown at the bottom.  The split bar can be dragged to any position to see as much or as little live text as desired.  Once the screen is split, the Shift-Up and Shift-Down arrows can be used to move line by line, or the PgUp and PdDn keys can be used to scroll a page at a time.  You can still type commands in the command line and send them to the MUD while the screen is split.  To unsplit the window and automatically return to the bottom of the scroll buffer, click the Pause button in the lower right corner of the window, or press the Ctrl-Z key, or press the ScrollLock key, or type #FREEZE on the command line.  You can also unsplit the window by dragging the scroll bar to the bottom.
You can search for text in the output window using the Find command in the Edit menu, or by pressing Ctrl-F.  You can search backwards (default) and forwards through the buffer.  Since this buffer can grow quite large, especially in the 32-bit version of zMUD, the Find command is very handy for rapidly locating past text.  The screen is automatically split when the text is found so that you can view the scrollback buffer and the live text at the same time.
You can also copy text from the output window and paste it into other programs.  When you highlight text with the mouse (click the left button at the starting location, drag the mouse with the left button still held, then release the mouse button at the end location) the screen is automatically frozen to prevent scrolling from disturbing your selection.  When you release the mouse button, the text is automatically copied to the clipboard.  You can select large portions of text (more that a screenful) by left clicking the start location, the left clicking while holding the Shift key at the end location.  If you double-left-click, the word under the mouse is highlighted then copied to the clipboard. If you left-click in the narrow margin to the left of a line, the entire line will be selected.
Contents of the screen are stored to the clipboard in both plain ASCII text format and in color ANSI format.  When you paste to an external program like Notepad, the plain text format is used.  If you paste to the Command Editor the ANSI color format is used to preserve MUD colors.  If you paste to the Command Line, plain text is used unless you have defined a color translation syntax in the color preferences in which case the ANSI color is converted to color commands for your MUD.  If you paste more than one line of text into the command line, the line breaks are replaced with the command separator character (;).

User Interface OverviewUser Interface OverviewUser Interface Overview
zMUD provides many special features that enhance the user interface or that allow you to customize the user interface to your preference.  In general, if you find something about the zMUD user interface annoying, there is usually a way to change it.
New Window Caption Buttons
On the caption bar of most zMUD windows are some new buttons.  In addition to the standard Minimize, Maximize, and Close buttons, many windows also have Rollup/Rolldown and Stay-On-Top buttons.  MUD Output windows and the main zMUD menu window also have a partial maximize button.
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 Rollup/Rolldown
These buttons collapse the window so that just the window caption is shown (Rollup), or expands the window back to its normal size (Rolldown).
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 Stay On Top
When this button is clicked, the window is set to stay on top of other windows.  This function is a toggle.  When the Stay On Top function is active, the button appears depressed.  Note that there are bugs in Windows when dealing with multiple StayOnTop windows.
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 Partial expand
When the + button is clicked, the MUD output window expands to fill the entire without covering the main zMUD menu window.  When the - button is clicked, the window returns to its previous size and location.  This button is similar to the standard Windows Maximize button, but the Windows Maximize button will cause the MUD window to cover the menu window.  
When this button is used on the main zMUD menu window, the + button causes the menu window to move to the top of the screen and to expand to the full width of the screen.  If the common command line is visible, it is moved to the bottom of the screen.
All of these functions are also available via the System menu (Ctrl-Space) in the upper left corner of the window.
Window
The Layout menu is used to select several window tiling options.  These options can be used to control how multiple windows are layered on the screen.  You can select Auto Tiling which keeps the tiling option you select in effect at all times, or Quick Tiling which changes the size and position of windows but then unlocks them so you can adjust them yourself.
To switch between windows on the screen, click on the desired window, or select it from the Windows menu.  Also, you can display a Window Tab bar beneath the toolbar in the main zMUD menu window (by default), or along with the common command line described below.  You can also switch between windows using the Ctrl-Tab or Ctrl-N keys.  To change the name of a window, use the #NAME command.
Task Bar Icons
If you prefer having icons for your windows in the Windows Task Bar, you can turn these options on in the Windows Preferences page.  Or, if you prefer fewer icons, turn these options off.
Toolbars
Many zMUD windows contain toolbars at the top just beneath the menu bar.  The buttons on these toolbars normally consist of both an icon and a text label.  You can customize these toolbars by right-clicking on them and deciding whether you want text labels, icons, or both.
Command Lines
By default, each new MUD window has its own command line at the bottom of the window.  This allows each window to maintain a separate command history as well.  If you prefer having a common command line for all of your MUD windows with a common command history, right-click your MUD window to bring up the Window Options menu and turn off the Show Command Line option.  This removes the command line within the window and activates the command command line.
Child windows created with the #WINDOW or #CAPTURE commands normally do not have a command line or status bar associated with them, but you can turn these on by right-clicking the window.  To save the settings of a child window, save them to a file with the same name as the window.  For example, if the window is named "Tells", save the settings to the file Tells.mud.  This allows you to customize colors, fonts, and window options for your child windows and have them restored the next time you use that window.
The status bar displayed at the bottom of a MUD window can be turned on and off via the right-click Windows option menu as well.  Or you can turn off the MUD Output window itself using the option in the Window option menu.
Using the MouseWheel
zMUD supports mice such as the Intellimouse that have a wheel on them.  This wheel can be used to scroll the main MUD window or the Editor window.  In addition, whenever you are using a numeric input control, the mouse wheel can be used to increment and decrement the value of the number.
Window Docking
Windows in zMUD can be "docked" together into a single panel which can then be moved and resized as a single window.  For example, it is useful to dock your child windows from the #CAPTURE command to the top of your current MUD window where you can always see them.  Others like to dock the mapper window to the right side of the MUD window so that it is always visible.  
Windows can be docked side-by-side (either vertically, or horizontally), or can be docked on top of each other, creating a window-tab for each window that overlaps.
To prevent windows from docking as they are being moved, hold down the CTRL key.  You can also turn on an option in your Preferences that will require you to hold down the ALT key to dock windows instead of having windows docking automatically.
In addition to the MUD character windows and their child "capture" windows, the other windows that can be docked are: Settings Editor, Mapper, Database, and Status Window.
Layouts
An arrangement of windows on your screen is called a layout.   Once you have arranged and docked your windows the way you want them, you can save this layout using the Save Layout command in the Layout menu.
If only a single MUD character is open, the layout file is stored with that character and will be used the next time you load the character.  To prevent a character from loading with it's saved layout, Edit the character, go to the Files tab, and turn off the Use Layout option.
If more than one MUD character is open when the layout is saved, a special Layout icon is added to your character list.  This icon will work just like a normal MUD character, but when you click Connect or Offline, the layout of windows will be restored.  If you click Connect, all of the MUD characters saved in the layout will be connected to.  This is how you can open multiple characters on the same or different MUDs at the same time.
Note that only one layout can be active at a time.  If you try to load another character layout while a layout is already active, the current layout will be closed.

Creating a Charactercharactercharacter,creatingNew CharacterCreating a Character
To create a new character, click the New button from the Character Database, or select the New|Character option from the File menu.  The New Character dialog will be displayed.
The New Character dialog has several fields for you to enter data.  The cursor is initially placed in the Host field.  Enter the Internet host name or IP address of the MUD you want to connect to.  Then press the <TAB> key and enter the Port number of the MUD you want to play.
Alternatively you can just select a MUD from the list displayed at the left.  This list comes from the MUD Connector at www.mudconnector.com.  This web site maintains an up-to-date list of MUDs.  You can update the file used by zMUD  by clicking the Get button.  This will download a new MUD list from the MUD Connector.
MUDs are categorized by Type (DIKU, LP, MOO, etc).  Most people have certain types of MUDs they like to play and are only interested in MUDs of similar type.  In this case, just click the Search button to filter the list by type of MUD you desire.  If you know the MUD by name and do not care about MUD types, scroll down to is name or use the Search Button to find it faster.
As you select a MUD in the list on the left by clicking on it, details of that MUD are displayed in the window to the right.  These details are taken from the MUD Connector and might vary from MUD to MUD.  Some MUDs provide a URL to a more detailed web page.  You can click on this URL to open your web browser to that page.
Once you have picked a MUD Host and Port, click the Save button to save the character.  You will be returned to the Character Database screen where you can connect to the MUD or edit the character further.  Or, you can just press the Connect button directly from this dialog without pressing Save first.  To abort the creation of a new character, click the Cancel button.

Copying Characters
To create a character on the same MUD as one of your other characters, just select the character you want to copy from the list in the Character Database.  Then use the Copy and Paste options in the Edit Menu.  You may then edit the specifics of the character to be your new character.

Character Databasecharacter databaseCharacter Database
The Character Database is the main window first opened when you run zMUD.  You can also access it any time by selecting Open... in the File menu, or clicking the Chars button in the main toolbar.  The Character Database is used to create, edit, and manage all of your MUD characters.  A MUD character is defined as a specific character that you have created (or will create) for a specific MUD on the Internet.
In the main character display, each of your characters is displayed as an icon with a title.  By default, the title of the icon is the name of the character and the name of the MUD.  For example, "Zugg on Mirkwood" is the character named Zugg on the MUD named Mirkwood.  To connect to one of your existing characters, select the character by clicking on its icon, then click the Connect button in the tool bar for the character dialog.  You can also just double-click on the icon to connect to it, or just press the Enter key if you prefer using the keyboard.  When you connect to a character, zMUD will contact the MUD for that character and attempt to log you in automatically.
You can rename an icon by either selecting Edit and changing the Icon caption, or you can click twice (slowly, not a double-click) on the icon and then type the new name of the icon.
If you want to work on your character settings (aliases, triggers, etc) without actually connecting to the MUD, select your character and click the Offline button (or press the O key).  Your character window will open as normal, but no connection will be made to the MUD game itself.  When you are working on your character offline, you can connect to the MUD by selecting the Reconnect command from the File menu.
The Edit button allows you to edit the properties of your character.  Click the Edit button or press the E key to edit your character.
The New button allows you to create a new MUD character.
The Delete button deletes the currently selected character.  Be careful, there is no way to "undo" a deletion.  You can also just press the Delete key on the keyboard to delete your current character.
The View button allows you to change how your characters are displayed.  It works similar to the View options in the Windows Explorer.  You can view your characters by large icons, small icons, in a list, or in detail.  When viewing the detailed list you can sort on any column by clicking on the column heading.  Clicking a second time reverses the sort order.  For example, clicking on the Date column once will display your characters by the date you last connected to them, with your most recent characters at the top.  If you click on the Date column again, the oldest character will be displayed first.
Many of these functions are also available by right-clicking on the screen.  If you right-click a character you can Connect, work Offline, Delete, Edit, and change the View settings.  As with most 32-bit Windows 95 and Windows NT programs, right-clicking in zMUD usually brings up a context-sensitive menu.  You can select the Notes command by right-clicking on your character to view any notes you want to associate with your character in the panel on the left.
Finally, you can open an empty MUD window.  Just press the ESCAPE key or select New|Blank Window from the File menu; and a default, empty window will be displayed.  You can use this to edit the DEFAULT.MUD settings, or for general zMUD testing and debugging.  Keep in mind that you cannot connect to a MUD with an empty window because no hostname or port has been specified.

Edit CharacterEdit CharacterEdit Character (MUD Information)
Your MUD character has many properties that can be edited.  On this first screen you can edit the Internet Host and Post for the MUD, the MUD Name, and the Type of the MUD.  You can also lookup the Internet IP Address for the MUD Host, or Ping the MUD to see if it is currently running.
The tab control along the top of this window allows you to also edit your Character information, Files information, and Notes information.
The Host and Port fields are the most important.  Every MUD has an Internet Host Name and an Internet Port number.  The Host Name is a series of names (not numbers) separated by dots.  For example, www.zuggsoft.com is the Host Name of the Zugg Software web server.  In general, a Host Name refers to the name of a computer connected to the Internet.  A single computer is capable of running several different MUD games, all on the same computer system.  To specify the MUD game that you want, you need to use the Port Number.  Most MUDs will publish the port number that you need to use.  If a number is not given, the default Port Number is 23 (23 is the standard port number for Telnet sessions).
The MUD Type field allows you to select the general type of MUD that you are creating a character on.  This field is used for information only.  The Icon Caption field is normally computed automatically based upon the name of your character and the name of the MUD.  You can enter your own caption for the icon in this field, which automatically turns on the Lock Caption button to disable the automatic caption generator.
The icon used to display this character is shown on the right of the page.  Click the button over the icon to change the icon.  This will bring up an icon selection dialog.  Select the icon you want for this character from the list that is shown.  You can import your own icons into this list using the Import button.  You can import .BMP, .GIF, .JPG or .ICO files.  You can also delete icons you don't want in the list anymore, but you cannot delete any of the internal zMUD icons that are displayed at the beginning of the list.  You can also specify the exact filename of the image file on this screen.
Most computers run the Domain Name Service (DNS) in order to convert an Internet Host Name into the Internet IP address needed to actually connect to the game.  zMUD will automatically attempt to look-up the IP address for a Host when you connect.  You can manually look-up an address by clicking the Lookup button.  If your computer does not support the DNS system, or your MUD does not have a registered Host Name, just enter the known IP address (a set of 4 numbers separated by dots) into the Host field.  Entering an IP address into the Host Name field disables the automatic DNS lookup that zMUD performs.  Do not attempt to edit the IP Address field; that field is just used to display the results of a Lookup operation.
PING is an Internet protocol used to determine if a host computer is reachable.  Clicking the Ping button will sent an echo request to the Host computer and wait for a response.  This is done five times, and the number of times a response was received and the average time between the echo request and response will be displayed.  If you do not get five responses, then some of the echo request packets were lost on the Internet.  This can be caused by a noisy modem, bad connection somewhere on the Internet, or a very busy Internet router.  This type of packet loss can cause "lag" when playing the MUD.  Lag is a delay between commands that you send to the MUD and the response that it generates.  In general, you should try playing MUDs that do not have much lag.

Character informationCharacter informationauto loginloginlogin,autoEdit Character (Character Information)
Your MUD character has many properties that can be edited.  On this screen you can edit your character name, password, ID, and comments.
The tab control along the top of this window allows you to also edit your MUD information, Files information, and Notes information.
The Name and Password fields contain the name and password of your character on the MUD server.  You usually enter this information when you log into the MUD.  The first time you connect to a MUD, these fields will be blank and the MUD will ask you to create a character and specify a password.  The next time you log into the MUD and manually enter your name and password, zMUD will detect this and will automatically fill in these fields in this database screen and will create a trigger to automatically send this information to the MUD for you.  This is called an AutologThe first time you log into a new MUD, zMUD tries to automatically detect your character name and password information in order to create triggers to log you in automatically the next time.
If the information shown in this dialog is correct, click Yes and zMUD will create the autolog triggers for you.  If the information is wrong, click No.  If you just created a new character on this MUD, the prompts are different than those given when you log in with an existing character, click No and let zMUD detect the information again when you log in the next time.
If you want to prevent this dialog from appearing, click the Stop Asking button..

 script.
Make sure you do not set these values to blank if you have an autolog trigger activated.  If zMUD sends a blank value to your MUD, the MUD will usually disconnect you.
zMUD stores your character password in encrypted form.  If you ever forget your password, connect to your character Offline, then go into the Preferences and turn off the Gag Password option, then type

#SHOW %pass
on the command line and your password will be displayed.  zMUD normally deletes any line that contains your password, so you should make your password something the MUD will not normally display.
The Comment field is used to enter a short reminder to yourself about this character.  It can be used for any purpose you want.
This database screen also shows the date and time you last connected to the character along with the total amount of real time you have been connected to the character on the MUD.

Files informationFiles informationEdit Character (Files Information)
Your MUD character has many properties that can be edited.  On this screen you can change the name of your primary and inherited settings file and the name of a folder to organize the files for this MUD.
The tab control along the top of this window allows you to also edit your MUD information, Character information, and Notes information.
A Settings File is used by zMUD to store your preferences, aliases, macros, triggers, paths, buttons, etc.  By default, a Settings File is created for you based upon the name of the MUD.  For example, if you create a character on the Mirkwood MUD, a Settings File called MIRKWOOD.MUD will be created.  If you want to have several characters on the same MUD and do not want to share a Settings File, change the primary filename to something unique for your character.  You can click the folder icon to the right of the input box to browse your local disk for a file.  However, you should generally only use a settings file within the current directory or folder.  Loading a settings file from a different directory can cause weird behavior in zMUD.
Each character can have two Settings Files: Primary and Inherited.  When zMUD loads your character, it first loads any settings in the DEFAULT.MUD file.  This is used to initialize many zMUD settings and cannot be disabled.  Next, settings in your Inherited Settings file are loaded.  Most people do not use this feature, but it allows you to set up common settings that you want to share between several characters.  Inherited settings files can be in the current directory or folder, or can also be stored in the directory containing the ZMUD.EXE file.  After loading your Inherited Settings file, then your Primary Settings file is loaded.  It contains settings specific for this character.
Since you can end of with many files for a particular MUD (including map files, sound files, and settings files), zMUD provides an easy way to organize your MUDs into their own folders or subdirectories.  By default, zMUD creates a Folder based upon the name of the MUD you are playing.  If you want to move your settings into a different folder, enter the name in the Folder field.  IMPORTANT NOTE: If you rename your folder within Windows, the value stored in zMUD is not updated, so make sure you update it by hand or zMUD won't be able to find your settings info.  In general, you should not modify files or directories in your zMUD directory by hand.  Always use the Folder field in this database screen to change the name of your zMUD folders.
At the bottom of this screen you can change the amount of time since you last connected to this character that zMUD uses to flag the character as old.  Old characters are displayed in the main character screen with an exclamation (!) mark next to them.  This is a reminder to log onto the character to prevent it from being deleted by the MUD administrators.  Each MUD has a different policy on deleting old characters.  The zMUD default for flagging old characters is 10 days.

Notes informationNotes informationEdit Character (Notes Information)
Your MUD character has many properties that can be edited.  On this screen you can enter any notes about this character that you want.
The tab control along the top of this window allows you to also edit your MUD information, Character information, and Files information.

Using SoundsUsing Sounds
You can use sounds to enhance your MUD experience.  For example, imagine battling a monster and hearing the clash of steel and the grunts and screams from hitting the monster.  Or, play background sounds and music while you MUD.
zMUD also supports the MUD Sound Protocol (MSP) which enables the MUD itself to trigger sounds on your local system.  For information on the MSP specification details, go to http://www.zuggsoft.com/zmud/msp.htm
The sound driver in zMUD is very detailed and can handle many different sound formats.  In fact, as long as you have the proper Windows drivers on your system to play a sound or multimedia file, zMUD can play it to.  When playing standard WAV files (8-bit mono), you can play up to 8 sounds simultaneously.  When playing other types of sounds, you can only play one at a time.  At the same time as sound effects, you can also play a MID (MIDI) soundtrack in the background.
Using the #PLAY Command
All of this is accomplished with the #PLAY command.  Just specify what you want to play.  The sound files must be within the /sounds subdirectory of your MUD character folder, or in your zMUD directory.  You can also specify a sound path in the Direction preferences to give zMUD a third place to look for your sound files.
Let's say you have a WAV file that says "Ouch" and you want it to play whenever you are badly injured.  Just use #PLAY in a trigger like this:
#TRIGGER {You are BLEEDING!} {#PLAY ouch.wav}
That's all there is to it.  Set up other sounds based upon messages received from the MUD.  Or, play a MUD that uses MUD Sound Protocol (MSP) and the sounds will be triggered automatically!

Introduction to Aliasesaliasesaliases,introductionaliases,specialmapping,advancedmappingIntroduction to Aliases
Aliases are another way to simplify your life of MUD playing.  Basically, aliases allow you to assign any command to a shortcut abbreviation.
The easiest way to create an alias is to type the command or words you want to make a shortcut for, then press Control-A, or select Make Alias from the Action menu.  You will be prompted for the shortcut abbreviation you wish to assign the command to.  For example, enter the text fill waterskin statue and press Control-A.  Then enter fs and click OK.  Now, whenever you enter fs in the command buffer, the string fill waterskin statue will be sent to the MUD.
Note that aliases are only translated if they are the first word in a command.  In the example described above, if you entered the text say fs on the command line, the string say fs is sent to the MUD and fs is not translated.
Aliases Settings Editor
You can edit all of your aliases using the View/Aliases menu command, or by clicking the Alias button in the main toolbar.  This brings up the alias dialog.  All of your aliases (like fs from the above example) are displayed in the list.  To edit an alias, double-click on it, or select it and click the Edit button.  To define a new alias, click the New button and enter the name and commands for the alias.  You can copy an alias by selecting it and using the Copy command in the Edit menu (or the right-click popup menu).  Then select Paste from the Edit menu to make a copy.  Multiple items can be copy and pasted.  To delete an alias, select it and use the Delete command in the Edit menu (or the right-click menu).
This is an example of using the zMUD Settings Editor.  It has a list of your settings, just like Windows Explorer shows a list of your files and directories.  The buttons on the toolbar allow you to select what kinds of settings you wish to view.  For example, to view Aliases, click the Alias button.  To view Triggers, click the Trigger button.  To view more than one item at a time, hold down the Shift or Ctrl key as you click the button.  You can also click the All button to display all settings.
The Details button shows each setting on a separate line.  The List button shows just the names of the settings and allows multiple columns of setting names to be displayed at once.  When the Details button is pressed, you can edit the settings by clicking twice on them (not double-click, click once, then click again just like when renaming a file in the Windows Explorer).  You can also right-click on a setting to see a menu of common actions. 
To open the detailed settings editor, double-click on the setting to edit, or click the Edit button.  The Edit button will always bring the Editor window to the front of all other windows.  You can also dock the editor window to the bottom or right-side of the settings display if you want the editor to always be visible.
The Settings editor is used to edit all kinds of things in zMUD, not just Aliases.  To learn more, go to the Settings Editor topic.
The ALIAS command
Another way to define an alias is using the #ALIAS command.  Commands are typed entirely in the command input line at the bottom of the screen, but perform a function for zMUD and normally don't send any text to the MUD.  Commands are provided for users of text-based MUD clients like TINTIN, and are similar in syntax.  To create an alias with the ALIAS command, type #ALIAS shortcut {command text}.  The command text will then be assigned to the shortcut abbreviation that you supply.  You can also list all aliases by just entering #ALIAS, or you can list the definition of a single alias using #ALIAS shortcut.
Aliases can also contain Parameters.  Parameters are the text following the shortcut.  For example, if you enter fs foo bar, fs is the alias shortcut, foo is the first parameter, bar is the second parameter.  Parameters are assigned to specific numeric variables %1 through %99.  In the previous case, %1 would contain foo, and %2 would contain bar.  You can use these parameters in the alias itself.
For example, define the alias #ALIAS k {kill %1}.  Now when you enter k rabbit, the command kill rabbit is sent to the MUD.  Now, this isn't a very useful example, because if you add text after an aliases (like rabbit in the above example) and the alias doesn't use it as a parameter, the extra text will just be appended to the result of the alias translation.  Thus #ALIAS k kill followed by k rabbit will do the same thing.  However, with parameters you can get more sophisticated.  For example, the alias #ALIAS kk {kill %1;kick %1} followed by kk rabbit will send the commands kill rabbit and kick rabbit to the MUD.
Special Aliases
One last tidbit...if you assign a command to the alias atconnect, it will be executed whenever you connect to the current MUD.  Other special aliases include: atexit which is executed when you exit zMUD, atdisconnect which is executed when you disconnect from the current MUD, onroomcreate which is executed after a new room has been created in the mapper, onroomenter which is executed immediately after room scripts, and onwalkend which is executed after onroomenter for the last room of a walk.

Introduction to Macrosmacrosmacros,introductionIntroduction to Macros
One of the first ways to make zMUD do more than just a dumb TELNET client is to assign commands to keys on your keyboard.
To assign a command to a key, press Control-K, or select Define Key from the Action menu.  You will be prompted to press the key combination that you wish to assign a command to.  Almost any key on the keyboard can be assigned a command, in combination with the Shift, ALT, and Ctrl keys.  If you assign the macro to a key already used by zMUD (like Ctrl-C for Copy), then your macro will override the zMUD command, so be careful about this.  You can control whether your macros override Windows commands (like Alt-F) in your Command Line Preferences.  Also, note that zMUD automatically activates the NUMLOCK mode to allow you to assign macros to the keypad.  If NUMLOCK is off, the keypad functions as the cursor keys.  Since the cursor keys are used to edit the command buffer and recall from the command history, you should refrain from assigning macros to the arrow keys (although you can if you want).
Once you press the key you want to assign a command to (for example, the NUM8 key, the 8 key on the keypad) you will be prompted for the command.  Enter the text you wish to be sent to the MUD when you press this key.  For example, if you were assigning a command to the NUM8 key, you could enter the text north.  Now, when you press the NUM8 key, the text north is sent to the MUD.  Notice that when you press a macro key the text in the command entry field is selected, but is otherwise undisturbed.  This is a very useful feature.  For example, if there is a monster to the north that you want to hit quickly before it can hit you, you can enter kill monster in the command entry field, press the NUM8 key (to move north) quickly followed by pressing <Enter> to send the kill command to the MUD.
Macro Chaining
If you want the text assigned to the macro key to be placed into the command line instead of being sent to the MUD, turn off the "Send to MUD" option in the Macro settings screen.  To append the text of the macro key to the current contents of the command line, turn on the "Append to Command Line" option.  Text will only be appended if the command line is not fully highlighted.
If you turn on the Daisy Chain option, then this macro can be used after other macro keys for a special effect called "Macro Chaining".  When Daisy Chain is enabled, the macro text is appended to the command line if the command line ends in a space character.  Then the whole command line is sent to the MUD.  Otherwise, if the command line doesn't end in a space, the macro command is sent to the MUD normally.
The best way to understand how macro chaining works is to look at an example:
Define a macro key with the string "open " and turn off the "Send to MUD" option, but turn on the "Append" option.  If you assigned this to the F8 key, then pressing F8 would put the text "open " in the command line (without sending it to the MUD).
Next, define a macro with a command of "north" and turn on the Daisy Chain option.  Assign this macro to the NUM8 key on the keypad (actually, zMUD defines this macro for the number pad key automatically, and assigns directions like north, south, east, west to all of the keys on the number pad).
Now, when you press F8, the text "open " is placed in the command line.  Now when you press NUM8, the command "north" is appended to the command line (since it ends with a space) and the command "open north" is sent to the MUD.  However, if you just press NUM8 by itself with nothing on the command line, then the command "north" is just sent to the MUD.

Introduction to Variablesvariablesvariables,introductionIntroduction to Variables
Variables are very similar to aliases.  The important difference between aliases and variables is that aliases are only expanded when at the beginning of a command, while variables are expanded anywhere.  To expand the variable, you precede its name with the @ character.  Note that this is different then TINTIN where variables start with a $.  You can change the variable character in the Preferences dialog if you wish.
To define a variable, you still use the #VARIABLE command.  For example, #VAR container waterskin stores the string ‘waterskin’ into the variable container.  To return the contents of the variable, precede its name with the @ character.  For example, fill @container would expand to fill waterskin.
Another assignment syntax is also provided.  As with some programming languages, you can use the syntax variable=value to assign a value to a variable. All variables are stored internally as character strings, just like aliases.
So, the illustrate the use of variables, with the variable @container defined as shown above, you could now create an alias #ALIAS fs {fill @container statue}.  Now when you enter fs on the command line, the current value of the container variable (waterskin from the above example) is expanded and the command fill waterskin statue is sent to the MUD.  Most commands that create settings do not preform expansion on variables.  The expansion occurs when the setting is used.
Variables are only expanded in the command line when the Expand Vars option is turned on in the General Preferences.  If Expand Vars is turned off and you want to expand a variable in the command line, enclose the variable reference in angle brackets (<>).  For example, if you type fill @container on the command line, fill @container will be sent to the MUD.  However, if fill @container is being executed within an alias or script, then it will be properly expanded.  To force it to expand on the command line, you would enter fill <@container> or turn on the Expand Var option.  
System Variables
There are also several predefined system variables that are maintained by the system.  These variables all begin with the parameter (%) character.  Changing temporary variables does not change the modified status of your settings file, so you aren't prompted to save your settings when you exit.  These system variables are used just like regular variables, except with the % character instead of the @ character.

Global SettingsGlobal Settings
While each MUD character can have it's own aliases, variables, triggers, macros, etc, you can also have global settings.  Global settings allow you to define aliases and variables that can be accessed by any MUD character.  Also, global Buttons allow you to redefine the main zMUD toolbar, and global Menus allow you to redefine the main zMUD menu.
Global Aliases
When an alias name is entered into the command line, zMUD first looks for a local alias with that name.  If one is found, then the local alias is executed.  However, if no matching alias is found, then zMUD searches the global alias list.  If a global alias is found, it is executed.  Global aliases are always executed in the context of the current MUD character.  So, if you refer to a variable within your alias, zMUD will first look for a local variable within the current MUD character.  You can define a global Alias using the #GALIAS command.  Or, select Global Settings in the Settings menu.
Global Variables
Whenever you reference a variable using the @varname syntax, zMUD will first look for a local variable with the given name.  If one is found, then its value is returned.  If no variable name is found within the current MUD character, then zMUD searches the global variable list.  If a global variable is found, then its value is returned.  You can define a global variable using the #GVARIABLE command, or select Global Settings in the Settings menu.
Global Buttons
The main toolbar for zMUD is comprised of buttons defined in the global settings.  Select Global Settings from the Settings menu and then select the Buttons command from the Show menu.  Or, simply right-click on the main zMUD toolbar and select the Customize option.
When a global button on the toolbar is clicked, the commands for the button are executed by the current MUD character.  Typically, the global buttons use the #MENU command to access menu bar commands that don't change from character to character.
Global Menus
While most of the main menu for zMUD is fixed, you can add your own menu items to it using the global menu settings.  Each menu setting will be added to the main menu to the right of the Help topic.  To define a submenu, use a menu class.  See the Menus topic for details on defining menu classes.  Menu items and menu classes work the same way with the global settings.  However, instead of changing the right-click popup menu for a specific MUD character, you are changing the main menu bar of zMUD.

Introduction to ClassesIntroduction to Classes
Classes allow you to group other settings, such as aliases, variables, triggers, etc, into a single group or folder.  In addition to organizing your settings, classes can be enabled and disabled and also allow you to perform some advanced "object-oriented" type of scripting.
Creating a Class
To create a new class, or to switch the current class to an existing class, use the #CLASS command:
#CLASS Class1
will create a new class called Class1, or will switch to that class for all following commands.
Many of the commands for creating settings, such as the #ALIAS command for creating an alias, already contain an argument for specifying the class name.  In the case of an alias, the third argument is the name of the class:
#ALIAS aliasname {commands} "classname"
If the classname doesn't exist, then it is created.  If the classname is not specified, the current class is used.  All settings have an argument like this for specifying the class.
In the Settings Editor, classes are displayed as folders, and you can drag settings into these folders to change the class they are in.  To display all settings no matter what class folder they are in, click the "Show All Classes" button.
Classes can be nested, like subfolders.  To refer to a nested path, seperate the class names with the / character.  So, if Class1 contained a subclass named Class2, you would refer to it as "Class1/Class2".  So, for example:
#ALIAS aliasname {commands} "Class1/Class2"
would create a new alias within the Class2 subclass of Class1.  To refer to a subclass of the current class you are already in, use the syntax "/Subclass".  So, if your current class was already Class1, you could create an alias in the subclass Class2 using the syntax:
#ALIAS aliasname {commands} "/Class2"
Older versions of zMUD use the | character instead of the / character, so you will sometimes see "Class1|Class2" instead of "Class1/Class2".
You can also specify the class path in the name of the setting itself.  For example, to create an alias in Class1, you could use the syntax:
#ALIAS class1/aliasname {commands}
This is a more general purpose syntax for refering to a setting in a specific class, and can also be used for executing specific aliases or expanding specific variables.
For example, imagine the following situation:
#CLASS Class1
#ALIAS Test {in class1}
#CLASS Class2
#ALIAS Test {in class2}
Now, if you just type "Test" on the command line, which "Test" alias will get executed?  You don't really know.  The rule is that if your current class is set to something other than the root class (class 0), then zMUD will check the current class, and then the parent classes for a matching alias.  So, in the above example, we are still currently in Class2, so typing "Test" will execute the "in class2" alias.  If you are set to the root class (class 0), then zMUD will search all enabled classes, starting with the last class created.
To force execution of a specific alias, you can specify the full path.  For example:
Class1/Test
will always execute the "in class1" alias, no matter what the current class is.
When specifying the path to a setting, such as an alias, '..' can be used to refer to the Parent class, and '.' can be used to refer to the Root class.  A path starting the '/' starts with the current class.
So, if you just type: "Test", you don't really know which alias will get executed, although it will usually be the one that you want.  If you always want it to execute the "Test" alias in the current class, you would type "/Test".  If you always wanted to execute the "Test" alias in the root or None class, you would type "./Test".  To execute the alias in the Parent class, you would type "../Test"
Variables are different
There is an exception when dealing with Variables.  Normally, if you try to create a new setting with the SAME NAME as a setting in the parent class, a new setting will be created in the current class.  For example, if you have nested classes:
#CLASS Class1
#ALIAS Test {in class1}
#CLASS /Class2
#ALIAS Test {in class2 which is within class1}
this will create two aliases, one in the parent Class1 and one in the subclass Class2 within Class1.  To execute the second alias, you would use the syntax "Class1/Class2/Test"
Variables are handled a bit differently.  If you use #VAR to create a variable with the SAME NAME as a variable in a parent class, then the variable in the parent class will be changed instead of creating a new variable.  So, in the example:
#CLASS Class1
#VAR Data 1
#CLASS /Class2
#VAR Data 2
this will actually change the value of the Data variable in Class1 to 2 instead of 1.  Only one variable would still exist.  This is done because when doing object-oriented programming, you normally do not create new data fields with the same name as in a parent class.  
If you want to force zMUD to create a new variable in the subclass, use the '/' at the beginning of the variable name to force it to the current class.  So:
#VAR /Data 2
will force zMUD to create a new variable in the current class with a value of 2 rather than changing the Data variable in the parent class.
Enabling and Disabling Classes
There are two ways to enable or disable a class: using the #CLASS command, or the #T+ and #T- class.  The #T+ and #T- commands are used to enable and disable a class, respectively.  This is older, backwards compatible syntax from when classes could only contain Triggers, so #T- was the method to disable a "trigger class".  Classes can contain more than triggers now, but the syntax remains.
The #CLASS command is a more versatile way to enable and disable classes:
#CLASS classname value
will enable the classname if value is true (non-zero), or disable classname if value is false (zero).  You can retrieve the current condition of a class using the %trigger(classname) function.  This will return one if the classname is enabled, or zero if classname is disabled.  (Again, the name of this function is left over from when classes only contained triggers).
When you disable a parent class, all subclasses of that parent are also considered to be disabled.
Disabling a class prevents execution of any aliases, triggers, or macros within the class.  Buttons in the disabled class disappear from the button bar, and menu items in the disabled class disappear from the right-click menu.  Variables in a disabled class cannot be accessed unless you specify the full path to the variable specifically.

Introduction to Triggerstriggerstriggers,introductionIntroduction to Triggers
Triggers can be tricky, but are also the most powerful feature of zMUD.  Triggers (called actions on other MUD clients) allow you to execute a command whenever a particular string of text is received from the MUD.  While this sounds simple, it has powerful implications.
To define a trigger, you use the #TRIGGER (or #ACTION) command.  The syntax is #TRIGGER {pattern} {command}.  Whenever the pattern text is received from the MUD, the command is executed.  You can also define and edit triggers using the View/Triggers menu command to display the Trigger dialog.
Let's start with a simple example.  When you are working in a group, it is important to see anything that someone in the group has to say.  When someone in the group talks, the MUD usually says something like Zugg tells the group 'heal me'.  To ensure you don't miss this important information, let's change the color of the line to red using the #COLOR red command.  Thus, the trigger would be defined as #TRIGGER {tells the group} {#COLOR red}.
That was easy, and triggers like this can really enhance your MUD playing.  Here's another useful example: #TRIGGER {You are thirsty} {dr}.  With an alias like #ALIAS dr {drink @container} this trigger will keep your stomach happy and full by automatically drinking whenever you are thirsty from whatever container you have.
Extracting text from the MUD
Patterns can contain more complicated expressions and wildcard characters, and parts of the matched pattern can be stored in special parameters for use in the command string.  Parameters were introduced when Aliases were discussed.  The way you store part of the pattern into a parameter is by surrounding the part of the pattern with parenthesis.  One of the wild-card strings for a pattern is %w which matches any word.  So, for example #TRIGGER {(%w) tells you} {tell %1 I am busy} will match any string from the MUD that has a word followed by the string tells you.  Thus, when you receive the string Zugg tells you 'Hi', you will automatically send the command tell Zugg I am busy to the MUD.
Here's another really useful one:  #TRIGGER {You get (%d) coins} {split %1}.  Since %d matches any set of numeric digits, whenever you pick up some gold coins, you will automatically split them to your group!
Many times you just want to extract the text from the MUD and put it into a variable.  For example, you might want to capture the information from your MUD status line about your hit points and mana:
#TRIGGER {Hp: (%d) Mana: (%d)} {#VAR HpVar %1;#VAR ManaVar %2}
When the MUD displays
Hp: 100 Mana: 50
the trigger will store 100 into the @HpVar variable and 50 into the @ManaVar variable.
However, there is an even easier way to do this using the &VarName syntax in the trigger patter:
#TRIGGER {Hp: &HpVar Mana: &ManaVar}
No action is needed...the captured values are automatically stored into the specified variables if the pattern matches.
By default, the &VarName syntax uses a wildcard pattern of * to match the text.  To change the wildcard that is used, specify it just after the & character.  Or, if you want to use the square brackets [] to define your own wildcard range, put it after the & character.  For example, to only capture the digits 0,1,2 into a variable, you would do:
#TRIGGER {Hp: &[012]HpVar}
so it would only capture your hitpoints if it only contained the digits 0,1,2. Not very useful, but it illustrates the syntax.
If you need to capture something where there are alphabetic characters just after the value you want, you need to enclose the variable name in {} characters.  For example, if the MUD displays:
You have 100gp
You might want to create a trigger to capture this number into the @Gold variable.  But, if you do:
#TRIGGER {You have &Goldgp}
IT WON'T WORK!  Because it will be using a variable name of "Goldgp" instead of just "Gold".  To get around this, use the {}:
#TRIGGER {You have &{Gold}gp}
and now it will set the @Gold variable properly.
Trigger Classes
Now, you wouldn't want the above trigger to be active all of the time.  Splitting coins when you are not in a group is not recommended.  To assign a name (called a Class name) to a trigger, provide the name as the optional third parameter to the #TRIGGER command.  For example: #TRIGGER {You get (%d) coins} {split %1} autosplit.  Then you can turn the trigger on with #T+ autosplit, or turn it off with #T- autosplit.  Assign these two commands to macro keys or buttons and you have full control over when you split and when you don't.
Regular Expressions
Instead of using the normal zMUD trigger syntax, you can use Perl Regular Expressions instead.  See the #REGEX command for details on regular expressions.

Introduction to Buttonsbuttonsbuttons,introductionIntroduction to Buttons
Combining the concepts of aliases, triggers, and variables are Buttons.  Buttons not only make it easier for novice users to use these features, but provides significant functionality to power users that is not found in text-based clients such as TINTIN.  Buttons can be clicked to execute a command, their caption can display the value of a variable, and they can act as a toggle to turn a feature (like triggers) on and off easily.
To define a button, right click on the button you wish to edit, or select Make Button from the Action menu.  There are several types of buttons including: push buttons and toggle buttons.  A push button is clicked to execute a command and releases as soon as you release the mouse.  A toggle button changes between being off (up) or on (down).  The type of button is controlled by the Variable field.  If you assign the name of a variable to this field, the button will be a toggle button, and the variable will contain the state of the button (0 for up/off, 1 for down/on).  A Multistate button can have multiple captions and commands, and looks like a pull-down menu button.  A menu button is similar to a multistate button, but simply points to a special menu class where the menu commands are defined, rather than defining the multiple commands within the button itself.
In the Off Caption, enter the text you wish to display on the face of the button when the button is in its normal, off position.  The next field is for the caption to be displayed when the button is pressed in, or on (this field is grayed out if the button is not a toggle button).  If you leave the On Caption blank, it will use the same value as the Off Caption.  You should limit captions to about 10 characters so that they fit on the button face.  The value of the caption fields are evaluated, so you can put an expression containing variables and the result will be displayed on the button.
We'll skip the Value field for a moment, and move to the On Command field.  Enter the command you wish to execute when the button is pressed (from Off state to On state).  In the Off Command field, enter the command you wish to execute when then button is released (from On state to Off state).
The Value field is used to externally control the state of the button.  You can do this with just the variable (e.g. if you assign 1 to the variable in the Variable field, the button will activate itself, if you assign 0 to this variable the button will deactivate itself).  However, the Value field allows greater control as to whether the button is pressed or not.  If the expression in the Value field is true, the button is in the On state (pressed).  If the expression in the Value field is false, the button is in the Off state (released).
So, how about an example?  In the Introduction to Triggers we created an autosplit trigger.  We can make this trigger much more user friendly by using it with a button.  Select Make Button from the Action menu.  In the Off Caption field, enter the text AutoSplit.  In the On Command field enter emote is auto-splitting;#t+ autosplit.  In the Off Command field enter emote stops auto-splitting;#t- autosplit.  In the Variable field, enter autosplit.  Click OK to save the button definition.  Now you have a button labeled AutoSplit, and it is currently off.  Click the button.  The command emote is auto-splitting is sent to the MUD (telling your group members what you are doing), and the autosplit trigger is enabled.  The semi-colon (or Separator character) allows you to specify more than one command on the same line.  Note that the button now appears in the On state (is pressed in).  This gives you the visual clue that your AutoSplit function is enabled so that you don't forget.  Click the button again.  The text emote stops autosplitting is sent to the MUD, and the autosplit trigger is disabled.  The button now appears in the Off position.  Now you don't have to waste two keys on the keyboard to turn your autosplit trigger on and off, and in addition you have a nice visual clue as to whether your trigger is active or not.  Try to beat this in a text-based MUD client!
Advanced Settings
In the advanced settings tab you can control many attributes of your buttons.  You can set the color of the button, change the size or location, and assign a graphic (BMP file format) to the button.  There are over 100 predefined images built into zMUD that you can access by clicking the down-arrow button on the right-side of the bitmap field.  Buttons can have their icon to the left of the caption, or on top of the caption.  Buttons can also be displayed using "Explorer" style which means they don't normally display a bevel around the edge of the button until the user moves the mouse over the button.  This allows you to create button bars that can be very complex.
You can also assign a variable name to a button to keep track of the button state.  A button that is off has a value of zero, and a button that is pushed in has a value of one.  In addition to setting the value of the variable to the current button state, you can control the button by setting this variable in a script.  For example, if you have the variable named "State" assigned to the button, and then do "state=1" the button will get pushed in.
The Value field is similar to the Variable field, but specifies a full expression used to determine the state of the button.  For example, the expression "@Name = "Zugg"" can be used.  The button will be pressed in whenever the variable @Name has the value of "Zugg".  Clicking the button will have no effect...the button is now controlled by this expression value.
Multi-State Buttons
In addition to toggle buttons and push buttons, you can create "multi-state" buttons.  These buttons have a menu associated with them.  When you click on the button, the menu appears and you can select an item from the menu.  Each item in the menu can correspond to a command, a new caption for the button, and/or a new color for the button.  
In the Create Button dialog, select the Multi-state button radio option, and then enter the number of states (menu items) you want your button to have.  In addition to the different menu items, the button has a main caption state which specifies the default caption, command, and color for the button.  Select the state you wish to change in the pulldown box, and then enter the caption for this state, along with the command you want to execute.
Multi-state buttons can also set variables just like toggle buttons.  The default state has a value of zero, with the selectable menu items starting with a value of one.
Instead of defining the states and commands of a button directly, you can point to an existing menu class.  Simply select the Menu button type, and enter the name of the menu class into the Command Script field for the button.  Using this method, you can share common menu definitions between buttons and popup menus.  See the Menus topic for more details.

Introduction to MultiplayingmultiplayingIntroduction to Multiplaying
If you connect to more than one character or more than one MUD (using the Another Character menu command or the Connection Wizard), zMUD will put each character into a different window.  This allows you to control multiple characters at once (called multiplaying and is banned on many MUDs).
The commands that you type in the command box are sent to the character window that currently has the focus.  This is usually the window on top.  You can change the currently focused window in several ways: select the window from the list given in the Window menu, select it from the "tablist" of windows shown at the bottom of the screen (just above the command line) when more than one window is open.  You can also cycle through the open windows using the Ctrl-N or Ctrl-Tab keys.
Each window has a name associated with it.  The default name for a window is the ID of your MUD character.  You can change this name using the #NAME command.
To send commands to a different window, precede your command with name: where name is the name of the window you wish to get focus, and : is the focus character (which can be changed in the Preferences).  The indicated window will be brought to the top and focused, and the command will be sent to that character.  To send a command to a different window without changing the focus, precede your command with :name: where name is the name of the window you want to command sent to.  In this case, your current window will be unchanged. If you do not specify any window name, and just enter :hi then hi will be sent to all windows.
Note that when referring to windows by name, you don’t have to spell out the entire name, just use enough characters to uniquely determine the window.  For example, if you have a window named zugg, then typing z:hi is enough to send hi to the zugg window.  You can also refer to windows by there number (shown next to the name in the Window menu).  For example 1:hi sends hi to the first character window.  Variables are also allowed before the colon.  If the variable @tank contains the value zugg, then @tank:hi will send hi to the zugg window.
Note that you can also mix these focus commands within your command line.  For example, entering zugg:eat;aurora:drink will send the eat command to zugg’s window, and the drink command to aurora’s window.  Aurora’s window will have the focus at the end of this.  Let’s look at some more examples to make this clearer.  In all of these examples, assume that we have two windows, Zugg and Aurora, and that Aurora’s window currently has focus.

eat;zugg:drink
tell aurora to eat and zugg to drink.  Gives zugg the focus.
zugg:eat;drink
tell zugg to eat and drink and give zugg the focus
:zugg:eat;drink
tell zugg to eat (don't change focus) then tell aurora to drink
zugg:eat;::drink
tell zugg to eat and give him the focus.  Then, change the focus back to aurora and tell her to drink.
Finally, you can use tab completion to change window focus without sending any commands to the window.  Typing zugg: and pressing <TAB> will give the zugg window focus and bring it to the top.  The command buffer will then be cleared, awaiting commands to be sent to this window.
Window Activity
When you have more than one window open, you can use the Tabbed Layout to display each window name in a tab bar.  To bring a window to the front, just click on a tab.  This is the same as clicking on the window itself, or selecting it from the list in the Window menu.
To the left of the window name in each tab is an activity indicator.  When the indicator is an empty circle, that indicates the current window that has focus.  Other status indicators include:

red dot	session has been disconnected
green dot	session has received new text since the last time it was active
yellow dot	session has disconnected, but was able to automatically reconnect
yellow bolt	session is connecting

Debugging ScriptsDebugging Scripts
zMUD provides several tools for helping you to debug your complex scripts.  First, the settings editor itself performs syntax checking as you enter your scripts.  Keywords are highlighted and script elements are color-coded.  In addition, help tips about the commands and arguments that you are typing automatically appear at the bottom of the window.  You can also enable syntax checking in the built-in Editor window.
In addition to syntax checking as you type, zMUD also contains an integrated Debugger.  To activate the Debugger, select it from the Windows menu.  The Debugger window is split into three sections.  The large section on the left will display the script that is running.  The upper-right section displays the current execution stack.  The lower-right section displays the current Watch List.
The Watch List
The Watch List displays any variables or expressions that you want to watch as your scripts execute.  Whenever one of these expressions changes, it's value is updated in the Watch List.  To add an expression to the list, right-click and select Add.  To remove an expression, right-click on it and select Delete.  You can also add expressions to the Watch List from the command line or from a script using the #WATCH command.  For example, to watch the value of a variable called HitPoints, you'd use the command:
#WATCH @HitPoints
You can remove an expression from the Watch List using the #UNWATCH command:
#UNWATCH @HitPoints
Any number of expressions can be entered into the Watch list.  However, this list is not saved when you exit zMUD.
The Execution Stack
zMUD scripts can contain sub-scripts, or nested scripts.  For example, the command:
#IF (@HitPoints < 100) {heal}
is a script which contains the nested script "heal".  The nested script is executed if the @HitPoints<100 expression evaluates to true.  Another example of a nested script is:
#ALIAS Nested {I am nested}
#ALIAS Main {Main Script;Nested;Back to Main}
The script "Main" calls the nested script called "Nested".
The Execution Stack in the Debugger displays the name of the current script, along with all of the currently active scripts above it.  In the above example, if the debugger was stopped in the Nested script, the Execution Stack would show the "Main" script, followed by the "Nested" script.  So, the Execution Stack shows you how zMUD got to the script that it is working on, whether from another script, a trigger, an #IF statement, or whatever.
The Script Display
The main section of the window on the left displays the currently executed script.  In the above example, if you double-clicked on the "Nested" script in the Execution Stack, the script window would display "I am nested".  If you double-clicked on the Main script, the script window would show:
Main Script
Nested
Back to Main
and the "Nested" line would be highlighted to show that it was the last line executed in that script.
The Toolbar
The Toolbar at the top of the window contains buttons for controlling your script execution.  You can pause execution at any time.  One execution is paused, you can then single-step through a script, or run through the end of the current script and stop when it gets back to it's parent script.  There is also a button for clearing breakpoints, which are discussed later.
An Example
Let's look at a simple debugging example.  Make sure the Debugger is active by selecting Debugger from the Windows menu.  Now, click the Pause button in the Debugger.  This will stop all script execution.  You should do this test offline so that any triggers you might have running won't be interrupted by this test.
Now that execution of scripts is paused, enter the following script on the command line:
start;#IF (2=2) {value is true};end
When you press Return, your command will be executed, and will immediately be loaded into the debugger where execution will pause.  The script window will show:
start
#IF (2=2) {value is true}
end
and the "start" line will be highlighted.  The highlight shows that the start command is the next command that will be executed.  Click the Single-Step button in the debugger.  The "start" line will be executed (which will display "start" in your MUD window).  Then the highlight will move down to the #IF statement.  Click the Single-Step button again.  The #IF statement will be executed.  Since the expression 2=2 is true, the nested script "value is true" will be loaded.  
Now your Execution Stack will show two scripts.  The second script will be highlighted and the Script Window will show the "value is true" line.  If you double-click on the first script in the Execution Stack, you'll be back at the previous script display, showing that the #IF statement is being executed.  Double-click on the second script again to get back to the "value is true" script.  Click the Single-Step button.  The command will be executed and "value is true" will be displayed in your MUD window.  Now the debugger will be back to the main script, with the "end" line executed.  Click the Run button in the Debugger to finish running the script.  The string "end" will then be displayed in your MUD window and the Debugger will then be blank.
This shows a sample debug session in action.  While debugging you can add values to the Watch List in order to see what the value of certain variables might be.  You can single-step through your script to find out what might be causing them to fail.
Breakpoints
Stepping through a large script line by line can be tedious.  Sometimes you know that the trouble is far down in the script and you don't want to always step through the lines at the beginning that are already working.  To stop your script in the middle and load the debugger, you need to set a BreakPoint.  zMUD supports several different types of breakpoints.
First of all, you can use the #BREAK command in your script.  When zMUD executes the #BREAK command, execution is stopped and your script is loaded into the debugger.  This is a very powerful method, since you can also use #BREAK within an #IF statement to only break when a certain condition is reached.  For example, maybe you only want to break when your @HitPoints<10.  So you'd use a line in your script:
#IF (@HitPoints < 10) {#BREAK}
Also, breakpoints are only executed if the Debugger is enabled.  The checkbox in the upper-right corner of the debugger can be used to enable or disable the debugger.  So you can decide only to enable the debugger when something specific happens on your MUD, thus activating any breakpoints you have set.
A second type of breakpoint can be set on certain zMUD objects themselves.  You can set Object Breakpoints on Aliases, Triggers, and Variables.  To set an object breakpoint, go into the Settings Editor.  Right-click on the object you want, and select the Break command.  The object will be highlighted in red in the settings editor to remind you that a breakpoint has been set.
Alias breakpoints cause execution to stop when the given alias is executed.  The debugger will load the script for the alias and then stop on the first line of the alias.  The Execution Stack will display any parameter values sent to the alias.
Trigger breakpoints cause execution to stop when the Trigger is executed.  The script for the trigger will be loaded into the alias and execution will stop on the first line.  The Execution Stack will display any parameter values (%1..%99) used by the trigger.
Variable breakpoints cause execution to stop when a new value is assigned to the variable.  Execution is stopped right *after* the new value is assigned.
You can clear all Object Breakpoints using the Clear button in the Debugger window.  Only Object Breakpoints will be cleared.  Any #BREAK commands must be removed manually.

Introduction to the DatabaseIntroduction to the Database
The Database module in zMUD allows you to keep track of all the equipment, monsters, players, and other items on your MUD.  This powerful database allows you to find items quickly and add new items easily.  It supports multiple databases and data import/export from external applications such as Excel.  The database is also fully scriptable so you can even automatically capture the MUD output of an "identify" spell and create a new item in the database based upon the results.  The database is also integrated with the zMUD Automapper so you can walk to the location of an object or monster on your MUD automatically.
Each MUD has thousands of unique items and unique properties for each item.  It is impossible to automatically recognize your MUD's object format from within zMUD.  Instead, you must first create a database for zMUD to use for your specific MUD.  Several template databases are shipped with zMUD to get you started.  Once your database is created, you then fill it with information about the objects from the MUD.  You can do this by writing scripts to capture the output of "identify" commands, or you can enter the information manually, or you can import it from a text file or external application.  Once you have the database filled with information you can then easily search for items quickly and use the database to help your MUD playing in many ways.
Please choose a topic from the list below to learn more about the Database module, or click the Next button to go to the next topic in this section.

Creating a Database
Database Views
Adding Data to a Database
Quick Filters
Programming the Database
Advanced Database usage

Creating a DatabaseCreating a Database
A Database is created by telling zMUD what information is to be stored for each object.  For example, if you are creating an equipment database, you want to store the name of the item, perhaps the item cost and weight, and any special attributes such as whether the item adds to your hitpoints or strength.  If you are creating a monster database, you want to store the name of the monster, its level, how many hitpoints it has, and how much damage it inflicts.  You must decide what information you want to store in your own database.  Don't worry though, you can always add more information to a database later if you forget something.
Each item is stored in a database "record".  The pieces of information stored for each item are called "fields".  For example, in the equipment database, each piece of equipment is a record, and the fields are the Name, Cost, Weight, etc for the item.  The information about the Fields in the database are stored in the database Definition File and has a file extension of .dbd.  The actual data for each record in the database is stored in a separate Data File which has a file extension of .db.  These two files are separated to keep the structure of a database separate from the actual data.  This lets you add or remove fields in the future without having to start over entering the data.  It also allows you to share your database structure with other zMUD users without sharing the specific data.  
Database Window Overview
To open the Database window, click the DB button on the main zMUD toobar, or select Database from the Windows menu.  The database window will open and prompt you to create a New database, or Open an existing database.  Along the top of the window is the menu bar, and beneath that is a toolbar.  You can change the properties of the toolbar by right-clicking on it.  Beneath the toolbar is a selection box for the database you wish to view when multiple databases are open.  To the right of the database selector is an area for window tabs to select different database Views.  A database View is a way of looking at a subset of your database, sorted in a particular way, so you don't have to always look at the entire database at once.  Beneath the View tabs is the main portion of the window where the data is actually displayed.
Creating a New Database
To create a New database, click the New button or select New from the File menu.  You will be prompted to enter the Name of the database, the Filename to store the database in, and what Template you want to create the database using.  The Name of the database can contain spaces or any other letters to remind you what is stored in the database.  The Filename will usually be created automatically based upon the database name that you use.  
To help you create new databases quickly, several templates have been supplied with zMUD.  The templates include an equipment database, a monster database, and a character database.  You can select one of these templates that closely matches the type of database you are creating, or you can just select the Blank template to start from scratch.  Once you create your own database, you can save it as a template yourself by selecting the Save As Template option in the File/Save As menu command.
Creating Fields
When you create a New database, you will automatically be placed into the Field editor.  You can also select the field editor at any time by clicking the Fields button in the toolbar.  The fields editor allows you to define the types of information you want to store for each database item.  There are several different Types of fields that can be used for storing different information.  The available field types include:
Text	a single line of text
Memo	multiple lines of text
Number	a number in a given range with several formatting options
Single Option	a single value out of a list of possible values
Option List	multiple values from a list of possible values
Zone	a list of map zones from the automapper module
Room	a list of map rooms from the automapper module
Record	points to another record in this database or another database
Boolean	a true/false or yes/no field that can be formatted different ways
Each field has a Name, a Type from the above list, a Color for the field to be displayed in, an Internal flag, and an optional Formula.  Formulas are described in the Advanced Database topic.  The Internal flag is used to prevent the value of the field from being returned to the zMUD scripting language.
The Hint field is used to describe the field.  This text is displayed in the status bar when the user enters data into this field.
In addition, each field requires other information depending upon what Type of field it is.  For example, a Text field can have a default value.  A Number field has a default, along with a minimum and maximum value.  The Single Option and Option List types allow you to define the list of possible values the field can contain and you can indicate if additional values outside the list can be added by the user later.
Numbers can be formatted in several different ways for output to the screen.  You can select a format of General (the default), Currency (with a dollar sign and commas), Commas (like General but adds commas between thousands), and Plus/Minus (places a + or - in front of the number depending on if it is positive or negative).  These formats only control how the number is displayed for output.  You always enter numbers in General format.
Option Lists
Fields with a type of Single Option or Option List need a list of possible values to be entered.  If you want to allow additional values for these fields as needed, click the Allow Other option.  Otherwise, only the values that you list will be allowed in the field.  To add values to the allowed list, click the Add button next to the list.  Enter the name of the value to be added.  You can enter multiple values at the same time by putting commas between the values.  Also, if you paste into this field, any newlines or tabs are also replaced with commas, so you can select a row or column of values in a spreadsheet like Excel and paste them into the Add box.
To delete values from the list, select the value by clicking on it, then click the Delete button to the right of the list.  To edit the name of the value, select the value by clicking on it, then click the Edit button.
You can mark values as the default value for the field by clicking the checkbox to the left of each value.  A Single Option field is only allowed to have a single default value, but an Option list can have as many default values as you need.
Adding Fields
To add a field, click the Add button.  A new, blank field will be created, and you then need to enter the Name of the field, the Type, and enter any other information required.  Instead of creating fields from scratch, you can select from several pre-defined fields using the Quick Add button.  Click Quick Add and a list of pre-defined fields will be displayed.  Select the one you want and click OK.  You can then modify the field if it needs to be changed slightly.  Pre-defined fields are stored in the TEMPLATES.DBD database definition file which you are free to open and edit to add new fields or to change the existing pre-defined fields.  Be sure and backup any changes made to this file in case it is overwritten in the future when you upgrade zMUD.
Deleting Fields
If you no longer want a field, you can delete it using the Delete button.  Be very careful, however, since all data stored in the database for that field is lost and cannot be recovered.  While you can "Exit Without Saving" from the database if you make a mistake, zMUD autosaves the database every 5 minutes by default, so be very careful deleting fields.
Rearranging Fields
The list of fields shown on the left are the fields for your database and the order that they were created in.  By default, the data stored for each record will be stored in the order that is shown.  While this order normally doesn't make any difference, you can rearrange the order of the fields using the Move Up and Move Down buttons in the toolbar.  This will change the order that the fields are saved when the database is next saved.
Saving your Fields
When you are done creating the fields for your database, save your database definition by using the Save command in the File menu.  You should always save your work periodically although by default zMUD will autosave your database every 5 minutes.  You can change or disable the autosave function in the Logging Preferences page.
Once you have saved your field definitions, click the List button in the toolbar to display the main database screen so you can create some Database Views and then Enter your Data.

Database ViewsDatabase Views
A Database View is a subset of the database sorted and displayed in a particular way.  For example, in an equipment database, perhaps you only wish to display the Weapons stored in the database.  To do that you would create a Weapons view.  The equipment database templates has a view for each equipment type, sorted by the name of the equipment.
For each view, you can control which columns are displayed, what order they are displayed in, how wide each column is, how the data is sorted, and what types of records to display.
A view called "All" is always defined and cannot be deleted.  While you can change the sort order of this view, you cannot change which records are displayed.  As the name of the view suggests, All records in the database are always displayed by the All view.  However, feel free to change the column order or column widths as you'd like.
Changing a View's Appearance
You can change the width of a column in a view by clicking on the line between the column names where the mouse cursor changes to a resize image, and then dragging the edge of the column where you want it.  To rearrange the order of the columns, click on the name of the column you want to move and drag it to its new location.  The display will automatically update to show your changes.
To change how a view is sorted, click on the column header that you want to sort on.  As you click on the column header, it will toggle between a normal sort, a reverse-order sort, and no-sorting.  You can sort on multiple columns by holding down the Shift key when you click on a column to add that column to the sort list.  So, to sort in Reverse order on the Hit field and then sort on the Name field, you would click the Hit column twice (to set it to reverse sort), then Shift-Left-click on the Name column to add it to the sort order.
Creating a New View
You can only change the appearance of the All view.  To change other view properties you need to create a new view.  Select New from the View menu or right-click on the empty space in the view tabs to the right of the All view tab.  The View window will then be displayed.
The View window has a toolbar along the top, and a list of all fields in the database on the left.  Just beneath the toolbar is a selection box for selecting the View you wish to edit, and the Name of the View.  To the right of the Name is an option box labeled Auto Append.  This option selects whether new fields added to the database are automatically appended to the columns in this view.
To the right of the list of database fields are three sections labeled "Columns", "Sort Order", and "Records (Filters)".  These sections control which columns to display in the view, how the view is sorted, and which records are displayed in the View.
Columns in a View
The Columns area indicates the columns displayed in the view and the order that they are displayed in.  The top value is the name of the column to be displayed at the left side of the database display.  To add columns to the view, drag the name of the field from the list on the left and drop it into the Columns box.  It will be added wherever you drop it.  To remove a column from the list, drag the name of the column from the Columns box and drop it anywhere on the Field list.
You can also add a field by clicking on the item in the Columns list just below the point you want the new column, then click on the Field you want in the Field list, then click the Add button.  The Add All button will add all of the fields to the Column list.  The Remove All button will remove all columns from the column list.
To change the order of columns in the column list, simple drag the column you want to move to its new location in the list.
Sort Order
To change the way the view is sorted, drag the field you want to sort by from the Fields list on the left and drop it into the Sort Order box.  You can sort on as many fields as you like.  The field at the top of the list is sorted first.  Items that have the same value for this field are then sorted by the second field in the Sort Order list.  If you check the checkbox to the left of the field name in the Sort Order list, the order of the sort is reversed.  For example, adding the Name field to the Sort Order list will normally display names in normal alphabetical order, starting at A and going to Z.  If you check the box next to the Name field, the order is reversed, with Z shown first, and A last.
The Formula box beneath the Sort Order allows you to sort based upon a numeric "score" for each record in the database.  This is explained in more detail in the Advanced Database section.
Record Filters
To select what records to display in the View you must create some record Filters.  Filters are rules that describe the type of records to display.  To create a new filter, drag the field you wish to filter on from the Field list on the left and drop it on the Record Filter box.  A default filter for that field will then be displayed.  You modify a filter using the different fields shown beneath the filter list.  To delete a filter, drag it from the Filter box and drop it onto the Field list.  To change the order of filters, simply drag the filter to the position in the list you want it.
Filters are combined using the boolean AND and OR operators.  For example, you might want to display records that have the Kind field set to the value of Weapons AND records whose Level field is greater than 20.  Or, you might want to display records that have the Kind field set to the value of Scrolls OR records whose Kind field is set to Potions to display both scrolls and potions in the same view.  The AND and OR operation is selected with the first selection box on the left beneath the filter list.  The AND operation has precedence over the OR operation.  So, if you have three filters and set them up in the order F1 AND F2 OR F3, this is really the same as (F1 AND F2) OR F3.  If you want to do F1 AND (F2 OR F3), you need to enter the filters like F1 AND F2 OR F1 AND F3 by repeating the F1 filter.  Think of the AND as multiplication, and the OR as addition and you'll see how this works: F1 * (F2 + F3) = F1*F2 + F1*F3.
The selection box to the right of the AND/OR box is simply the Field selection box and should already be filled in properly if you dragged the field you wanted to filter from the list on the left of the window.  However, you can change it here if you want.  The first value in this selection box is called -formula- and is explained in more detail in the Advanced Database section.
To the right of the Field selection is the Operation selection.  This important selection box tells the database what you want to test for.  Several operations are given depending upon what Type the field is you are filtering on.  For example, for Text fields, you can filter if the field Contains a certain string, Begins with a certain string, Ends with a certain string, etc.  For Number fields, you can test if the number is Equal to a value, Greater then a value, Between two values, etc.  Here is a complete list of the operations available for each field type.

Text, Memo
Contains, Equals, Begins with, Ends with, is not Empty, Greater than, Less than, Greater than or equal, Less than or equal
Number
Equals, is not Empty, Greater than, Less than, Greater than or equal, Less than or equal, Between
Single Option, Option List
Contains, Equals, Begins with, Ends with, is not Empty, Greater than, Less than, Greater than or equal, Less than or equal, Between, Has some items, Has All items
In the case of text fields, an alphabetic comparison is made, where as with Number fields a numeric comparison is made.  The Between operations tests if it is between one value or another, or equal to one of those values (inclusive test).  The Has some items tests an option field to see if it contains any of the items in a list.  The Has All items tests an option field to see if it contains all of the items in a list.  All of the text operations are case insensitive, so HELLO is equal to hello.  To reverse or negate a filter, click the NOT option box.
Let's look at the example mentioned above for displaying level 20 or greater weapons.  First, drag the Kind field to the filter list and change the Operation to Equals, then select Weapons from the list the appears below the operation selection box.  Then, drag the Level field from the list on the left and drop it into the filter box.  Change the operation to Greater than and enter 20 into the number box that is displayed below the operation list.
The line beneath the field selection and operation selector changes depending upon the operation that you select.  If the operation requires a text value, a text box will be displayed.  If it requires a number, a numeric entry box is displayed.  If it requires you to select a value from a list, a selection box is displayed.  To the left of the input box is a button labeled @ that is used to enter scripting formulas.  This option is described in more detail in the Advanced Database section.
Saving your View
To save your new view, click the Save button.  To discard any changes, click the Cancel button.  You will be returned to the main database display and your new view will be shown.
To edit you new view, select the Customize option from the View menu or right-click on the name of the view in the view tabs and you will be returned to the View window.
While in the View window, you can select another view to edit by selecting the name of the view in the selection box just beneath the toolbar.  If you change views, any changed made to the current view are automatically saved.
You can Delete a view by selecting Delete from the View menu in the main window, or by clicking the Delete button in the View window.
You can add a New view by selecting New from the View menu in the main window, or by clicking the New button in the View window.
Once you have some views defined you can start Entering Data into the database.

Adding Data to a DatabaseAdding Data to a Database
A database isn't very useful without some actual data, so zMUD provides several ways to easily populate your database with information.  While you can start adding data as soon as you define the fields in a database, it can be very useful to also define some database Views before entering data.  The reason for this is that any field set up as a filter in the View will automatically get set when a new record is created so that it satisfies the filter.
For example, if your view is set up to filter records with the Kind field set to Weapons, then when you create a new database record within this view, the Kind field will automatically get set to Weapons.  All other fields in the new record are set to their default field value if any is specified.  Using Views in this way allows you to enter data very quickly without setting certain fields to the same value all of the time.  You'd enter all of your weapons using the Weapons view, your armor using the Armor view, etc.
Adding Records
There are many ways to add data records to your database.  The most straightforward is to simply click in the first column of the last row of the current view.  This last row is always reserved for a New record.  As soon as you enter a value into any of the cells in the last row, a new record is automatically created.  Pressing Tab from the last column of a row will send you to the first column of the next row, so you can add records by simple starting to type.  Press Tab to move from column to column and from the end of one record to the start of the next.  This again illustrates the value of defining your own View before entering data.  If you enter data into the All view you have to supply values for each column.  In your own view you only have to enter data for the columns that are displayed in the view. 
You can also move around the grid using the arrow keys.  The up and down arrow move you to the next or previous record, keeping the cursor in the same column.  The left and right arrows are a bit trickier.  If the entire field is highlighted, the left and right arrows will move you to the previous or next column.  If the field is not highlighted, the left and right arrows just move the cursor within the text value of the field.
When entering data for each field, use the keyboard.  For a text field, just type the value you want.  For number fields, simply type the number you want, although you can also use the + and - keys on the keypad to increment and decrement the value.  For Single Option fields, start typing the value of the field and the option that matches what you are typing will be shown as you type.  If the field does not allow other values, a beep will occur if you press a key that is not allowed.  For Option List fields, enter the first few unique characters of each option, and separate each option with a comma.  Unlike the Single Option fields, the matching values are not displayed as you type.
The List and Detail modes
The List mode displays your database information in a grid format with each record on its own row and field values in the columns.  This is similar to other database programs and spreadsheets such as Excel.  The List mode is designed to make it very easy to enter data using the keyboard as described above.  Clicking the Detail button switches the database into Detail mode and provides a different way to look at your data.  In Detail mode, the list of records in the database are shown on the left, and in the main window to the right, each field of the database is shown on a separate line.  Text fields are displayed as text input boxes, Memo fields are displayed as multiline input boxes, Number fields are displayed as a numeric input box, Single Option and Option Lists are shown as selection boxes, etc.  If there are more fields than can be displayed in one window, you can scroll down to view the other fields.  The Detail mode is designed to be edited with the mouse rather than with the keyboard.  To edit a field, click on it.  To edit a number, click the Up or Down arrow buttons to increment or decrement the number.  Tab will still move you from one field to the next but will not move from the last field in a record to the next record.  To create a new record, you click the New button on the toolbar.  To delete a record you click the Delete button.
You can use either the List or Detail mode as much as you want.  It doesn't matter which mode you use to view or edit your data.  The View still controls the order of the fields and which fields are displayed, and how the list of records is filtered and sorted.
Copying and Pasting records
You can select a record by clicking on the record number column at the left of the record you want.  To select multiple records, hold down the mouse and drag it up or down over several records.  You can also select the start record and the Shift-Click on the end record to select an entire range of records.  You can only select a range of records, you cannot use Ctrl-Click to select non adjacent records.
Once you have select the record or records you want, you can copy them to the clipboard with Ctrl-C or selecting Copy from the Edit menu.  You can also Cut them which copies them to the clipboard but also deletes them from the database.  Once records have been copied to the clipboard, you can use the Paste command in the Edit menu or Ctrl-V to add them back to the database.  Copying a record and then pasting it multiple times is a good way to duplicate a record if you have several records that are very similar.
Pasting from other applications
A very powerful way to add data to your database is to copy and paste it from another application like Excel.  Many people already have put information into their own spreadsheets or databases and can use the Paste Special command in the Edit menu to import it into zMUD.
The Paste Special imports data stored in the clipboard (from a Copy or Paste operation).  The Import command imports data from a file on your local disk.  However, both of these commands operate the same way.
When you use Paste Special or Import, you will first get a window that asks for information on how the data is delimited.  zMUD automatically tries to figure out if the data is tab delimited, or comma delimited, or delimited by another character, or whether it is in fixed width fields.  The display along the bottom of the window shows the data being imported and how it is split into columns.  If zMUD guessed wrong about the delimiter, change it on this screen until the data looks like it is in the proper columns.  Also, if the first line of the data contains the names or headers of the columns, click the Use First Row as Headings option.
Once you have the columns set up correctly, click the Next button and you will be asked to assign each column of data to a specific database Field value.  If the Name or Header of a column matches a current database Field name, the assignment will be made automatically and shown in the list of columns on the left.  Otherwise the column is marked as -ignored- which means the column will be ignored.  To assign a column to a field value, click the column in the list on the left, or click it in the data display along the bottom.  Then select the Field you want to assign it to in the Field Selection box.  Do this for each column you wish to import.
Fields that have a type of Single Option or Option List have an additional feature.  A common practice for multi-value fields is to create several columns in a spreadsheet, one column per possible value, and then put an X or other letter into the column if it has that value.  For example, you might be listing which character classes are allowed to use a specific weapon.  Your spreadsheet could have columns for Warrior, Mage, Cleric, Thief, etc and you would put an X in the column if that class is allowed to use the weapon.  In the zMUD database, you can collapse all of those columns into a single field.  In the above example, you might have an Option List field called AllowedClass that has the possible values Warrior, Mage, Cleric, Thief.  When you select the Warrior column in your imported data, you would assign it to the AllowedClass field, and then further assign it to the Warrior value in the value selection box that appears below the field selection box.  Then you'd assign the Mage column to the AllowedClass field with the Mage value, and so on.  Now, when zMUD imports the data, any value in one of those columns (like an X) causes the assigned value to be added to the Option List field.  So, in the above example, if there was an X in the Warrior column and an X in the Cleric column, the imported record would then end up with an AllowedClass field with a value of "Warrior,Cleric".
In some case you might end up with a very complex assignment of columns to fields.  You can save the Paste Special setup to a file so that you can use it again later if you paste from the same source.  Simply click the Save button to save your import settings to a file.  To load previously saved settings, click the Load button.  This makes it very simple to import lots of data from your existing spreadsheets or databases.
Setting Field Values
You can also set the value of a field for multiple records using the Set Field command in the Actions menu.  You will be prompted to select the Field you wish to change, and then enter a value for that field.  Using the @ button you can enter a zMUD expression that will be evaluated if you wish.  If no records are selected, then the current record is modified, otherwise all selected records are modified.  To change all records in the database, go to the All view and do a Select All in the Edit menu to select all of the records.
Adding data from the MUD
Because the zMUD database can be controlled from the zMUD scripting language, you can set up triggers and aliases to automatically capture the result of an "identify" spell on the MUD and create a new record with this data.  For information on how to do this, see the help section on Scripting the Database.

Quick FiltersQuick Filters
In many cases you just want to Find a certain set of records in the database.  Instead of providing a Find and a Find Next command, zMUD uses Quick Filters to display a list of matching records.  Quick Filters are similar to the filters used to create a View, but can be applied more quickly on top of a current View.
To create a Quick Filter, display the Filter Panel if it is not already displayed by selecting it under the Toolbar menu in the View menu.  Once the filter panel is turned on, it will be displayed just below the list of database views.  It has controls similar to creating a filter in the View window.  On the left is the Field Selection control.  Select the field you want to search or filter on.  To the right of the field selection is the NOT option box, followed by the Operation selection.  The available operations are the same as for the View itself.  Once the operation is selected, the appropriate value box will be displayed.  Enter the value you want to search for and click the Filter button.  Click the Clear button to clear the filter and return to the full view.
For example, to display all of the "swords" in the Weapons view, turn on the filter panel, select Name in the field selection box, select Contains in the operation selection, and enter the word "sword" into the value field and click Filter.  All of the records in the current view with a Name that contains the word "sword" will be displayed.  You can then treat the data just like a normal view, including editing.  However, the quick filter has no effect on creating new records.  New records are created just like then would be if you cleared the filter.
Note that zMUD does not reapply the filter until you change it or click the Filter button.  In the above example we can then create a new record and enter a name of "ax" into the Name field.  The new record will still be displayed even though we are filtering on "sword".  However, as soon as you click the Filter button, the new "ax" record will disappear since it doesn't match the filter.
The Quick Filter is a global filter that applies to all views.  For example, if you set up a filter to display records whose Level field is greater than or equal to 20 (try it), you can then click on different views, such as Weapons and Armor and in each case you will also see the records with a level >= 20.  This is a powerful feature for searching for particular types of equipment in your database.
The Quick Filter also updates the view automatically when the filter parameter is changed.  In the above example displaying equipment with a Level >= 20, you can click the Up arrow button next to the value 20 to change it to 21.  The view will then instantly change to show equipment with Level >= 21.  This is an easy way to browse through your database based on various criterion.
The Quick Filter is not saved with your database file.  It is only active while you are actually using the database.  If you quit zMUD and reopen the database, the filter panel will still be displayed, but the filter will be cleared.  If you want a filter to remain, you are better off adding it to a specific view in the View window and saving the database.

Programming the DatabaseProgramming the Database
The Database Module can be fully controlled from within a script or from the zMUD command line.  This section provides an overview of the scripting controls.  To learn all about scripting the database, read each of these topics in order, or use the Next and Prev buttons along the top.  Or, just click on the topic you are interested in:

Database Names
Describes the zMUD naming conventions for databases.
Opening and closing Databases
Describes how to open, save, and close a database.
Database Variables
Introduces the important concept of a Database Variable, which can be used independently of the actual database records.  Make sure you understand this section before reading any of the following topics.
Accessing Database Records
Describes how to access fields in a database record, and how to get and put database records into database variables.
Using Database Views
Describes how to change a view or create a new view
Setting View Filters
Describes how to find items in the database and how to filter the records in a view
Accessing Records in a View
Describes how to loop through records in a view
Database Column calculations
Describes special functions that perform calculations on database columns
Creating New Records
Describes how to create new records and how to capture information from an "identify" MUD command automatically.
Working on the Database behind the scenes
Shows how to work on the database in a script without disturbing the database user interface.

Database NamesDatabase Names
Databases have both a long text name, plus a filename for storing the database on disk.  To refer to a database from the command line, you must use the first few unique characters of the filename.  zMUD is designed for database filenames whose first two characters are unique.  This two-character code is used throughout the scripting language to refer to the database.  For example, you could have a database with a long name of "Equipment Database", and a filename of "equip.db".  The two-character database code for this would be "eq".  No other database should have a filename that starts with "eq".  Make sure each database file starts with different characters.

Opening and closing DatabasesOpening and closing Databases
The #DBLOAD command will select a database as the current database, loading it from disk as necessary.  There is no way to open a New database from the command line since the database structure must be designed interactively.  This also means that there is no way to add or delete fields from the command line or otherwise change the database structure.  For example, to open the Equipment Database described above, you would do #DBLOAD eq
The #DBSAVE command will save the current database to a new filename.  This effectively allows you to rename a database since the first two characters of the filename is used as the scripting name of the database.  If you do not specify a filename, the #DBSAVE command will save all currently open databases to their current filenames.  This "save all" operation is also performed automatically every 5 minutes by default.  This time interval can be changed in the Logging Preferences.
The #DBCLOSE command will close the specified database, or the current database if nothing is specified.  If the database has been given a filename, it will be saved automatically unless the second parameter is non-zero in which case all changes since the last save will be discarded.

Database VariablesDatabase Variables
zMUD variables that contain database records have a special format.  They are similar to a string list (which has several items separated by the | character), but each item has both a Name and a Value.  You can use the format "Name1=Value1|Name2=Value2|etc..." in most database scripting commands, although the data is stored with different delimiters internally.  You should never have to access a database variable directly and will always use zMUD functions and command to manipulate them.
You can have a database variable that is not necessarily associated with a database record.  In this case, the variable contains the field Names and Values in the format shown above, but are not actually stored on disk in the database.  This is similar to a Record or Class in Pascal, or a struc in C.  It allows a single variable to have named fields and values.
To create a database variable, you can use several different methods.  The #VAR command accepts the above format:
#VAR VarName {Name1=Value1|Name2=Value2|Name3=Value3|etc...}
You can also add fields to a variable one at a time using the #ADDKEY command or the %addkey function:
#VAR VarName ""
#ADDKEY VarName Name1 Value1
#ADDKEY VarName Name2 Value2
etc
The #ADDKEY command also accepts the Name=Value syntax:
#ADDKEY VarName {Name3=Value3|Name4=Value4|etc...}
Warning:  Do NOT attempt to create a database variable using the concat function.  Doing
#VAR VarName %concat("Name1=Value1","|","Name2=Value2")
WILL NOT WORK!  The = and | delimiters are not used by the internal database storage and the resulting variable will not be considered a database variable.
You can delete a field from a database variable using the #DELKEY command:
#DELKEY VarName Name1
would delete the Name1 field and the Value1 value assigned to it.
To display the database variable to the screen in a nice format, use the #SHOWDB command:
#SHOWDB @VarName
will display each field Name and Value on a separate line on the screen.
To access a field Value from a database variable, you can use one of two methods.  The most general method is to use the %db function, where the first argument is the database variable, and the second argument is the Name of the field you wish to retrieve.  For example %db(@VarName,"Name1") would return Value1 in the above examples.  This method of retrieving values is preferred in complex situations since the name of the field can itself be a variable.  For example:
#VAR FieldName Name1
#SHOW %db(@VarName,@FieldName)
will display Value1 to the screen.
The second way to access database variables is using standard C and Pascal "dot notation" where you specify the VarName.FieldName.  For example @VarName.Name1 will return Value1.  However, this shortcut notation does not allow a variable field name.  @VarName.@FieldName WILL NOT WORK!  So, while it is useful most of the time, sometimes you will still need the %db function.  The dot notation can also be used to set database values, either with the #VAR command or the zMUD assignment statement:
#VAR VarName.Name1 Value1
VarName.Name1=Value1
will both set the Name1 field in the VarName database variable to Value1.
To access database fields of the current database record (%rec) you can use an additional shorthand: &FieldName.  The & character is the Database Character and can be changed in the Special Character preferences.  The &FieldName syntax is most commonly used in query and sort formulas to refer to fields in the current database record.  Do not confuse the &FieldName syntax with the &VarName syntax for Trigger Patterns.  Trigger Patterns have a completely different syntax from the normal scripting parser.  So, all of the following are equivalent and return the value of the Name field for the current record:
#SHOW %db(%rec,Name)
#SHOW %db(,Name)
#SHOW %rec.Name
#SHOW &Name
Here is a complete list of commands and functions that operate on general database variables:
%addkey(db,key,value)	adds the key=value to the database variable db and returns the new database variable.
%delkey(db,key)	deletes the key from the database variable db and returns the new database variable
%db(db,key)	returns the value of field key in the database variable db
%iskey(db,key)	returns the position of the key in the database variable db.  Returns 0 (false) if the key does not exist
%numkeys(db)	returns the number of fields (keys) in the database variable db

#ADDKEY db key value	adds the key=value to the database variable db.  Supports the Name=Value syntax.
#DELKEY db key	deletes the key from the database variable db
#SHOWDB db	displays the database variable db on the screen
#LOOPDB db commands	loops through each field in the database variable, assigns the field name to %key and the value of the field to %val, and executes the given commands.

Accessing Database RecordsAccessing Database Records
The currently selected database record can always be accessed through the %rec database variable.  For example, #SHOWDB %rec will display the current record to the screen.  All of the commands and functions in the previous section can be used on %rec.  The %db function (and the dot notation %rec.FieldName) is specially optimized to return the value of the database field very quickly.  Note that #DELKEY and %delkey do not function for %rec since you can't delete fields under program control.
To access a database record other than the current record, you specify the record number, appended to the database name.  If you leave the database name out, the current database will be used.  For example, to display record 20 in the current database, you can do
#SHOWDB 20
To show record 20 from the Equipment Name (name is eq), you would use
#SHOWDB 20eq
This syntax for record numbers can be used by in any of the database variable commands and functions described in the previous section (except for #DELKEY and %delkey).  In fact, the combination of a database record number and a field using the dot notation can be used anywhere a normal zMUD variable name is used.  For example,
#ADD 20.Hit 2
will add 2 to the Hit field of record 20 in the current database.  The side effect of this is that you cannot use variable names that start with a number when also using the Database Module.  Another, more complicated example:
#MATH 20.Hit @19.Hit*2
will set the Hit field of record 20 in the current database to the value of the Hit field in record 19 times two. Assignment statements also work with this notation:
20.Hit = 2
sets the Hit field of record 20 in the current database to 2.  This tight integration of database variables with the zMUD parser allows for some very powerful scripts to be written.
To retrieve the entire database variable from a database record, use the %dbget function.  The argument is the record number and optional database name.  So, %dbget(20eq) will retrieve record 20 from the Equipment Database.  The #DBGET command sets the current database variable (%rec) to the specified database record.
To set a specific record, use the #DBPUT command.  The first parameter is the record number to save.  If omitted, the data is stored to the current database record.  The second argument is the database variable to be stored, or a list of keys and values to be changed.  For example,
#DBPUT 20eq %dbget(21eq)
will store a copy of record 21 in the Equipment database on top of record 20.  Actually, you can do the work of #DBPUT with #ADDKEY, but sometimes it is easier to read to use #DBPUT.  For example, both of the following lines change the Name field of record 20 to Zugg:
#ADDKEY 20 Name Zugg
#DBPUT 20 Name Zugg
Actual database records also have an additional field name that is always present, called Num.  Num returns the record number in the database with the two-character database name appended to it.  So, in the above example, %db(,Num) would return 20eq.

Using Database ViewsUsing Database Views
The #VIEW command can be used to set the current database view, and can also be used to change the sort order or column order or to create a whole new view.  The first argument is the Name of the view.  The Name doesn't have to match exactly...just giving the first few unique characters is good enough.  For example, if you have a view called Weapons, doing #VIEW w will set it as the current view.  To create a new view, specify a name that does not yet exist.
The second argument of the #VIEW command is a string list of columns to specify the sort order.  If omitted, the sort order is not changed.  If a minus sign (-) is placed in front of the field name, it is sorted in reverse order.  To clear all sorting for the view, use a second argument of just a minus sign:
#VIEW Weapons {-Hit|Name}}
will sort the Weapons view in reverse order of the Hit field, then in order of the Name field.
#VIEW Weapons {-}
will clear all sorting of the view.
The third argument of the #VIEW command is the string list of columns to display.  If omitted or blank, the current columns are kept. 
#VIEW NewView {Name} {Name|Hit|Dam|Comment}
will create a new view with the name NewView sorted by the Name field, and displaying the Name, Hit, Dam, and Comment fields in columns.
The #VIEW command can also be used to refresh the current view (resort and reapply filters) and optionally display it to the MUD window.  If the first argument is blank or zero, the view is displayed to the MUD Window.  If non-zero, the view is refreshed but not displayed.
The optional fourth parameter to the #VIEW command can be set to non-zero to specify a pivot table, which is described in the Advanced Database section.

Setting View FiltersSetting View Filters
To filter records in a view, use the #FIND or #QUERY commands.  The #FIND command, by default, searches the first column of the view for records that contain the first argument.  So,
#FIND sword
will display all of the records that have the word "sword" somewhere in the first column of the view.  If the first column is a number field, the number must match the #FIND argument exactly.  The optional second argument specifies the View and Database to be searched.  By default the current view is used.  You can specify a view name, or a string list with the view name as the first item, and the database name as the second item.  So:
#FIND blue Potions
will display all of the records in the Potions view whose first column contains the string "blue".  In other words, it pretty much does what it says...finds the blue potions.  This makes the #FIND command a natural selection to query the database from the command line.  
The optional third argument specifies the column to search instead of the first column.  So,
#FIND str Weapons Comment
will search the Comment field for the string "str" and display the results from the Weapons view.
Normally the results of the #FIND command are both updated in the specified view, and also displayed to the MUD window.  To prevent the display output to the MUD window, set the optional fourth argument to a non-zero value.
The #QUERY command is similar to the #FIND command, but instead of searching a given column for a particular string or number, you can specify a general query formula.  You use the &FieldName syntax to refer to fields in the database, and form a normal zMUD expression that returns true for the records you want to display.  For example
#VAR Level 20
#QUERY (&Level=@Level)
will display all of the records in the current view that have the Level field equal to 20 (the value of the @Level variable).  
The optional second argument of #QUERY is the View|Database to use instead of the current view, and the optional third argument is non-zero to prevent the display of the results to the MUD output window.
The %query function is similar to the #QUERY command, and the %find function is similar to the #FIND command.  The difference is that instead of displaying the results to the screen, they return a string list of the record numbers that match the filters.  So, if the two blue potions in the Equipment Database are records 8 and 21, %find("blue","Potions") will return 8eq|20eq.  You can then #FORALL over the results to manipulate each record.
#FORALL %find(Blue,Potions) {#SHOW &Name}
will display the Name field of each blue potion in the database.
To undo any #FIND and #QUERY command and return the view to its original state, use the #DBRESET command.  The current record is also reset to the first record of the view.  The optional second argument of the #DBRESET command is the name of the View|Database to reset.

Accessing Records in a ViewAccessing Records in a View
Once a view has been sorted and filtered the way you want it, you can access each record in the view sequentially to perform various operations.  The #DBFIRST command sets the current record to the first record in the view.  The #DBNEXT command sets the current record to the next record in the view, and the #DBPREV command sets the current record to the previous record in the view.  When you access past the first or last record, then %rec returns a null value.  So, to loop through all the records in the current view and display the Name of each record, you would do:
#DBFIRST;#WHILE (!%null(%rec)) {#SHOW &Name;#DBNEXT}
This command sets the first record as the current, then loops until the %rec is null displaying the Name field and moving to the next record.  Don't forget the #DBNEXT or you will get an infinite loop (which you can abort using the ESC key).
You can also loop through a view using the #LOOPVIEW command.  This is sometimes easier than using the #WHILE command above.  By default, #LOOPVIEW cycles through the records in the current view.  To specify a different View|Database, use that as the first argument and put the commands to execute in the second argument.  So, you can also display the names of all the items in the current view with
#LOOPVIEW {#SHOW &Name}
which is much simpler than the example using #DBFIRST and #DBNEXT although less powerful.  If you wanted to display the names of the records in the Potions view, you would use
#LOOPVIEW Potions {#SHOW &Name}
You can also directly access records in a view using the %viewrec function.  The first argument is the record number to retrieve.  The first record in the view is record zero.  The optional second argument is the View|Database to query.  The optional third argument is set to non-zero to return formatted fields instead of raw data.  The %numrec function will return the number of records in the current view.  Its optional argument is the View|Database to query.

Database Column calculationsDatabase Column calculations
There are several zMUD functions that loop through a specific column in a view automatically and compute a result.  The first argument to these functions is the name of the Column (field) to loop through.  The second argument is optional and specifies the View|Database name to use.  If missing, the current view and database is used.  A complete list of these functions are:
%sum	Returns the sum of each value in the column
%average	Returns the average value of the column
%stdev	Returns the standard deviation of the column
%count	Returns the number of non-empty values in the column
%dbmin	Returns the minimum value of the column (and sets %rec to that record)
%dbmax	Returns the maximum value of a column (and sets %rec to that record)
%dblist	Returns each value in the column as a string list
For example, %sum(Hit) would return the sum of the Hit field for all records in the View.  %dblist(Name) would return a string list of all of the record names in the current view.  For the most part, these formulas are intended for use in a pivot table (see Advanced Database usage), but can be used for any other purposes.

Creating New RecordsCreating New Records
You can create new records in the database within a script using the #NEW command.  The first argument is the View|Database to create the record in.  If blank, the current view in the current database is used.  The following parameters are the Name and Value of each field you want to add.  The Name1=Value1|Name2=Value2 syntax is also supported.  You can also specify a database variable if you'd like.  Some examples are:
#NEW Weapons Name "short sword" Damage "1d6" Hit 0 Dam 2
#NEW Weapons {Name="short sword"|Damage="1d6"|Hit=0|Dam=2}
#VAR NewWeapon ""
#ADDKEY NewWeapon Name "short sword"
#ADDKEY NewWeapon Damage "1d6"
#ADDKEY NewWeapon Hit 0
#ADDKEY NewWeapon Dam 2
#NEW Weapon @NewWeapon
Each of the above scripts creates a new weapon in the database.
The #NEW command can be used to create a new record in the database by capturing the result of an "identify" spell or command on the MUD.  For example, let's look at the following MUD output for identifying a weapon:
> cast identify sword
Name: short sword Type: Weapon Cost: 1000 Weight: 5
Damage: 1d6 Hit: 0 Dam: 1
To create a new item based upon this output, we would first create an alias to cast identify, initialize out record variable and turn on a trigger class:
#ALIAS identify {#T+ identify;#VAR Item "";cast identify %1}
Then we would set up some triggers in the Identify class to parse the output and create a new variable:
#TRIGGER {Name: (*) Type: (%w) Cost: (%d) Weight: (%d)} {#VAR ItemType %2;#ADDKEY Item {Name="%1"|Cost=%3|Weight=%4}} identify
#TRIGGER {Damage: (*) Hit: (%d) Dam (%d)} {#ADDKEY Item {Damage=%1|Hit=%2|Dam=%3}} identify
#TRIGGER {$} {#T- identify;#IF (!%null(@Item)) {#NEW @ItemType @Item}} identify
The first two triggers capture the two lines of output from the identify spell and put the matched values into the NewItem database variable.  The third trigger matches a blank line and turns off the identify triggers and if the NewItem has a value, adds it to the database using the #NEW command using whatever view corresponds to the object type (in this case, Weapon).
Now, each MUD output for the identify commands is different, and in most cases the output is different depending upon the type of object being identified.  Thus, your triggers will likely be more complex than this example.  However, given the4 flexibility of zMUD triggers and the scripting language for the database, almost anything is possible.
A more extensive (advanced) example
If you are an expert in writing triggers, then you have probably discovered the useful &VarName syntax which will capture a value from the MUD and automatically assign it to a variable.  As a review, instead of doing
#TRIGGER {(%d)hp (%d)mana} {#VAR hp %1;#VAR mana %2}
you can just do:
#TRIGGER {&{hp}hp &{mana}mana} {}
Using the new dot notation syntax for database variables, the example from the previous section can be rewritten as:
#TRIGGER {Name: &Item.Name Type: &ItemType Cost: &Item.Cost Weight: &Item.Weight} {} identify
#TRIGGER {Damage: &Item.Damage Hit: &Item.Hit Dam &Item.Dam} {} identify
#TRIGGER {$} {#T- identify;#IF (!%null(@NewItem)) {#NEW @ItemType @Item}} identify
Note that the {} around the variable name are not needed since the space after the value delimits the end of the variable name.
OK, so all we have done here is save some typing.  Where this syntax becomes powerful is when we want to handle the case where the identify output varies depending upon the object.  For example, on many MUDs, if the item does not have a Hit bonus, the Hit:value is not even displayed in the identify output.  In this case our second trigger would never fire.  What we want is a separate trigger for each possible item property:
#TRIGGER {Name: &Item.Name Type: &ItemType} {} identify
#TRIGGER {Cost: &Item.Cost} {} identify
#TRIGGER {Weight: &Item.Weight} {} identify
#TRIGGER {Damage: &Item.Damage} {} identify
#TRIGGER {Hit: &Item.Hit} {} identify
#TRIGGER {Dam: &Item.Dam} {} identify
#TRIGGER {$} {#T- identify;#IF (!%null(@NewItem)) {#NEW @ItemType @Item}} identify
You can now expand this list of triggers to include any attributes that the identify command might display.  This is a much cleaner and more powerful way to create new database items from the output of the MUD.

Working on the Database behind the scenesWorking on the Database behind the scenes
In all of the examples so far, the command language manipulated or accessed the database, but also changed the user interface of the database.  For example, the #VIEW Weapons command will change the current database to the Weapons view.  zMUD also has a powerful way to perform scripts in the background without effecting the user interface.  The user can be editing a different view of a different database while your script is running.  Only if your script accessing the same record that the user is editing does a conflict occur, with whoever saves the record last taking priority.
To work in the background, use the #DBOFFLINE command.  Now, all database commands and functions will work as normal, but no changes will be displayed in the database user interface.  To return to "live" mode, use the #DBONLINE command.
The %find and %query commands already work in Offline mode so you don't have to worry about them.  Also, the column functions: %sum, %average, %stdev, %count, %dblist, %dbmin, and %dbmax already work in Offline mode.

Advanced Database usageAdvanced Database usage
In addition to controlling and accessing the Database Module from the command line, the database can also access scripting variables itself.  While the user-interface was designed to hide some advanced options from new users, there are several ways to customize database views beyond the simple sorts and filters.  In addition, you can set up additional columns that display computed results rather than just displaying database field values.
Formula Fields
A Formula Field is a database field whose value is calculated on the fly rather than being stored in the database.  These fields can be added to views, sort order, filters, or anything else that a normal field can be.  The main difference between a Formula Field and a normal field is that a Formula Field is read-only.  None of the operations or commands that modify a field will work on a Formula Field.
To define a Formula Field, go to the Field mode and create a new field.  Click the option labeled "Use Formula" and a new text box will be displayed for you to enter your formula.  The formula should be a standard zMUD scripting expression.  It can return a text or numeric result depending upon the field type that you set.  For number fields you can also still select the formatting option that you want.
For example, most MUD weapons have a Damage field indicating the amount of damage the weapon normally does, represented by a dice roll such a 1d6 (roll one 6-sided dice) or 2d4 (roll 2 4-sided dice), etc.  zMUD has several functions for manipulating dice rolls.  A common attribute that you might be interested in is the average damage caused by the weapon.  This can be computed using the %diceavg function.  So, create a New field and turn on the Use Formula option.  In the Formula box, enter:
%diceavg(&Damage)
and set it to be a numeric field.  Now when you add this column to your Weapons view you will see the average damage caused by the weapon (times 100).
Internal Fields
Internal fields are created by checking the Internal option in the Field definition window.  Internal fields are never returned as a result of a scripting command or function.  They are basically hidden from the scripting language.  The main use for Internal fields is for display-only formula fields.  If the field is not marked as internal, the formula is computed whenever the record is accessed by the script.  For complex formulas this can slow down database access.  Set the formula field to Internal to prevent these extra calculations.
Using Variables in Filters
When creating a filter for a view, you might want to filter based upon the value of a zMUD variable.  For example, you might want to only display equipment that has a Level field less than or equal to your current character level.  All of the record filters have a button next to them labeled with a @ character.  Click this button and the field will change to a standard text field where you can enter a zMUD formula expression.  Notice that the @ button changes to a # button which will take you back to the normal input box.  Text fields do not have the @ button since you can already enter a text formula into the box.  The only fields that have the @ button are Number and Option fields.
For example, to only display items with the Level field less than or equal to the @Level variable, turn on the Filter Bar in the Toolbar option of the View menu if it isn't already displayed.  Select the Level field in the field selection box.  Select Less than or Equal to in the Operation selection box.  Click the @ button next to the numeric entry field to switch it to a text entry field.  Enter @Level in the text box.  Click the Filter button to apply the filter.  Now, from your zMUD command line, if you change the value of the @Level variable, the database view will automatically refresh to show the equipment that matches the new query.
The above example illustrates the drawback associated with using variables to filter views.  If the value of the variable changes, the view must be resorted and re-filtered.  This can take some time on large databases.  So, make sure you don't filter on a variable that is changing often.
Sorting based upon a Score
In many cases, you don't just want to sort on a specific field, but you want to sort based upon a combination of fields.  For example, if you are a Fighter, you want to display the best equipment for a fighter, which means weapons that have a high damage, high hit bonus, and high damage bonus.  If you are a magic user you want to display equipment that adds to your mana or your intelligence.  So, deciding which equipment is "best" depends upon the type of character you are playing and can be quite complex.
You can define a formula that returns a numeric value for each record in the database and then sort on the results of that formula.  To do this, customize the view and enter the formula into the Formula field in the Sort Order area.
For example, a formula to display the best equipment for a fighter might be:
%diceavg(&Damage)+&Dam*2+&Hit
which will display the weapons with the best ones on top.  In this case we are looking for weapons with a high average damage potential and giving extra weight to those weapons with a high damage bonus (the *2 acts as a weighting factor).
Pivot Tables
Pivot Tables extend the concept of sorting equipment based on a score one step further.  In a pivot table, the "best" records for each possible value of the first column in the view are displayed.  To create a pivot table, simply click the Pivot Table option in the View window.  The view will be displayed with each possible value in of the first column of the view displayed.  In each row, the best equipment whose field contains that value will be displayed.  
To better understand this, think of creating a new view where you filter the first column to contain a specific value.  zMUD will filter and sort and display the view.  The first record displayed in that view is the best record for that particular query.  Next, change the filter for the first column to equal the next possible value and resort the view.  The first record is the best record for the new first column value.
As a more concrete example, consider an equipment database with a field called Kind which indicated the type of equipment (Weapon, Armor, Helm, Ring, etc).  When you create a pivot table with Kind as the first column, the best equipment for each value of Kind will be displayed.  If you use a Sort Score of something like &Hit+&Dam+%diceavg(&Damage) then the best equipment for a Warrior will be displayed.  You can still use any other record filters that you want.  A better view would only display equipment less than or equal to the current character level.  Then, as your level changes you just consult this pivot table to determine what the best equipment you should be wearing is.
When you create filters in a Pivot Table, filters on Formula fields occur after the pivot occurs and filters on normal records occur before the pivot.  So, if you filter on a normal field like &Name, you are restricting the portion of the database that the pivot is created from.  But, if you filter on a Formula field, such as %count(Name), this filters which pivot rows are displayed in the view.
The use of Formula fields allows you to perform standard pivot table analysis on a database.  These formulas operate on the list of records being considered for each row in the pivot table.  For example, if you use a formula of %count(Name) in a column called "Count", then the Count column will display the number of records in each pivot table.  In the example above, it would show the number of Weapons on the weapon row, the number of Armor objects on the Armor row, etc.  Using a formula like %dblist(Name) will display the names of each item considered in the pivot row.  Note that the use of column formulas will further slow down the calculation of the pivot table.
This is an incredibly powerful feature of the database module.  However, performing a pivot table computation can also be slow depending upon the size of the database.  If you can set up any view filters to reduce the number of records that the pivot table must search, you will speed up the computation.  But, while you are waiting on it, just think about how hard it would be to search the database yourself for the best equipment of each type!
The Database and the Mapper
The Database is integrated to the mapper via Zone and Room fields.  There should only be one zone and room field per record.  Zones and Rooms are stored as numeric fields, but are displayed in the database by their Names when possible.  Room names can only be displayed if the Zone field for the record matches the current zone being displayed in the mapper window since the mapper only loads one zone into memory at a time.  Rooms can only be edited as integers though since many rooms on a map tend to have the same name.
The Actions menu contains commands to manipulate the mapper.  The Set Object Location commands sets the Zone and Room fields of the current record to match the currently selected location in the mapper.  The Find Object Location takes the Zone and Room fields of the current database record and centers the mapper on that location.  The Walk to Object command speedwalks from the current map position to the position given by the Room and Zone fields for the object.  If no zone field is present, the current zone is assumed.
Record Fields
Fields of type "Record" are pointers to other database records.  They contain the normal record specifier which is the record number with the optional two-character database name appended to it.  The value of these records will be displayed as the Name field of the matching database record.  If no Name field is found, the first Text field is displayed.
These fields are used to link databases together.  For example, you might link an Object to the Monster that carries it.  The Goto Linked Record command in the Action menu loads the record that the current record is linked to.

Introduction to MappingmappingIntroduction to Mapping
zMUD has a mapping module built-in that allows you to create maps of your MUDs.  These maps are interactive and in addition to simply giving you a visual picture of your MUD, allow you to speedwalk anywhere based upon room names, automatically opening doors while walking, and much more.  Maps can also be printed for offline use. The automapper adds a whole new perspective on MUDding, both for new users as well as advanced users.
Here are some of the basic features of the mapper:
Automatic configuration of mapper for your specific MUD
	Versatile parsing can handle most MUD formats automatically
Zones allow maps within maps. Each zone can be multi-level
Can speedwalk to a room by double-clicking on the map
Room names and descriptions (and exits) automatically captured from the MUD
Can automatically generate map (with proper configuration) as you walk around
Manual editing functions for tweaking the map
Handles multiple levels (up/down), along with all 8 normal directions (n.s,e,w,ne,nw,se,sw) and non-standard exits defined by the user.
Cost of room traversal can be adjusted to improve optimal speedwalking
Handles one-way exits for maze areas
Handles doors with auto-opening code during speedwalking

Select one of the help topics below, or press the Next button to go to the next mapper topic:
Configuring the Mapper
Editing Topics
Using Zones
Introduction to Paths/Speedwalking
Speedwalking with the Map
Advanced Mapping Topics
	Improving Room Detection
Shortcuts and Tricks

Configuring the Mappermappingmapping,configurationConfiguring the Mapper
Because every MUD is different, it is impossible to pre-configure zMUD to automatically start mapping the MUD you play.  Before you can start using the mapper, zMUD must learn how your MUD displays rooms as you walk around the MUD.  zMUD makes extensive use of the exit information displayed by a MUD.  Because of this, make sure you have turned on any option or flag necessary on your MUD to see the exits from a room.
The automapper is intimately tied with the Directions settings used by the speedwalking module.  If you are not using the standard DEFAULT.MUD default settings file that is supplied with zMUD, make sure you edit you have Directions defined (View/Directions menu) so that words and commands are tied to the proper map directions.  If you don’t know what this means, assume you are using the proper default file and continue reading.
You can configure the mapper two different ways: Auto Configure (recommended), Manual Configure (only for those who know what they are doing).
How the AutoMapper works
Before you can configure the mapper, you should understand how the mapper works.  The mapper first groups text received from the MUD into paragraphs.  Paragraphs are lines of text separated by a blank line or a line that looks like the MUD prompt.  A MUD prompt is defined as a line with several punctuation characters, more numbers than letters, or a simple text string surrounded by brackets (configurable).
Once the mapper has grouped lines into paragraphs, each paragraph is searched for exit information.  Exit information is defined as lines containing keywords from the Directions settings, and optionally an exit keyword (which defaults to the string "exit").  Once the paragraph and line(s) containing the exit information are found, the mapper uses its configuration information to flag the room name (if present) and room description (if present).  Because the mapper starts its search based upon the exit information, getting the exits identified properly is the key to configuring the mapper.
Automatic Configuration
For approximately 95% of the muds out there automatic configuration will work.  This includes all Simutronics muds, most ROM/Diku muds, and practically every MXP enabled mud.  This is the first step when trying to configure the AutoMapper.  For Simutronics muds and MXP enabled muds it is still required to run the Automatic Configuration so mapper knows to expect the MUD to supply tagged information.  Even when the mapper successfully configures automatically, you may want to tweak the configuration.  Reading the Manual Configuration page will give you an idea of how you can adjust the mappers parsing routines.
Offline Configuration
Instead of configuring the mapper using text captured from the MUD, you can provide your own text or log file by clicking the "Offline Setup" button in the upper-right corner of the mapper configuration wizard window.  You can then control what text the wizard sees.
Manual Configuration
You should always try auto configuration first and only resort to manual configuration if absolutely necessary.  There are many combinations of parameters for the mapper, and with manual configuration it is easy to set the mapper so that it doesn't work at all.  Only advanced users should attempt to configure the mapper manually.
Overriding the Mapper
If part of a room is not distinctly findable by any of these methods you may have to use the techniques described in this page.  If you can not find enough information in this help to configure the mapper you can search the online Forums to see if someone else has figured out how to do it.

Automatic Mapper ConfigurationAutomatic Mapper Configuration
Automatic configuration of the mapper is the best way to get started mapping your favorite MUD.  To use this method, make sure you are connected to your MUD, then open the Automapper from the Windows menu, or click the Map button on the main toolbar.  A blank map window will be opened.  Click the Map Mode button in the mapper tool bar to begin creating a map.  Since the mapper has not yet been configured for your MUD, the Auto Configuration window will appear.  If the wizard doesn't appear or later you need to change the configuration, you can start the wizard by selecting Reconfigure from the Config menu in the Mapper window.
In the box provided in the wizard, enter a command to move you in some direction out of the current room you are in.  For example, enter north, south, east, or west depending upon the exits for the current room.  After you have entered this command, click the Next button.  The movement command you entered will be sent to the MUD and the text displayed by the MUD is captured by the mapper configuration wizard.  You will be prompted for what items you would like the wizard to automattically detect.  If you are on a slow connection or slow MUD and the wizard doesn't wait long enough to receive the full room description, click the Back button and increase the delay time on the main screen.  Keep trying until you get a clean capture of a room.
A clean capture is indicated by the screen that displays the output received from the MUD and highlights the detected room name, description, and exits in colors.  If the configuration wizard did not properly detect this information, try capturing another room by clicking the Back button and trying again.  If the wizard cannot properly detect the room information automatically, you may be able to configure the mapper manually, but you will likely have trouble with the mapper.
Name, Description, and Exits
Once the text has been captured from the MUD or entered manually, you are prompted to select which type of information the wizard should scan for.  Normally you want the wizard to scan for the room name, description, and exits, which is the default.  However, if your MUD is in "brief" mode, you might want to turn off the detection of the room description.  Turning off detection of the room exits is normally a bad idea since the room exit information is so critical in detecting a new MUD room.

Mapper Wizard OfflineMapper Wizard Offline Mode
The Offline Mode of the mapper preforms exactly the same as the Automatic.
To use the Offline Mode manually enter or paste text into the box on the left, or use the Log File control to read a log file into the config wizard.  When you click Next, the text you supplied will be used to configure the mapper instead of the text from the MUD.
The Capture from MUD button in the lower-left corner of the window is used to capture the text from the MUD just like when using the autoconfigure mode.  The same command used for autoconfigure (default of "south") will be set to the MUD and the output will be captured.  You can then edit the text from the MUD as needed.
After you click next all steps are the same as described in the Automatic Configuration page.

Manual Mapper ConfigurationManual Mapper configurationManual Mapper Configuration
Manual Configuration
To completely change the configuration manually with no interference from the auto config wizard, select Configuration Settings from the Config menu.  The mapper properties dialog will be displayed, and the section for the Room Name configuration will be shown.
Paragraphs and Lines
Paragraphs are numbered starting at zero for the last paragraph received, and increasing as you move back into the scroll buffer.  So, the most recent paragraph is zero, the next most recent is one, and so on.  Line numbers within the paragraph start at zero for the first line of the paragraph.
Room Name Configuration
If the MUD displays a room name, make sure the Room Name option is checked.  If the MUD does not display a room name, such as for an LPmud in full mode, uncheck the Room Name option and go to Room Description.
If the MUD has a room name, you can specify the paragraph number and the line number within the paragraph.
If you are in wizard mode on your MUD and you want zMUD to look for the room number (called vnum) in the line containing the room name, click the Parse vNUM option.
You can tell the mapper whether to match room names at the beginning or end of a line.  Matching names at the end of the line is usually the best option since many MUDs display the MUD prompt before a room name some of the time.  However, if your MUD displays the room name as part of the exit information (such as on Medievia), you do not want to match room names at the end of a line since they will match in the exit info of the previous room.
Check Name ends with period only if all room names on the mud end with a period.
Check Room Name uses Proper case only if all room names on the mud use proper case.
Room Description Configuration
If the MUD displays a room description, make sure the Room Description option is checked.  Again mark the paragraph containing the room description based upon the numbering scheme described in the previous section, and mark the starting line of the description information.  If the room description covers more than one line, check the Multiline Description option.
Room Exit Configuration
The room exits is the most important section to configure properly.  If the mapper is unable to detect room exits, then it won't be able to find the room name or description.
You should normally make sure the Room Exit option is checked.  If your MUD does not display room exit information, you can turn this option off, but the mapper probably won't work.  As described in the Room Name section, set the paragraph number and starting line number for the room exit information.
If Exit information spans multiple lines sometimes on your MUD, select the Multiline option.  If the exit information is contained within the MUD prompt, select the Exit In Prompt option.  If the exit information is displayed in the same line as the room name, select the Exit In Room Name option.
In the View/Direction settings, each direction can have multiple commands.  For example, north is defined as "n|north" which means either "n" or "north" match this direction.  Normally the mapper will look for any of the names listed in the View/Directions for detecting directions.  However, if you select the Use Short Exit Name option, only the shortest name for the exit will be searched for.  This helps the mapper ignore exits in the description (that usually use the long name) if the exit line always just contains the short version of the exit.
The Use entire exit paragraph option is for muds that put the exits in the description.
To help the mapper find exit information when you are in a room without exits, the mapper uses an exit keyword.  This is a word or phrase that is always present in the exit line.  By default, this keyword is "exit".  On some MUDs you might want to make this "obvious exit" to make it more unique.  To more unique this phrase is, the easier time the mapper will have at finding the exit information.  The Exit Line Contains Key option tells the mapper whether to look for this keyword or not (you will usually want this on).  If the exits occurs on the line immediately following the exit phrase, select the Exits After Keyword option.  These two options can not be used at the same time.
MUD Prompt
The final configuration screen allows you to set some options about how your prompt should be detected.  If your prompt was recognized during Automatic configuration you check Auto Prompt detect and uncheck all other options here.  Checking No Prompt tells the mapper to not look for a prompt, this can cause the mapper to not capture every line it should.  The Complex Prompt option indicates that the prompt may be different each time it is received, this should almost always be checked.  You can specify whether lines containing a simple text string followed by a bracket (>, ], ) ) character is considered to be a prompt with the Allow string> prompts box.  Use Number prompt if your prompt always starts with some number.  The Prompt Char parameter is used by the mapper to detect a simple MUD prompt, any line that begins with this character is flagged as a MUD prompt.
In general, making your prompt more complicated will help the mapper work better.

Overriding the MapperOverriding the Mapper
While the mapper works great on many MUDs after auto-configuring it, there are some MUDs that are tough to map.  The mapper contains many powerful commands that enable you to map complex MUDs.  With these commands, you should be able to map any MUD with a little effort.
Basic Overrides
All to often text will be received between the moment a direction command is sent and room information begins to be received.  There are some advanced tricks you can use that will modify your MUD output before the mapper has a chance to see it.  You can do this using Triggers.  With the #SUBSTITUTE command, you can remove any special characters that are giving the mapper trouble, or add characters that the mapper needs like blank lines.  You can tell the mapper to ignore lines altogether using the #NOMAP command.  You can override any of the automapper detection with the #TAG command.  Finally with you can abort a failed movement with #NODIR.  It is recommended that whenever you use a trigger to change the mapper behavior, you run the autoconfigure wizard after adding the trigger so that the mapper configuration gets set properly.
Fixing the MUD Prompt
The mapper is sensitive to the Prompt used on your MUD, since it flags this as the same as a blank line, separating room information.  If the mapper cannot auto-detect your MUD Prompt, then the mapper will have trouble.  By default, the mapper looks for a line that contains more numbers and special characters than regular letters.  So, a prompt like: "[100 hp 100 mana]" works the best.  If you cannot change the prompt on your MUD to be something like this, you can use the #TAG command to force the mapper to detect your prompt.  In this case, go to the Other Config page in the Mapper Preferences and turn off the Auto Prompt detection.  Then set up a trigger for your prompt.  For example, if your prompt is a simple * character, use a command like:
#TRIGGER {^~*} {#TAG prompt}
to tell the mapper what the prompt looks like.
Using the TAG command
The #TAG command, while extremely powerful, requires precise triggers.  You can use this command to force the mapper to recognize a room name, exit information, description, vnum, flags, prompt, etc.  This is done by having a trigger capture information from the received lines.  For example, if your MUD displays room names in brackets like: "[Room Name]" you would could up a trigger like this:
#TRIGGER {^~[(*)~]} {#TAG name {%1}}
This tags the line as a room name and captures the text between the brackets and sends it to the mapper.  In this case a trigger using #SUBSTITUTE would work as well.
You can combine multiple tags for a single line.  For example, if your MUD displayed the room name, exit information, and room number in the same line like this: "Room Name [n,s,e] #20" then you would set up a trigger like this:
#TRIGGER {(*) ~[(*)~] ~#(%d)} {#TAG name,exit,vnum {%1} {%2} {%3}}
to tag the line, capture all the information, and send it all to the mapper.
Whenever you set up Tag triggers, you must also Tag your prompt and Reconfigure the mapper so that it will properly recognize your new triggers.  Also note that you do not need to detect everything with the #TAG command.  Just detect what you need to and let the autoconfigure detect the rest.  In many cases, just detecting the MUD Prompt is good enough.

Creating and Edittingmappingmapping,usageCreating and Editting a Map
Once you have configured the mapper, creating a map automatically is as easy as walking around your MUD.  Just make sure that when you want to create a map your mapper is in Map Mode.  When in Follow Mode, the mapper will follow you around to existing rooms but will not create new rooms.
While you walk around your MUD, the mapper will autodetect room names, descriptions, and exits and add rooms to the map.  Rooms are indicated as squares.  Connections between rooms (called Links) are drawn as lines.  This simply display can be vastly enhanced by zMapper.
Mapping MUD areas (zones) is a tricky business.  Most MUD areas are designed to be challenging to map even by hand, so the zMUD Automapper won't always be perfect.  By default, zMUD assumes the distance between rooms is the same.  On some MUDs, moving between two rooms actually covers a long distance.  You can drag rooms on the map by clicking them with the mouse, holding the left mouse button, and moving the mouse to drag the room.  When you let go of the mouse button the room is dropped into place.  Use this feature to position the rooms as needed to make a more comprehensible map.
zMUD uses the room information from the MUD to determine if you have visited a room before.  Sometimes it will create a second room on top of another because it looks like two different rooms to zMUD.  In most cases, it really is two different rooms, and you should drag the different rooms to other locations to make the map more readable.  zMUD displays multiple rooms on top of each other by offsetting the rooms slightly.
If the mapper made a mistake and created two different rooms that are really the same, make sure they are stacked on top of each other and select the Merge option from the Edit menu, or right-click context menu.  That will cause all of the rooms stacked together to be merged into a single room.
Dragging rooms to new locations and merging identical rooms are the most common manual editing tools you will use while creating your map automatically.  There are many more manual editing functions described in the next page.  Just remember that zMUD won't move any of your rooms around the map, it will just create them for you.  To move rooms where you want them you must drag them with the mouse.  However, the advantage of this is that once you have your map looking the way you want, you won't have to worry about the mapper messing it up.

Editing your MapEditing your MapEditing your Map
Creating a map with the keyboard
To add rooms to a map quickly and easily, select "Keyboard Creation" from the Zone menu and the map will be put into Map mode.  Now the keys on the keypad can be used to move around and create rooms as you go.  These keypad keys will also work while the Room Properties window is open, so you can type the Room Name and Description, then press a keypad key to move in a direction and create a new room.  This allows you to create a map offline very quickly.
Selecting Objects
To select a room or a link between rooms, click on it with the left mouse button.  The selected object will highlight (default is red).  To select multiple objects, hold down the Shift key when you click on new objects.  Shift-clicking toggles the selection status of an object, so to de-select it, just Shift-click a second time.
You can also select multiple objects by drawing a box around all the objects you want selected.  Simply click in an open area on the map, hold down the left mouse button, and move the mouse to display the selection box.  When you release the mouse button, everything within the selection box will be selected.
Moving Rooms
To move a room (or all of the selected rooms), click on the room with the mouse, hold the left mouse button, and move the mouse to drag the room to a new location.  Release the mouse button to drop the room in the new location.
You can also move a room or selection of rooms using the Move dialog in the Edit menu.  This dialog allows you to specify the number of squares to move the room in any direction, including up and down.  Using the Move menu is the only way to move rooms to a different level (up or down).
Deleting Objects
To delete objects, select the objects as described above, then click the Delete tool in the drawing toolbar on the left of the map.  Or just press the Delete key on the keyboard.  Deleting a room that is connected to another room will cause all links to become unattached stubs.
Adding New Rooms
To add a new, blank room to the map, click the Add button (rectangle tool) in the toolbar on the left of the map and click on the map where you want to add the room.  Select Properties from the Edit menu to enter a room name and description for this blank room.
Linking Rooms
Connections between rooms are called links and are added with the Link (line) button in the toolbar on the left of the map.  To connect two rooms together, click the link tool, then click the edge of the first room (or just inside the edge) then click the edge of the second room (or just inside the edge).  A line will be drawn between the edges of the two rooms.  The top edge of the room represents north, the bottom edge: south, the right edge: east, the left edge: west, and so on.  The diagonal corners of the room represent the diagonal movement directions.
The above method for adding a link is called the two-click method (because you click twice: once on the first room, and once on the second).  You can also add a link using the click and drag method.  To do this, select the Link tool.  Then, click on the edge of the first room, but hold down the mouse button.  Then move the mouse to the edge of the second room and release the left button.  
You also use the click-and-drag method to move a link.  Click on the end of the link you want to move and hold down the left mouse button.  Move the mouse to the new place you want the link connected to and release the button.  The link will be changed to point to the new room or direction.
Links are deleted just like rooms: select the link then click the Delete tool or press the Delete key.
Links can also have both ends pointing to the same room.  This is displayed by a little circle on the side that you would leave the room from.
Links can Bend
Sometimes you need to connect two rooms that are not adjacent to each other.  While the mapper tries to draw the link properly, sometimes it will be drawn through other rooms making the map look ugly.  You can add bends to a link to change how the link is draw so that it can be drawn around other objects.
To add a bend to a link, right click somewhere on the link and select Add Bend from the context menu.  When the link is selected, the bend is shown as a square box.  You can click on this box, hold down the mouse button, and drag it to another location on the map.  If the Snap To Grid option is on in the Options menu, the bend can only be placed in certain locations on the map to make it easier to line up straight lines.  You can turn off the Snap To Grid option to drag the bend to any location on the map.  You can add as many bends to a link as you want.  Using this feature you can even create a circular link!
To delete a bend that you no longer need, right click on the square box that represents the bend and select Delete Bend from the popup menu.
One-way links and Doors
Sometimes on a MUD you move in a direction and then cannot go back.  This is called a one-way link and is represented by an arrow on the map.  To change a link into a one-way link, right click where you want to put the arrow-head and select One Way from the context menu.
To add a door to a link, right-click the link and select Door from the context menu.  When you walk across a link that contains a door, the mapper will automatically send an "open door" command to your MUD that you can configure in the map properties, Strings and Doors section.
Adding Labels
You can add text labels anywhere on the map by clicking the Text tool in the toolbar to the left of the map.  Then, click on the place on the map you want to put the upper-left corner of the label.  A text-edit dialog will display for you to type in the label you want.
To move a label, just drag and drop it like you would move a room.  Labels can be selected and deleted just like rooms.  To change the text in a label, double-click the label to open the text-edit dialog.
Stacking and Merging Rooms
Any number of rooms can occupy the same location on the map.  If there is more than one room in the same spot on the map, they will be drawn slightly offset to indicate the stack.  To remove rooms from a stack, simply drag and drop the room somewhere else.
You can combine all rooms in a stack using the Merge command in the Edit menu.  The name and description of the room on the top of the stack is used for the combined room.

Map Object PropertiesMap Object Properties
Rooms and Links have properties that you can edit by right-clicking them and selecting the Properties option.  The properties of these objects are described in detail below:
Room Properties
Text Page
This page of the Room Property dialog allows you to view and edit the room name and description.  Also, below the description, you can add notes about the room (such as what objects or monsters it contains).  You can also add a Room Script to be executed when you enter this room.  For example, in a shop, you might put the "list" command into the script field so that it always displays a list of items when you enter the room.  Note the script for the room is preformed before room information is received to allow triggers to act on that information.
Exits Page
You can edit the exits (links) attached to the room.  These Link Properties are described in detail in the next section.
Appearance Page
On the Appearance page of room properties you can set the room color, or change the position of the room label.  To add a label that is attached to the room.  Simply click on the direction you want the label to be drawn.  By default, the name of the room is displayed in the Label.  However, you can change this by editing the Short Name field in the Other page of the properties.
Other Page
The Other page of room properties allows you to edit miscellaneous information about the room.
VNUM is used by wizards to identify rooms by number.  It is also used by all of the internal zMUD functions to access a room under script control.  Make sure that two rooms in the same zone do not have the same number.
The Short Name is a used to display the room label from the Appearance properties.  It also can be used to identify the room with many script commands and functions.
Cost to enter the room is used by the speedwalk algorithm to compute the shortest path between rooms.  If your MUD implements different movement costs for rooms you can enter the value in this field.  The Do Not Enter flag causes the walk alogorithm to treat the cost as 2 billion.
The Reload flags on the bottom of the page are used to tell the mapper whether to reload part of the room information the next time the room is entered while in Map Mode.  zMUD uses these options with the #LOOK command to reload all properties of a room, but you can use them manually if you like.
The Force Entry option forces the mapper to move you to this room without checking the MUD output first.  Use this flag so that the mapper doesn't get lost if you have a room that is hard for the mapper to recognize.
Finally, the Room Name options on the right of the page allow you to override the default speedwalking detection for individual rooms.  Normally, the configuration settings are used to form trigger that flags the success of a speedwalk step.  You can use the beginning of the line, end of line, or both by changing these options.  They only effect this individual room, and not the other rooms on the map (which are controlled by the master map properties).
Contents Page
This page crosslinks rooms to the Database module.
Link Properties
You can change the properties of a link by right-clicking and selecting Properties from the popup menu.  You can also edit links by selecting a room and displaying the Exits page of Room properties.
In any case, all of the links for a room will be displayed, with the currently selected Link highlighted.  You can change the link that you are editing by selecting it from the list on the left side of the dialog.
In the center of the dialog, the properties for From side of the link are shown, and on the right side the properties To end of the link is shown.  To move to the properties of the destination room, click the Jump To Room button (arrow to the right of the room name).
For each end of a link you can control the direction used to draw the link and to speedwalk through the link.  The 8 cardinal directions, as well as up and down are shown as buttons.  As you click these buttons, the link will be displayed in the new direction on the map.  You can unselect all directions to prevent the link from being drawn at all.  The Other direction is used to create links for non-standard directions.  If you click the Other direction, the link is shown as a small solid circle to the lower right of the room.  In the Other Com field  you enter the command that will move you on the MUD to the destination room of the link.  For example, if you type "enter" to enter a room on your MUD, put the word "enter" in.
Note that entering a value into the Other Com box overrides the normal movement command for the room no matter what link direction is selected.  For example, if you have "enter" in the Other box, but have the North button selected, the link will be drawn to the north of the room, but you will still need to type the "enter" command on the MUD to traverse the link.  Going North will not traverse the link.  Thus, the way a link is drawn and the movement command used to cross the link are two different values.  You can really get yourself confused with this, so be careful.  For example, you can put "west" in the Other Direction box, but show the link to the East!  What power.
Below the Link Directions are the options for One Way links and Doors.  Note that doors can be one sided (select Door on one end of the link, but deselect it on the other end).  The open door command is only issued when traversing a link that is marked as a door.  By default, the open door command just uses the direction of the door.  For example, a door to the north is opened with the "open north" command.  Some MUDs require the name of the door to be used.  Place the name of the door in the field next to the Door button, and use the %2 parameter in the Door Command string of the Map properties to represent the name of the door in the open command.  Doors can also be locked, but currently only two-sided doors can be locked.  The locked door is only displayed visually and has no other function at this time.
Sometimes links connect rooms across the map rather than adjacent rooms.  You can create a "broken" link with a label by entering a value into the Link Label field and turning off the Draw Link option.  For example, you can put the text "A" in the Link Label and turn off the Draw Link option.  At each end of the link, a short line stub will be drawn on the room in the proper direction, and the label "A" will be drawn next to the link.

Room ScriptsRoom Scripts
Room scripts allow you to assign commands to a room that are executed when you enter the room.  Any settings defined in a room script are added to a temporary Class and are removed when you exit the room.  This allows you to define aliases, triggers, buttons, etc that are only active in a particular room.  Note the Room Scripts are created immediately after sending the direction to allow triggers to act on text received as part of the room information.
To create a room script, open the Properties for a room.  Below the Room Name and Description fields is an area for the Room Script.  Enter any normal zMUD scripting commands.  Newlines are replaced with the current command separator (;) character when you save.
For example, a room script of:
list
#BUTTON 0 {Buy Bread} {buy bread}
#BUTTON 0 {Buy Potion} {buy potion}
will define two buttons, one for buying bread, and another for buying a potion.  When you enter the room, the 'list' command is automatically sent to the MUD.  This might be useful in a store where you want to see what is for sale and then buy stuff by just hitting a button.  The buttons will be removed when you exit this room.
The combination of room scripts and offline mapper usage allow you to turn zMUD into a powerful Dungeon Master tool or for developing offline D&D scenarios.
Note that the room script is only executed when you move into a room.  It is not executed if you manually select the current room on the map.  To execute a room script for a given room, right-click on the room and select Execute Room Script from the context menu.

Using ZonesUsing ZonesUsing Zones
Most MUDs group rooms into "areas" or "zones".  These zones are then linked together to form the MUD that you play.  In fact, some zones were built many years ago and are shared on many different MUDs, sometimes with minor or major modification.  For example, the "Old Thalos" area is a common area on many DIKU MUDs.
The zMUD Automapper follows this same structure by splitting your map into zones that are linked together.  While you are not forced to split your maps into zones, it makes managing the huge MUD areas easier.
The main reason for creating zones is to clean up and simplify the display of your maps.  For example, when walking through town you might enter a mansion.  This mansion has several levels, an attic and basement and consists of dozens of rooms.  On the map of your town, you'd like the mansion represented by a single room.  Then, when you enter that room, you "zoom in" to see all of the rooms in the mansion.  By putting the mansion into a new zone, the rooms of the mansion do not get overlayed with the rooms of the town, reducing the clutter in the town map.
To create a new zone, select the room or rooms that you want to make into a zone, and select "Move Rooms to Zone" from the Edit menu.  First you will get a list of all current zones in the MUD map.  To move the selected rooms to an existing zone, just select the zone from the list and click OK.  To move the selected rooms to a new zone, click the New Zone button.  You will then be prompted for the name of the Zone.  Click OK when done and you will see the selected rooms in a new zone, linked back to the previous zone.
Zone List
By default a list of all zones in the current MUD map is displayed in alphabetical order to the left of the map.  The current display zone is stated just above the map window.  To display a different zone, just double-click on the name of the zone in this list.  You can show and hide this list by clicking the Show/Hide Nearby Panel button in the upper-left corner of the map dialog.  You can drag and drop zones into other zone in this list to make a collaspable tree of zones.  The display options for the list can be modified by right-clicking and selecting Flat View or Sort By Name in the context menu.
Zone Links
Zone Links are like normal links between rooms except that they span zones.  By default, zone links are displayed as broken, labeled links, with the name of the destination zone as the link label.  To turn off this label, select the Link properties and turn off the Draw Link option.
Creating a link between two zones is as easy as creating a normal link between two rooms.  In Map mode, select the Link tool in the toolbar to the left of the map.  Then, click on the edge of the room that you want the link to originate from.  Then, move the mouse over to the list of zones on the left of the map (if the zone list is not visible, click the Show Nearby Panel button in the upper left corner of the map window).  Double-click on the destination zone to display it in the map window.  Then move the mouse back into the map window and click on the edge of the destination room.  You will then see the new zone link displayed on the map.  Both ends of the zone link are created, so if this is a one-way link, you'll have to manually set it as such.
Favorite Rooms
Many MUDs have important locations that you want to be able to walk to no matter where they are.  For example, you always want to be able to get back to the temple, your clan hall, or other starting locations.  Locations such as stores, repair shops, or training rooms might also be important.  You can add important rooms to the Favorites list by right-clicking the room on the map and selecting the "Add To Favorites" command.  This list can also be displayed as a tree to help avoid clutter.  A dialog will appear to allow you to enter a name for your favored room.  To center the map on one of these important locations, right-click the name of the Favorite and select from the context menu, the zone will be opened and centered on the room you selected.  You can also edit the name of these locations by selecting Rename from the context menu.
To speedwalk to an important location, simply double-click the name of the room in the favorites list, or select Walk To Room from the context menu.

Introduction to Pathspathspaths,introductionIntroduction to Paths/Speedwalking
Paths are a very powerful feature that allow you to save the directions to a location and then replay these directions at high speed at a later time.  This is also called speed walking in other MUD clients.  Not only is this useful for getting to common areas within the MUD, but the directions are replayed fast enough to get you past some aggressive monsters (agros).  This is not fool-proof as some MUDs have high aggressive monsters that will hit you anyway.  Also, when leading a party, sometimes the monster will still hit one of your other party members.  However, it works most of the time and you will find yourself using Paths quite a bit.
To record a path, enter the #MARK command, or select Record Path from the Actions menu and press the Start Recording button.  Then use your normal movement commands to walk to the final destination.  Then, use the #PATH command to save the directions by entering #PATH shortcut.  Or, you can select Speedwalking from the Action menu, press the Stop Recording button and enter the shortcut name for this path.
Paths are saved as aliases preceded by a special character called the Movement character, which defaults to a period (.).  To replay the path directions, go to the start of the path that you saved earlier with the #MARK command, and enter .shortcut.  The directions saved in the path shortcut will then be replayed at high speed.
You can also send a set of directions at high speed using the Movement character by entering directions.  For example .neesuwd will send north, east, east, south, up, west, down to the MUD at high speed.  You can proceed any direction with a number to repeat it that many times.  The above path could be abbreviated .n2esuwd.
While recording a path (after entering the #MARK command), you can inspect the current path being recorded at anytime by entering #PATH (with no parameter).  The current path relative to the marked starting location will be shown in the direction syntax described above.  If you make a mistake and go the wrong direction, you can use the #BACKUP command to erase the last direction from the currently recorded path.  It will also attempt to move you to your previous location (e.g. if you went north by mistake, then did #BACKUP, you will be moved south).
A useful function that zMUD has added over other clients that have path features is the ability to reverse a path.  For example, let's say you have the path .2s2wn assigned to a shortcut called magic (gets you from temple to magic shop).  When you enter .magic while in the temple, you are taken to the magic shop.  Now you buy whatever you need, and then you want to return to the temple.  You can use the #REVERSE command to reverse the path by entering #REVERSE magic.  You can also use the shortcut syntax of two dots: ..magic.  The path .s2e2n will be sent to the MUD.  If you enter #REVERSE with no parameters, than the currently recorded path (since the last #MARK) will be reversed.  Kind of like leaving a trail of breadcrumbs.  Note however, that in many cases, going east to a room doesn't necessarily mean that entering west will go back.  The #REVERSE command only works in "Euclidian" areas of your MUD.
Note that speedwalking relies upon definitions of commands like north, south, down, etc.  You can add your own commands and short-cuts (such as o for open door) using the View/Directions menu command.


Speedwalking with the MapSpeedwalking with the MapSpeedwalking with the Map
While maps are useful as visual aids, they are even more important as a speedwalk tool.  Once you successfully create a map of a MUD zone, you can then use it to quickly travel to any location.
Consider normal speedwalking using paths.  You create a path to go from one location to another.  For example, you might create a path the takes you from the temple to the magic shop.  However, this path will only work if you are currently at the temple.  If you are somewhere else on the MUD, you must first walk to the temple, then use your speedwalk path to go to the magic shop.
If you have the area mapped in zMUD, you simple double-click the magic shop room and zMUD will automatically generate the shortest speedwalk path to that location.  With an accurate map, you can move to any location by just double-clicking on it!  This makes maps one of the most valuable tools for a MUD client.  You never have to worry about getting lost and can get anywhere you want quicker than most any other players (unless they are using the zMUD mapper too).
The mapper will perform speedwalking three different ways: Fast, Safe, Slow.  You can choose your speedwalking preference in the Speedwalking section of the Map Properties in the Edit menu.
With Fast speedwalking selected, the movement commands to get to the destination room are sent all at once to the MUD.  This is the fastest way to walk, but also the most dangerous.  Because they are sent to the MUD at one time, any commands you enter are now received by the MUD *after* all of the speedwalk commands.  Thus, if a monster attacks you along the way, your kill command will be delayed, and the mapper may also lose track of where you are (it will think you reached the destination when you didn't).  Even though Fast walking is Fast, it is not recommended.  Many mud also limit the numbers of commands that can be buffered, and even the shortest path can add up quickly.
Both Safe and Slow modes use #OK triggers to update map position.  The mapper uses the room name to create such a trigger unless you check the Match Room description during speedwalk box in the Speedwalk page of the mapper configuration.  When this is checked the first line of the room description is used to determine if a walking step was successful.  If the Send #OK on speedwalk box in room properties is unchecked then the automatically created trigger for that room will not include the #OK command.  Also, OK triggers that you have set up in the Slow Walking page of the preferences will confirm the mapper movement.
Safe speedwalking eliminates the problem of Fast setting your position to the wrong location.  When using Safe mode the mapper sends the all direction commands, then watchs for the appropiate match before updating your displayed position.  The advantage of this method is that you are only moved on the map when you actually successfully move on the MUD.  Fighting monsters along the way is still problematic in this mode because all movement commands were already sent.
Slow speedwalking is very similar to Safe speedwalking, except that movement commands are sent one at a time.  This is the most useful and most recommended way to speedwalk because the Slow Walk timeout can be used to abort a speedwalk in the middle, as can the #PAUSE and #STOP commands  You can also send other commands in the middle of the walk.  For example, if you encounter a monster and start fighting it, you would use #PAUSE, and then continue when done fighting using the #STEP command.

Improving Room DetectionImproving Room Detection
While the automapper works well on many MUDs, it might need some adjustment to properly map your MUD.  There are three common adjustments that you will want to make to your mapper.  
First, you need to keep the mapper in synch with the directions you are moving on your MUD.  If you move in an invalid direction, or bump into a closed door, the mapper needs to be told about this.  Otherwise it will still try to create a new room in the direction you originally went.  You can see which direction the mapper is currently working on displayed in the lower-right corner of the map window.  This is called the Direction Queue and shows you the direction that the next room will be created in.
To tell the mapper when you have moved in a wrong direction, use the #NODIR command in a trigger.  For example:
#TRIGGER {You can't go that direction} {#NODIR}
#TRIGGER {The door is closed} {#DOOR %lastdir;#NODIR}
The #NODIR command will remove the current direction from the Direction Queue.  You can also clear the Direction Queue manually by double-clicking on it.  Setting your location on the map manually will also clear this queue.
Next, you might need to tell the mapper to ignore certain lines from your MUD.  The mapper can get very confused by lines that start with special characters such as brackets or parenthesis, since it will think that looks like your MUD prompt.  To prevent a line from being seen by the mapper, use the #NOMAP command.  For example, if your MUD displays the current weather in parenthesis, like: "(It is raining)" you can tell the mapper to ignore these weather lines with the trigger
#TRIGGER {^~(*~)} {#NOMAP}
Finally, some MUDs implement day and night or reduced lighting in specific rooms.  When it is dark and you enter a room, it might display something like "It is pitch black".  You need to tell the mapper that you have successfully entered a room since otherwise the mapper will wait until it sees the room name.  To confirm the movement, use the #OK command, just like when slowwalking:
#TRIGGER {It is pitch black} {#OK}

Shortcuts and TricksShortcuts and Tricks
Non-standard exits
While you can create non-standard exits (like enter, portal, etc) by manually creating a link and editing it's properties, you can also create one while walking around your MUD creating your map from the MUD command line.  Simply prefix the non-standard direction with the MapDir character (defaults to >) and the mapper will create the new room as you move.  So, for example, if one of the exits from the room is "enter", simply type ">enter" on the command line and a room will be created and linked with the Other exit called "enter".  Normally the mapper will put the new room in a vacant spot near the original room.  To force the room to be created a certain cardinal direction from the original room, put the cardinal direction after the other exit separated by another ">" character.  So, for example, to create a new room to the east, you would type ">enter>e".  This is only needed when you first need to create the room.  Once the room is created, simply typing "enter" should follow the existing link to the room.
Special Aliases
There are 3 aliases which are executed automatically while using the mapper.  They are onroomcreate, onroomenter, and onwalkend.  Details can be found here.
Other alias tricks
Alias may be used with many of the fields in the automapper.  Links between rooms have the Other Com field.  In the mapper configuration under Strings and Doors aliases can be used to handle special doors.  For even more powerful map scripting it is recommened that you try out zMapper.

PreferencespreferencesPreferences
The Preferences editor is accessed by clicking the Pref button in the main toolbar, or selecting one of the preference options under the View Preferences menu.  Note that zMUD makes a distinction between "preferences" and "settings".  Settings are objects such as aliases, triggers, macros, etc that can be placed within a class.  You can have any number of settings for a given character.  Preferences are options that you toggle or change that have a single value for a given character.  Some Preferences are also global and effect all zMUD characters.  Global Preferences are stored in your ZMUD.INI file while character-specific preferences are stored along with your settings in your character.MUD file.
Preferences are grouped into categories.  The tree hierarchy on the left shows the preference categories.  Select the type of preferences you want more help on:
General
User Interface
Command Line
Emulation
Logging
Spam Protection
Word Wrap
Script Parser
General Parsing
Syntax Editor
Pretty Printing
Colors
Color Schemes
ANSI Mapping
Foreground
Background
Color Syntax
Syntax Editor
Connection
Reconnection
IP Address Lookup
Proxy Firewall
Directories
zmud.ini
mudchar.dat
Settings Files
Sound Files
Fonts
Memory
Slow Walking
MUD Prompt
Sounds
General Sounds
MSP General
MSP Sounds
MXP
General MXP
Elements
Entities
Tags
GSL Emulation
Special Characters
Tick Timer
Windows
Window Options
Layout

User InterfaceUser InterfaceUser Interface
This Preferences page contains options that control the zMUD user interface.  Many of these are global preferences as indicated below:
Auto NumLock (global)
Controls whether the NUMLOCK key is automatically activated when zMUD is started.  Default is on.  Users with laptop computers should turn this option off.  Turn this option on to activate the movement macros assigned to the keypad.
Autosave on exit (local)
Controls whether the settings for the current character are automatically saved when you exit or whether you are prompted for the save.  Default is on.
Backup settings (global)
Controls whether backup files are made when settings are saved.  Default is on.  Backups of .MUD files are saved in .BAK files.

Status bar (local)
Determines whether a status bar is displayed in the current MUD window.
MUD Output (local)
Determines whether the main MUD Output portion of the window is shown.
Caption on Top (local)
Determines whether the window caption is on the top or left side of the window

Refresh Amount (local)
Controls how many lines of text are buffered before being updated in the MUD output window.  If set to one, the window will be updated after each line is received from the MUD, which results in very smooth scrolling, but is also the slowest settings.  If set to zero, the window is only updated when the MUD finishes sending an entire network buffer, which results in jumpy scrolling (and may result in some lines never displayed if the buffer is larger than a screenful) but is the fastest.  The default is 5 which updates the window after every 5 lines are received from the MUD.  The default setting is a good compromise between speed and smoothness.  Note that in any setting, triggers are always tested on each line received whether it is displayed or not.

Main Tool bar (global)
Controls whether the main toolbar is displayed below the main menu.  Default is on.
Help Balloons (global)
Controls whether popup hints are displayed when the mouse is positioned over a control that has hints available.  Default is on.
Clock (global)
Controls whether the clock is displayed to the right of the command line.  Default is on.
24-hr Clock (global)
Determines if the clock is displayed in 12-hr (am/pm) or 24-hr format.Attached Command line (local)
Determines whether a command line is displayed at the bottom of the MUD window.  If this option is turned off, a common command line is displayed in its own window
Foreign Translation
Determines whether the ZMUD.LNG file is used to translate all text shown in zMUD windows and dialogs.  Using this option will slow down the opening of windows, but will allow you to display zMUD in different languages.  Check the www.zuggsoft.com web site for the language files currently available.

Command LineCommand Line
This Preferences page contains options that control the zMUD command line.  Many of these are global preferences as indicated below:
Auto Clear Input (local)
If set, the command input line is cleared when Enter is pressed.  Otherwise the text in the command line is not cleared but is simply highlighted (default).  When the command line is highlighted, any text that you type automatically overwrites the highlighted text, so this works similar to auto-clearing but allows you to send the same command in a row several times by just hitting Enter multiple times.
Wordwrap Command Line (global)
Determines whether the command line performs automatic word wrapping, or whether it just scrolls horizontally as you type
Multiline Paste (global)
If on, multiple lines in the clipboard are pasted to the command line as multiple lines.  If off, multiple lines in the clipboard are pasted to the command line as a single line with the Command Separator character (;) added between clipboard lines.

Show column (local)
Determine if the column indicator is shown on the status line.  This keeps track of what column your cursor is in on the command line.

Force Shift-tab text to lowercase (global)
When using the dynamic tab completion feature, this option controls whether the matching text is converted to lowercase before being placed in the command line.
Enable Menu key shortcuts (local)
Determines whether Ctrl-keys are used to execute macros or menu commands (like Ctrl-C for copy), or whether they are send directly to the MUD as Ctrl-key codes (for example, sending Ctrl-C directly to the MUD).  Default is on.
Macros override menu shortcuts (local)
Determines whether user-defined macros can override menu commands such as Ctrl-C. Default is off.
Ctrl-Alt-key sends Ctrl-key (local)
Determines whether pressing Ctrl-Alt-key will send Ctrl-key to the MUD.  Since this conflicts with some foreign keyboards, this option is off by default.

Attached Command line (local)
Determines whether a command line is displayed at the bottom of the MUD window.  If this option is turned off, a common command line is displayed in its own window

History Size (global)
Controls how many previous commands are saved in the command history.  Default is 20.

Bell Column (local)
Determines what column number causes a beep when you are typing.  Useful for preventing you from typing more characters than your MUD will accept.  Default is 0 (off)

EmulationEmulationEmulation
This Preferences page contains options that control how zMUD emulated various terminal types or protocols.  Most of these preferences are local to the specific character.
ANSI Color (local)
Controls whether ANSI color codes are recognized from the MUD.  Default is on.
VT102 emulation (local)
Controls whether VT102 terminal codes are recognized from the MUD.  Default is on.
MrTerm emulation (local)
Controls whether shortened VT102 codes as used by the MrTerm (Mortal Realms terminal) program are recognized.  Default is off.
MCP Emulation (local)
Determines whether Mud Client Protocol commands are recognized from the MUD.  Default is on.
Visit zMud MCP Implementation page online.
Character mode (local)
Controls whether individual characters are immediately sent to the MUD or whether entire lines are set (the default).  In Character mode, if the cursor is placed within the MUD output window instead of the command line characters are immediately sent.  This mode is used for running some character editors such as emacs or vi from zMUD and more strictly emulates a normal telnet client.
Local echo (local)
Controls whether keys and commands are locally echoed to the screen when in Character mode.  Default is off.
Emulate control codes (local)
Controls whether any control codes are recognized by zmud or whether they are displayed on the screen.  Default is on (recognize control codes).  This option is normally used for debugging purposes.

Telnet options (local)
Controls whether telnet options are recognized from the MUD.  Telnet options are used to communicate the terminal type and screen size to the MUD but some MUDs do not follow the strict telnet protocol and do not support this feature.  Default is on.
MXP/HTML (local)
Determines whether MXP commands are recognized from the MUD.  Default is on.
This must be active to use the #MXP command, and MXP strings in other commands.
Visit the zMud MXP Specification page online.
MUD Compression (local)
Controls whether Mud Client Compression Protocol (MCCP) is recognized from the MUD.  Default is on.
Visit the zMud MCCP Specification page online.
Send window resize NAWS (local)
Controls whether zMud sends a NAWS message to the mud to inform of changes in output window size.  Default is on.
Use GA/EOR for prompt (local)
Controls whether zMud interprets the Go Ahead/End Of Record telnet options to indicate the end of a prompt.  When active zMud will display the next text received from the mud on a newline if the mud forgets to send a newline.  Default is on.
Strict Telnet (local)
Controls the fashion in which zMud recognizes telnet options negotiation.  Not all muds negotiate correctly.  Those that don't will need this option turned off.  Default is on.
Default Telnet terminal type (local)
Controls the default terminal type sent to the MUD in response to a Terminal Type telnet option request.  Default is "zmud".

LoggingLoggingLogging
This Preferences page contains options that control logging lines to files.  Most of these preferences are local to the specific character.
Log Commands (local)
Controls whether commands typed on the command line and echoed to the MUD window are also written to the log file.  Default is on.
Log after triggers (local)
Controls whether logging is done before or after triggers are executed.  Default is to log before triggers.  For example, if you have a trigger that gags a line, logging before will write the line that is gagged to the log file, while logging after triggers will not cause this line to be written to the log file.
Log ANSI color (local)
Controls whether ANSI color codes are written to the log file.  To create a normal ASCII text file, turn this option off.  However, to create color log files that can be displayed by the internal zMUD ANSI editor, turn this option on.  Default is off.
Save scrollback Buffer
If enabled, the entire contents of the scrollback buffer are written to the log file when it is first opened.

Log Autosave interval (local)
Specifies the number of minutes before automatically saving the log file.  To turn off autosaving, set this value to 0.  Default is 5.
Map Autosave interval (local)
Specifies the number of minutes before automatically saving the map files.  To turn off autosaving, set this value to 0.  Default is 5.
Database Autosave (local)
Specifies the number of minutes before automatically saving the database files.  To turn off autosaving, set this value to 0.  Default is 5.

Spam ProtectionSpam ProtectionSpam Protection
This Preferences page contains options that control zMUD's automatic spam prevention feature.  Most of these preferences are local to the specific character.
Many MUDs get upset if you send several identical commands in a row to the MUD.  For example, sending 20 consecutive "recall" commands might cause the MUD to disconnect you.  The MUD does this to avoid people chatting the same line over and over again to everyone on the MUD or to people in the same room.  zMUD can prevent the MUD from detecting multiple consecutive commands by sending a different command after a certain number of identical commands are detected.  For example, if you have the zMUD Spam Limit set to 10 and try to send 20 recall commands, zMUD will send 10 recall commands, followed by your defined Spam Command, followed by another 10 recall commands.  Note that you should never use this feature to abuse the MUD or other players on the MUD by chatting or telling the same message over and over again...that kind of behavior can easily get you banned from the MUD.  This zMUD feature is only intended to prevent normal MUDding from being accidentally interrupted by the MUD spam detection code.
Spam Limit (local)
Controls the number of consecutive commands needed to trigger the spam prevention feature.  Set to zero to turn off this feature.  Default is zero.
Spam Length (local)
The minimum length of commands detected by the MUD's spam code.  Normally, short commands such as directions are ignored by the MUD's spam code.
Spam Command (local)
Command to send to the MUD when the Limit number of consecutive commands have been sent to the MUD.  Set this to a command that doesn't do much on the MUD.  Something like "save" works well.

Word WrapWord WrapWord Wrap
This Preferences page contains options that control zMUD's word wrapping feature.  Most of these preferences are local to the specific character.
Word Wrap (local)
Controls whether zMUD performs any word wrapping of the text received from the MUD.  Default is on.
Auto Wrap (local)
Controls whether zMUD wraps lines based upon the width of the current MUD window or whether is uses the Wrap Column defined below.  Default is on.
Wrap Column (local)
Sets the fixed column used to wrap text regardless of the width of the current MUD window if the Auto Wrap option is off.
Wrap Indent (local)
Specifies the number of spaces to indent wrapped lines by on the screen.  Default is 3.

General ParsingCommand ParserGeneral Parsing
This Preferences page contains options that control the zMUD command parser.  Most of these preferences are local to the specific character.
Show Triggers (local)
Controls whether a message is displayed to the screen whenever a trigger fires.  The default is off.  This is normally only used for debugging purposes.
Echo Commands (local)
Controls whether commands entered into the command line are also displayed in the MUD output window when Enter is pressed.  Default is on.  Echoed commands are displayed in the command echo color.
Echo messages (local)
Controls whether various zMUD informational messages are displayed to the MUD output window.  Default is on.  Information messages are displayed in the information color.
Echo scripts (local)
Determines whether commands from scripts and triggers are echoed to the screen.

Capture Commands (local)
Controls whether commands echo to the MUD output window are also captured to the capture window when capturing is turned on (#C+).  Default is on.
Gag Password (local)
Controls whether any line containing your character's password is gagged (not displayed).  Default is on.  Since you should always choose a password that is not a normal word you should never have to turn this option off.
Trigger on Commands (global)
Determines whether triggers are executed on commands you send to the MUD.
Enable autologin (local)
Determines whether the autologin triggers will be created and/or executed for this character.

Allow [] for eval (local)
Controls whether brackets [] are parsed in the command line to indicate immediate evaluation of expressions.  Default is on.
Allow <> for expand (local)
Controls whether brackets <> are parsed in the command line to indicate immediate variable expansion.  Default is on.
a=b syntax (local)
Controls whether the syntax var=value is parsed in the command line to set zMUD variables.  Default is on.
Strip " quotes (local)
Controls whether zmud strips double quotes on the command line (used to indicate a literal string).  Default is off.
Expand Vars (local)
Controls whether variables in the command line are expanded using the current Variable expansion character (default of @).  Default is off.
Null Var references (local)
If set, then @varname when the variable is not defined will return a null value.  Otherwise, if not set, @varname will return "@varname" if varname is not defined.  Default is on.
Allow ; comments (local)
Controls whether a ; at the beginning of a line indicates a comment.  Default is on.
Allow // comments (local)
Controls whether // at the end of line indicates a comment.  Default is on.
Allow VBScript (local)
Controls whether the VBScript tab is available.  Default is on.
Allow JScript (local)
Controls whether the JScript tab is available.  Default is on.

Send Delay (local)
Specifies the number of milliseconds to delay between sending lines from the #SEND command or when sending text from the editor.

Syntax Editor Syntax EditorSyntax Editor
This Preferences page contains options that control the zMUD syntax editor.  All of these settings are specific to the current MUD window.
This page allows you to set all of the colors used by the Syntax Editor.  A sample script is shown in the window, colored using the current settings.  In the upper-right corner is a list of all the color categories.  Select a category, then select the color from the palette below.  Left-click on the color palette to select a foreground color, right-click on the palette to select a background color.  You can also select the Bold, Italic, or Underline attributes.  To use the default foreground color, or default background color, select the option that you want.
The Restore Defaults buttons will restore the default colors defined by zMUD.

Pretty PrintingPretty Printing
This Preferences page contains options that control the pretty printing options in the syntax editor.
Add space before function arguments (local)
If enabled, functions are converted to the format:
	%function( arg1, arg2, arg3)
with a space before each argument.  If this option is off, then functions are converted to the format:
	%function(arg1,arg2,arg3)
without spaces.  The default is on since spaces allow the word-wrapping to function better.
Auto capitalize #command names (local)
If enabled, #coMMands are converted to #COMMANDS.
Auto expand command names (local)
If enabled, abbreviated commands are converted to thier full name.
Auto lowercase function names (local)
If enabled, %FunCtionS are converted to %functions.
Enable mouse-over expression evaluation (local)
If enabled, a hints box will popup displaying the evaluated value of the expression.
Enable mouse-over variable evaluation (local)
If enabled, a hints box will popup displaying the evaluated value of the variable.
Enable double-click variable edit (local)
If enabled, double-clicking on a variable will popup an edit box.
Indent Amount (local)
Controls how many spaces are added for indenting nested commands, like #IF statements.

Color SchemesSystemColor Schemes
This Preferences page contains options that control what colors are used by zMUD system messages.  Most of these preferences are local to the specific character.
For each color (except the Window background) you can change both the foreground and the background color of the text.  You can click on either of the color boxes and change both the foreground and background color of the text in the popup window.
Window background
This is the default color used for the main window background.  If you set this option, the background color for all the other options will also be set.
Default Text
The color used to display normal text sent from the MUD.  Note that the MUD can override the text color with ANSI color commands.  However, this color is used when the MUD resets the text color to its default value.  The zMUD default is green on black to simulate VT100 terminals.  Some MUDs expect a default color of gray on black.
zMUD Info messages
Used to display informational messages from zMUD.  Information messages can be turned off in the Command Parser section.
Command Echo
Color used to echo commands entered from the command line.  Command echoing can be turned off in the Command Parser section.
Highlighted Text
Color used to indicate text highlighted by the mouse.
Status Window
Default color used for text in the Status Window.
The Scheme pulldown menu allows you to select from "VT100", "ANSI", "Windows", and "User-defined" color schemes.  
You can also save your color scheme to a disk file using the Save Colors button, and load a scheme previously saved using the Load Colors button.
To override the default colors used for all new MUD windows, save your color preferences to the file DEFAULT.COL.

ANSI Function MappingANSIANSI Function Mapping
This Preferences page contains options that control how ANSI control codes are handled by zMUD.  Most of these preferences are local to the specific character.
ANSI control codes are normally used to specify the color of text from the MUD.  However, several special ANSI codes are used to specify attributes such as bold text, underline, blinking, and reverse video.  zMUD allows you to map these ANSI functions to one of several zMUD functions.  For example, if you don't like blinking text, you can map the ANSI Blink function to something else such as underlined text.  A very common setting is to map the ANSI Bold function to display highlighted colors so that you can have 16 text colors instead of the ANSI default of 8.  This is the default setting for the Bold function.  All other ANSI functions are mapped to their ANSI default.

ForegroundForegroundForeground Colors
This Preferences page contains options that control what text colors are used by zMUD.  Most of these preferences are local to the specific character.
Although ANSI defines 8 standard colors and 8 highlighted colors, zMUD allows you to map these values to any color your system is capable of displaying.  To change one of the colors, click the button next to the color number and select a new color from the displayed color palette.  
To set the colors to ANSI default values, click the "Make regular colors Dim" button.  To flip the dim and highlighted characters to make a default ANSI MUD look brighter, click the "Make regular colors Bright" button.
If the "Use colors from Inherited settings file" option is selected, the default mapping from the DEFAULT.MUD file will be used regardless of what values you change in this page.  To actually use the colors you have set, turn off the inherited option.

BackgroundBackgroundBackground Colors
This Preferences page contains options that control what background colors are used by zMUD.  Most of these preferences are local to the specific character.
Although ANSI defines 8 standard background colors, zMUD allows you to map these values to any color your system is capable of displaying.  To change one of the colors, click the button next to the color number and select a new color from the displayed color palette.  
To set the colors to ANSI default values, click the "Set colors to default" button.  
If the "Lock Background" option is selected, then changes to the background color sent by the MUD will be ignored by zMUD.

Color SyntaxSyntaxColor Syntax
This Preferences page contains options that control conversion of ANSI color to MUD color commands.  Most of these preferences are local to the current character.
These options control how color commands are sent to the MUD, rather than how ANSI color commands are received.  Most MUDs do not allow you to send the raw ANSI escape codes to the MUD, but instead implement a syntax for specifying colors.  When using the zMUD editor to set the color of text, you can use the color syntax specified on this page to convert from the ANSI color codes used by the editor to the syntax needed by the MUD.  This syntax also effects how lines that use the %ansi function send the color information to the MUD.
First, each color is assigned a keyword, usually a single letter.  All 16 foreground colors and 8 background colors are shown and you enter the keyword that the MUD uses to refer to the color in the box provided.  For example, if your MUD uses r for dim red and R for bright red, enter r into the box next to the dim red color and R into the box next to the bright red box.  You'd probably also enter r into the red background box also.
Next, the MUD usually has a way to represent the foreground and background colors.  For example, if the MUD uses %r for foreground red and &r for background red, enter %F into the "Syntax for foreground" box and &B into the "Syntax for background" box.  Some MUDs also have a command to set both colors at once, which you would enter into the "Syntax for setting both" box.  In this example, you would enter %F&B to set both colors.  Finally, enter any command that the MUD uses to reset color back to the default value in the "Syntax for reset" box.
You can also globally enable or disable the color syntax using the option on this page.  The zMUD editor has its own option for using color syntax which you must also turn on to convert ANSI colors to color syntax commands using the editor.
Using Color Syntax
Color syntax can be used from different places in zMUD.  First, in the Editor, turn on Color Syntax in the Options menu, and turn on ANSI and turn off Parsing.  Then type some text and use the color button to change parts of it to different colors.  When you have the text the way you want it, click the Send button to send it to the MUD.  The proper color syntax text will be inserted so that your text on the MUD is received with the proper colors.
From the main MUD window, Color Syntax is controlled by the Color Syntax Preferences page.  Enable color syntax on that page.  Then you can use the %ansi function to color the text you send to the MUD.  For example:
[%ansi(red)]this is red [%ansi(green)]this is green
will send red and green text to the MUD.  The brackets [] are needed to expand the result of the %ansi function within the command line.  If you have the Expand Vars option turned on in your Preferences, then you don't need the brackets.
If color syntax is enabled, ANSI codes will also be expanded whenever you paste text into the main command line in zMUD.  Go back to the Editor and Copy the colored text that you created.  Then go to the main command line and Paste (Ctrl-V) the text into the command line and you will see the correct color syntax codes added.  Then just press Enter to send the colored text to the MUD.

ReconnectionConnectionReconnection
This Preferences page contains options that control how zMUD connects to the MUD.  Most of these preferences are local to the specific character.
Check for new Version (global)
Determines if zMUD checks the zuggsoft.com server for a new version of zMUD every time you run zMUD.  Default is on.  You can always force zMUD to check for a new version manually using the Check for New Version command in the Help menu.
Auto reconnect (local)
Controls whether zMUD automatically tries to reconnect to the MUD when a connection is lost.  Note that some MUDs require that this option be turned off in order to use zMUD on that MUD.
Connection Timer (local)
Controls whether the connection timer is displayed in the status bar above the command line.  Default is on.

Reconnect Time (local)
The number of seconds to wait before reconnecting to a MUD that has disconnected.  Note that this value cannot be set lower than 10 seconds.  This is to avoid users reconnecting to quickly while a MUD is rebooting.  This time is used for the first 20 reconnection attempts.
Reconnect Time 2 (local)
Save as Reconnect Time, but this is use for the second 20 reconnection attempts.  After 40 unsuccessful attempts, zMUD stops trying to reconnect.
Connect timeout (local)
Number of seconds to try connecting to a MUD.  Default is 5 seconds.  If you have a slow network connection or are connecting to a slow MUD, increase this value.
LF / CR (local)
Sets Linefeed (LF) line termination.  MUDs that follow the telnet protocol send a CR/LF combination after each line, so setting either the LF (default) or CR option will work.  However, some MUDs do not follow the telnet protocol and you might have to set the CR option if you have trouble recognizing lines.

IP Address LookupIP Address LookupIP Address Lookup
This Preferences page contains options that control how zMUD converts host names into IP addresses.  Most of these preferences are local to the specific character.
In order to connect to a MUD, zMUD needs to know the IP address (four numbers separated by dots) of the MUD.  However, you normally use a Host Name to refer to a MUD since the actual IP address of a MUD can change if they move to a new server.  So, zMUD must normally convert a host name into an IP address.  The Internet protocol used to perform this conversion is know as the Domain Name Service (DNS).  zMUD queries your default DNS server and gives it the host name.  The DNS server responds with the current IP address of that host name.  If your DNS server cannot be contacted, then zMUD cannot convert host names and you must then enter the IP address itself into the Hostname field.
The DNS protocol is called an "unreliable" protocol because successful transmission of the information is not guaranteed by the network.  If you have a bad network connection, packets can be lost and DNS packets are not automatically retransmitted.  Thus, zMUD tries several times to contact the DNS server if the first attempt fails.  The parameters on this screen control these retries.  
zMUD starts with a quick DNS conversion attempt and waits only the number of seconds in the "Min Timeout" field for a response.  If you have a fast DNS server and a good network connection, this first attempt will usually succeed.  If it fails (no response within the Min Timeout number of seconds), then zMUD increases the delay time for a response by the "Timeout Inc" value and tries again.  If there is still no DNS response, zMUD again adds the Timeout Inc value and continues doing this and retrying until the Max Timeout value is reached.  If a successful DNS conversion cannot be made in the Max Timeout number of seconds, zMUD gives up and displays an error dialog asking you to input the IP address yourself if you know it.
The default parameters are Min: 1, Inc: 1, Max: 5.  Thus, zMUD will first try for one second, then two seconds, then three seconds, then four seconds, and finally for five seconds.  If you DNS server is down or misconfigured, zMUD will therefore wait 15 seconds before displaying the lookup error message (1+2+3+4+5 = 15).

Directories (zmud.ini)DirectoriesDirectories (zmud.ini)
This Preferences page contains options that control where zMUD looks for the ZMUD.INI file your local disk.  Most of these preferences are global.
For this file you can tell zMUD to look in the ZMUD.EXE directory, the Current directory, or an Other directory that you specify.
zMUD stores this Directory information in a ZMUD.INI file stored in the same directory as ZMUD.EXE.  If you select a different location for ZMUD.INI, the ZMUD.INI in the ZMUD.EXE directory will still be used to set file locations before the second ZMUD.INI file is actually read.
This directory settings is mainly provided for system administrators that have set up zMUD on a network.  Note that each user of zMUD must still be registered in such a setup.  

Directories (mudchar.dat)Directories (mudchar.dat)
This Preferences page contains options that control where zMUD looks for the Character Database (chardb.dat) your local disk.  Most of these preferences are global.  In previous versions of zMUD, this file was called "mudchar.dat".  zMUD also looks for the MUD database (mudlist.dat) in this directory.
For these files you can tell zMUD to look in the ZMUD.EXE directory, the Current directory, or an Other directory that you specify.

Directories (Settings)Directories (Settings)
This Preferences page contains options that control where zMUD looks for settings files (*.MUD) your local disk.  Most of these preferences are global.
For each file you can tell zMUD to look in the ZMUD.EXE directory, the Current directory, or an Other directory that you specify.
Settings files are stored in subdirectories named for the MUD Character title.  If zMUD cannot find them in this directory, then it searches the directory that ZMUD.EXE is stored in.

Directories (Sounds)Directories (Sounds)
This Preferences page contains options that control where zMUD looks for MSP Sound files on your local disk.  Most of these preferences are global.
For these files you can tell zMUD to look in the ZMUD.EXE directory, the Current directory, or an Other directory that you specify.
Normally, zMUD first looks in the "sounds" folder within the current MUD character directory.  If this is not found, then the Sound Directory specified here is used.  If the sound is still not found, it looks in the ZMUD.EXE directory.

FontsfontsFonts
This Preferences page contains options that control the text fonts used by zMUD.  Most of these preferences are local to the specific character.
Output Window Font
Controls the output font of the current MUD window.  The default font is Courier 10pt.  Proportional and True Type fonts result in somewhat slower scrolling than fixed-space screen fonts.
Command Input Font
Controls the font used in the command line.
Edit Window Font
Controls the font used by the screen editor built into zMUD.
Status Window Font
Controls the font used by text in the Status Window.
Vertical Space adjust
Controls the vertical spacing of the Output Window font.  Some Windows fonts do not report the proper spacing and end up with extra space between the lines.  To remove this space, set this value to a negative number.  Change it until the spacing of the font is more appealing.  Note that mis-setting this parameter can also cause lines to display over each other or cut off characters that descend below the text line.
To change the font, just click on one of the font boxes or the font button to the left of the box.  A standard Windows font change dialog box will be shown.  Select the desired font and size and click OK to save your change.  Changes to fonts take effect immediately.  Note that style changes (bold/italic) to the Input font are currently ignored.

MemoryMemoryMemory
This Preferences page contains options that control how zMUD uses memory (RAM).  Most of these preferences are local to the specific character.
zMUD actually uses memory very efficiently but also uses a lot of memory in order to provide a large scrollback buffer and to achieve the highest scrolling speed possible.  Fast scrolling is the number one design parameter in zMUD and using more memory makes this possible.  However, you still have some limited control over the memory usage.
When zMUD creates a new window, it only allocated memory for a small number of lines (usually a screenful).  As more text is received, zMUD continues to allocate lines in blocks of a screenful until the Max Lines setting for that window is reached.  When the maximum number of lines is reached, old lines are discarded as zMUD scrolls.
You can set the maximum number of lines for the main MUD windows, the child windows created with the #CAPTURE and #WINDOW commands, and for the editor.  You normally want the main MUD window and editor settings large to handle a large scrollback.  Note that the scrolling speed of zMUD is independent of the number of lines in the scrollback buffer.  On 32-bit systems, the number of lines in the scrollback is limited only by your available memory (RAM).  zMUD requires about 512 bytes per line.

Slow Walkingslow walkingSlow Walking
This Preferences page contains options that control how zMUD performs "slow walking".  Most of these preferences are local to the current character.
Slow Walking is used to move from one location to another safely, either in conjunction with the Automapper, or using the #SLOW command.
Timeout aborts walk
Controls whether the Timeout value shown below is used to abort the slow walk, or to flag the walk as successful.  Default is on (abort walk).
Timeout value
The amount of time to wait before aborting or completing a slow walk step.  This value is in milliseconds, so one second is a value of 1000.
Strings to determine successful slow walk
These are text strings from the MUD that indicate a successful step was taking.  They are actually trigger patterns that execute the #OK command to complete a slow walk step.  When using the mapper, the mapper will automatically add strings for the room name or description to this list.  When not using the mapper, a string such as ^Exits is used to match the exit line that is displayed when you successfully enter a room.

MUD PromptMUD Prompt
This Preferences page allows you to change the settings for capturing your MUD prompt.  This information can also be set using the #SETPROMPT command.
The first field contains the text that your MUD prompt starts with.  If your MUD prompt does not being with unique text, then you cannot use this simple method to capture your prompt and will have to use a normal zMUD trigger.
In the lower box, you enter the names of variables that you wish zMUD to fill with the numeric data from your MUD prompt.  The first number detected on the line will be stored in the first variable, etc.
For example, if your MUD prompt is:
[100/150hp 50/60mana]
Then, you would put "[" (without the quotes) into the first field, since the MUD prompt starts with a [ character.  Then, in the variable list, you would put:
hp
maxhp
mana
maxmana
Now, when zMUD receives this MUD prompt, it will load 100 into @hp, 150 into @maxhp, 50 into @mana, and 60 into @maxmana.

General SoundssoundsGeneral Sounds
This Preferences page contains options that control what sounds are used by zMUD.  Most of these preferences are global.
Enable Sounds (local)
Controls whether all sounds are on or off.  When this is off, zMUD will not use any sounds.  Default is on.
Old Sound Driver (global)
Determines whether to use the old sound driver.  The old sound driver is more compatible and will play most all WAV file formats.  However, only one sounds can be heard at a time.  The new sound driver only plays uncompressed WAV files, but it allows up to 16 sounds to be playing at the same time.

Beep Sound (global)
The sound used by the #BEEP command.
Startup Sound (global)
The sound played when zMUD is started.
Connect Sound (global)
The sound used when you successfully connect to a MUD.
Disconnect Sound (global)
The sound used when you are disconnected from a MUD.
In the input boxes, you can specify the name of a WAV file, or can enter the numeric value of the window event you wish to trigger.  Window event 0 is the standard beep sound.  Other sounds occur at 16, 32, 48, 64, etc.
When searching for WAV files, zMUD first looks in the Sounds subdirectory of your current character folder.  It then looks in the ZMUD.EXE directory, and finally in any directory specified by the Sound Files directory path.

MSP GeneralMSP GeneralMSP General
This Preferences page contains options that control how the MUD Sound Protocol (MSP) is used by zMUD.  Most of these preferences are local to the current character.
Enable MUD Sound Protocol
Globally enabled or disables the parsing of MSP commands from the MUD.  Default is on.
Visit the zMud MSP page online.
Echo MSP Triggers
Echos the MSP commands received from the MUD on the screen for debugging purposes
Background sound download
If a sound request is received from the MUD and the sound is not found on the local disk, the sound is downloaded in the background from the Sound URL path or from the URL path specified by the MUD in the MSP command
Show sound downloads
If on, background sound downloads are shown as progress windows
Allow inline MSP
Determines whether MSP commands are parsed in the middle of a text line, or just at the beginning of a text line.  All MUD MSP commands will be at the start of a line, but turning on inline MSP allows people to trigger sounds in their chat lines.  Turn this off if you don't want to be spammed by sounds.
Sound URL Path
The default URL path to download sounds.  The MUD can override this using the U= parameter in the MSP commands.

MSP SoundsMSP SettingsMSP Settings
This Preferences page contains options that control how the MUD Sound Protocol (MSP) is used by zMUD.  Most of these preferences are local to the current character.
The MUD Sound Protocol allows the MUD server to trigger sounds to play on the local computer.  The sounds are usually provided by the MUD in an acrhive that you extract into the Sounds subdirectory of your current character folder.  zMUD allows you to change several of the behaviors of this sound protocol and to remap any sounds requested by the MUD.
A list of MSP sounds received from the MUD so far are shown on the left.  If your MUD doesn't support MSP or hasn't sent any MSP triggers, this list will be blank.  You can select an MSP sound from the list by clicking on it.  You will then see the filename of the actual WAV or MID file.  You can change this filename to map the sound or music to a different file.  You can also enable or disable the sound individually, or enable or disable the entire class of sounds (if your MUD supports MSP sound classes).
The URL field allows you to override the URL used to download this sound from the Web.  The download button attempts to download the sound from this location.

General MXPGeneral MXP
This Preferences page contains options that control how the Mud eXtension Protocol (MXP) is used by zMUD.  Most of these preferences are local to the current character.
Enable Mud eXtension Protocol
Globally enabled or disables the parsing of MXP commands from the MUD.  Default is on.
Report <RELOCATE> Usage
Reports when the MUD uses the <RELOCATE> command to switch you to another server. Default is on.
Expand MXP tags in command line
Determines if Open MXP commands are allowed in the command line.  Even if turned on, the < character in the MXP tag will need to be preceded with a ~ character to prevent zMUD from parsing the < character. Default is on.
Underline MXP links
Determines if hyperlinks created by MXP commands should be underlined.  Default is on.

ElementsElements
This Preferences page lists the current MXP elements that are defined.
MXP Elements are split into 3 categories: MUD, User, and System.  The MUD tab will list all MXP elements that your MUD has defined.  The User tab will list elements that you have defined locally using the <!ELEMENT> MXP command.  The System tab will list all MXP elements that are defined by default in zMUD.

EntitiesEntities
This Preferences page lists the current MXP entities that are defined.
MXP Entities are split into 3 categories: MUD, User, and System.  The MUD tab will list all MXP entities that your MUD has defined.  The User tab will list entities that you have defined locally using the <!ENTITY> MXP command.  The System tab will list all MXP entities that are defined by default in zMUD.

TagsTags
This Preferences page allows you to change the settings for MXP line tags.
MXP can tag each line sent from the MUD with a number from 0 to 99.  Numbers 0-19 are reserved for system use.  Tags 20-99 can be user defined.  Click on the tag you wish to modify, then set the following options:
Enabled
Indicates whether the tag is enabled or disabled.  The following options only work when a tag is enabled.
Gagged
Indicates whether the line is gagged or not.  Gagged lines do not appear in the MUD output window.
Foreground Color
Select the default foreground color value for text in this line.
Background Color
Select the default background color value for text in this line.
Window Name
Enter the name of the window that this text should be captured to.

GSL EmulationgslSimutronicsGSL Emulation
GSL is the name given to Simutronics Games control codes.  Simutronics Corp is a leader in the business of massively multiplayer games, focusing on persistent worlds using a subscription-based model.  The company's flagship products are its fantasy role-playing titles, which dominate the market for MUD-style games. Based on Simutronics' proprietary Interactive Fiction Engine (IFE), these games support a dynamic, ever-changing game world where each player has an impact on the world and where an incredibly talented staff of GameMasters add new features daily. The games are positioned in the high end of the market, where players are seeking an advanced, robust role-playing experience, and are designed for years of play value.

By special agreement with Simutronics zMud has direct support for the GSL control codes, and direct links to help you create a character in Dragon Realms and Gemstone III.  You can also create characters in thier other games by using the drop down list in the login dialog.
Both character creation buttons come with some predefined scripts to help you get started.  More scripts (written by zMud users) can be found in our Finished Scripts Forum.

Special CharactersSpecial CharactersSpecial Characters
This Preferences page contains options that control special characters are used by the zMUD parser.  Most of these preferences are local to the current character.
When parsing is turned on, zMUD looks for several special characters in the command line used to execute zMUD commands or perform other special operations.  If you want to send all text to the MUD verbatim, turn off the Parsing option in the Setting menu or click the computer icon to the right of the command line.  
Individual characters used for zMUD parsing can be changed or completely disabled.  If you disable a character you will lose the use of that zMUD feature.  
Command Char
Used to begin zMUD commands.  Defaults to #
Separator Char
Used to separate multiple commands on the same line.  Default is ;
Variable Char
Used to expand the value of a variable.  Default is @ (TinTin uses a value of $ for this).
Parameter Char
Used to expand internal zMUD variables and functions.  Default is %
Focus Char
Used to send commands to other windows.  Default is :
Movement Char
Used to begin speedwalking and paths.  Default is .
Class Char
Used to begin desginate a path of classes for a setting.  Default is /
History Char
Used to recall commands from the command history.  Default is !
Quote Char
Used to escape other special characters.  To send any special character to the MUD without parsing it or match it in a trigger, precede it with this character.  Default is ~
Map Direction Char
Used to send a non-standard direction to the mapper so that it creates a new room.  Default is >
Database Char
Used to match a column name in the current database.  Default is &

Tick Timertick timer dialogTick Timer
This dialog allows you to easily manipulate the tick timer commands in zMUD.  The current value of the timer (counting down to zero) is shown at the top.  The timer can be started and stopped using the Start and Stop buttons.  The Synch button is used when a tick on the MUD actually occurs.  The current tick interval will be modified to reflect the actual tick on the MUD.  Note that most tick intervals vary depending upon the lag on the MUD, so don’t think this timer will save your life or anything.  The Reset button resets the timer back to the tick interval.
The Tick interval can be set from this dialog to a given number of seconds.  The Timeout Margin indicates the point at which the Timeout Command is executed.  For example, if the Margin is 5, the Command will be executed when the timer reaches 5 seconds.
Normally when the Tick Margin is reached, a message is displayed to your screen telling you a tick is coming.  You can disable this message by turning off the Display Tick Message option

Window OptionswindowsWindow Options
This Preferences page contains options that control how zMUD handles windows.  Most of these preferences are global.
Task Bar Icons
MUD output windows
Controls whether an icon is added to the Windows taskbar at the bottom of the screen for the main MUD output windows.  Default is on.
Capture windows
Controls whether an icon is added to the Windows taskbar at the bottom of the screen for secondary windows created with the #WINDOW and #CAPTURE commands.  Default is off.
Automapper
Controls whether an icon is added to the Windows taskbar at the bottom of the screen for the Automapper window.  Default is off.
Editor
Controls whether an icon is added to the Windows taskbar at the bottom of the screen for the Editor window.  Default is off.

Automatically bring to front window with activity
When on, subwindows that receive activity are brought to the front so they are visible.  Main MUD windows are not effected.
Bring Menu bar to front
This option will popup the main zMUD menu window whenever the mouse is moved to the top of the screen.  This is useful when the MUD window is running in fullscreen mode.  When the mouse is moved back over the MUD window, focus returns to the MUD window.
Use size/position in default.mud
Determines whether the window size and positions saved in the DEFAULT.MUD file are used instead of the normal tiling options.

Window Tabs in Menu Window (global)
Controls whether multiple open windows are displayed in a tab list below the toolbar and menu in the main zmud window. Default is on.
Window Tabs in Command Line (global)
Controls whether windows are displayed in a tab list in the common command line window.

Use ALT for Docking
If enabled, then the ALT key must be held down when moving a window in order for it to dock.

Update main icon with status
If enabled, then the main zMUD task bar icon is updated with status information about whether new output has been received in any zMUD window.

LayoutLayoutWindow Layout
The Window Layout dialog allows you to change various window tiling options.  
None
No automatic tiling is done.  You can freely move and resize your windows and their positions are saved in your settings file
Tabbed
All windows are maximized.  Each window has it's own tab to select it..
Tiled Horizontally
All windows are tiled horizontally.  All windows are treated equally.
Tiled Vertically
All windows are tiled vertically.  All windows are treated equally.
Multiple Tabs
Child (capture) windows are tabbed along the top, and the MUD character windows are tabbed along the bottom.  The MUD character windows take up two-thirds of the window height.

Settingscharactercharacter,commandcharacter,movementcharacter,parametercharacter,separatorcharacter,variablesettingsspamspam,commandspam,countspam,lengthcharacter,historySettings Editor
The settings editor is a single dialog that allows you to edit all of the settings associated with your current MUD character.  zMUD settings are defined as objects that can be assigned to a class.  Options that can only have single values are called Preferences and are modified in the Preferences dialog.
Settings consist of objects such as aliases, triggers, macros, buttons, etc.  Each object is assigned to a class folder (or to the default class of <none>).  Classes of objects can be enabled or disabled with the #T+ and #T- commands.  You can display a list of classes and their current state (on or off) using the #CLASS command.  Classes work for settings like folders (subdirectories) work for files.  You can also have one class folder within another class folder.  Use class folders to organize your settings into common categories.
Within the Settings Editor window there are 2 panes: Class Panel and Settings List.  The Edit window is docked to the Settings Editor by default.  The bottom of the Edit window contains a comment field which can be editted by double-clicking on it.
The Settings Editor consists of a toolbar across the top with buttons for displaying certain setting types (like Aliases, Triggers, etc).  Only the most common setting types are shown.  You can access *all* of the settings types using the Show menu.  For example, to display Buttons, you must select Buttons from the Show menu.  To display more than one kind of setting at a time, hold down the Shift or Ctrl button on the keyboard as you click the toolbar button or as you select the menu item from the Show menu.
Click the hotspot on the left edge of the settings list to display or hide the Class Tree view.  This shows the hierarchy of your class folders.  Double-clicking a folder in this tree view will display the settings within the class on the right.  A single class folder  can contain multiple object types.  For example, the Automapper class can also contain aliases, or macros, etc.
To edit one of your settings, select the specific setting you want to edit from the lower-left list by clicking on it, then click the Edit button.  Or, just double-click the setting.  The details of the setting will be shown in the Editor window.  The information that you can edit is different depending upon the object type.  For example, selecting a macro will allow you to change the macro properties, selecting a trigger allows you to change the trigger properties, etc.  You can dock the Editor window to the bottom or right side of the settings display if you always want it open.
For information on specific properties, select the type of object you are editing:
Classes
Aliases
Variables
Paths
Triggers
Macros
Buttons
Directions
Speed Menu
Tab completion
Status bars
To delete a specific setting, select it in the list, then select Delete from the Edit menu.  Or, right-click on the setting and select Delete from the popup menu..
To create a new setting, click the New button.  A new, blank object or the same type as the last setting displayed will be created.  Fill in the values of the properties for the new object, then click Save to save the new object.  Click cancel to discard the new object.  If you know what type of setting you want to create, click the drop-down arrow to the right of the New button and select the object type from the list.
By default, the settings stored in memory for your current MUD character are shown.  You can also display settings stored in a different file using the File|Open command.  When more than one setting window is displayed, you can drag and drop items between the windows to copy settings to different files.  To save your changes, select Save from the File menu.
The settings shown in the list are normally displayed in alphabetical order.  To display the settings in the order that zMUD loads them, go to the Sort command in the View menu and select None.  The unordered list shows the settings in the order they are loaded into zMUD.  For triggers, this is the order in which triggers are searched.  You can change this order using the Move Up and Move Down buttons that are displayed on the toolbar when it is unordered.  Or, when Sort is set to None, you can drag and drop items in the list to change their order.  The order of items is most useful for Buttons, Menu items, and Triggers.
Sometimes, if a setting is changed from outside the settings editor while the editor is being displayed, the Refresh button on the toolbar will turn yellow.  This indicates that there is a change pending.  Click this button to refresh the settings display to reflect the true settings.  This can happen, for example, if a trigger running in the background changes the value of a variable while you are editing your memory settings.

ClassesClassesClasses
This Settings Editor dialog page allows you to edit the properties of a Class.
The Name field gives the name of the class, and the options are described below:
Enable class when connecting to a MUD
When the settings file is loaded, this class is enabled.
Disable class when connecting to a MUD
When the settings file is loaded, this class is disabled.
Remove this inherited class when loading
Remove this class when the settings file is loaded.
Set as Default when executing
Settings within this class that create other settings, cause those other settings to be created in this class, rather than the default class.  For example, you might have a trigger that creates an alias.  With this option set, the alias will be created in the same class as the trigger.  Otherwise the alias is created in the current default class, set by the #CLASS command
Submenu class
Indicates that this class contains menu items that are grouped together as a named submenu for a right-click menu or button.
Enabled
Enable or disable this class.  Settings within a disabled class are ignored.  Buttons within a disabled class are not displayed on the button bar.
Hidden
Hides this class.  Hidden classes are not visible in the settings editor unless the Show Hidden option is enabled.

You can also enable or disable this class by double-clicking the green circle at the bottom of the editor.  To edit the Comment assigned to this class, double-click the comment bar at the bottom of the editor.
Class Scripts
Instead of editing each individual item within a class, you can edit the source code for an entire class by clicking on the Class Script tab.  The script for the entire class, as it would be exported to a text file, is displayed and can be edited.  If the Save button is clicked, any changes made in the script will take effect and change any items within the class.  This is useful for making a large number of edits to a complex class without editing each item by itself.
Class Character
The class character can be used to specify a path to a setting.  This is useful if you want to have multiple variables, aliases, or any other setting of the same name.  It can be used in the class parameter of commands or immediately before the settings name.  Periods can be used to designate root (None) class and parent class when a default class is used.
Examples:
#ALIAS ex {example1} /class1
	Creates the alias in class1 as a subclass of current default class.

#ALIAS ./class2/ex {example2}
	Creates the alias in class2 from the root

#CLASS class3
#ALIAS ex {example3} ../
#VAR test abc
#CLASS 0
	Creates the alias in the parent class of class3 and the varaible in class3

#SHOW @test
#SHOW @./test
class2/ex
	Would display abc, followed by a blank line because test is not found in the root class, then send example2 to the mud.

Aliasesaliasesaliases,editingAliases
This Settings Editor dialog page allows you to edit the properties of an Alias.
The Name field gives the shortcut name of the alias, and the Value field lists the commands assigned to the alias.  You can put multiple commands on separate lines, or separate them with the command separator character (default of ;).  
If the Style is set to Script, the syntax editor will check the syntax and report any errors.  If the Style is set to Text, you can edit the alias value without performing any syntax checking.  If Style is set to VBScript or JScript then the alias will be sent to that script processor.  Note: VBScript an JScript use the #SS command internally, if you change to another style you will have to remove that change manually.
There are a number of aliases that are automatically executed at certain special events.

VariablesvariablesVariables
This Settings Editor dialog page allows you to edit the properties of a Variable.
The Name field gives the name of the variable, and the Value field gives the current value of the variable.  The Default field can be used to assign a startup value to the variable when the character is first loaded or the #RESET command is used.  To enable a default value for the variable, enable the Use Default checkbox, otherwise the last value saved for this variable will be restored on startup.
If the Style is set to zMUD Script, the syntax editor will check the syntax and report any errors, which is used for #FUNCTIONs.  If the Style is set to Text, you can edit the variable value without performing any syntax checking.  If Style is set to VBScript or JScript then the commands will be sent to that script processor.  Note: VBScript an JScript use the #SS command internally, if you change to another style you will have to remove that change manually.
You can easily edit string lists by setting the Style to String List.  Each item in the list can be edited, and items can be drag/dropped to change their order.  You can also right-click on the list and Insert or Delete a row.
You can also edit Record variables by setting the Style to Data Record.  Each key and value stored in the record will be shown and can be editted.  Fields can be drag/dropped to change their order.  You can right-click on the list and Insert or Delete a row.
Variables are used within scripts through the variable special character, which defaults to @.  Many of the different data types that can be store in a variable can be referenced using a period notation.  Also COM methods and functions can be accessed by this notation.  Variables that reference COM objects, arrays, and floating point numbers will have a value like %tmpcom##### and can not be editted directly.
Also braces {} may be used to seperate a variable name from neighboring text or allow functions to expand prior to expanding the variable reference.
Examples:
#VAR example1 %array(0)
#9 {#NOOP %arrset(example1,%i,%i)}
#SHOW @example1.4
	The first 2 lines create an array with the number 0-9 in matching element slots.  Then element 4 is displayed.  New variables created with a syntax of #VAR name.# {x} will be created as arrays.

#WIN example2
:example2:#VAR newvar {just made this}
#SHOW @example2.newvar
	The first 2 lines create a child window then a variable in that child window.  Then the variable @newvar from the example2 window is displayed.

#VAR example3 {}
#ADDKEY example3 third {just another example}
#SHOW @example3.third
	This one creates a record variable with a key of third.  Then displays the value assigned there.  New variables created with a syntax of #VAR name.word {x} will be created as records.

#VAR example4 {abc|def|ghi}
#ADDITEM example4 {jkl}
#SHOW @example4.4
	This one creates a list variable and then adds a new item to it.  Then displays the forth item in the list.

#4 {#SHOW example%i = @{example%i}}
	This shows all 4 examples from above.

SpeedWalkingspeedwalking dialogSpeedwalking Paths
This Settings Editor dialog page allows you to edit the properties of a Speedwalking Path.
The Path Name field gives the name of the path.  The Directions field specifies the directions assigned to the path.  You can also execute a path by clicking the Fast walk button to walk there quickly, the Walk Reverse button to walk the path in reverse, or the Slow Walk button to walk there using the slow walk settings.
The Reverse button to the right of the Directions field simply reverses the directions in the Directions field without actually walking the path.

Macro Keysmacrosmacros,editingMacro Keys
This Settings Editor dialog page allows you to edit the properties of a keyboard Macro key.
The Key field gives the name of the key on the keyboard that the macro is assigned to.  To change this key, just click on this field, then press the key combination to assign to this macro.  The Value field contains the commands executed when the macro key is pressed.
Normally, text assigned to a macro is sent to the MUD immediately.  To put the text in the command line and not send it immediately to the MUD, uncheck the Send to MUD option.  Also, macro text placed in the command line normally replaces the current contents of the command line.  To append the macro text to the command line instead, check the Append option.  To allow this macro to chain with other macros on the command line, select the Daisy Chain option.
If the Style is set to Script, the syntax editor will check the syntax and report any errors.  If the Style is set to Text, you can edit the macro commands without performing any syntax checking.  If Style is set to VBScript or JScript then the commands will be sent to that script processor.  Note: VBScript an JScript use the #SS command internally, if you change to another style you will have to remove that change manually.

Triggerstriggerstriggers,editingTriggers (Pattern Tab)
[Pattern tab] [States tab] [Options tab] [Testing tab] [Trigger Patterns]
This Settings Editor dialog page allows you to edit the pattern and script of a Trigger.
The Pattern field displays the text pattern received from the MUD that causes the trigger to execute.  The Value field shows the commands that are executed when the trigger executes.
The State drop down list allows you to change which state you are editting or create a new state.
If the Style is set to Script, the syntax editor will check the syntax and report any errors.  If the Style is set to Text, you can edit the trigger commands without performing any syntax checking.  If Style is set to VBScript or JScript then the commands will be sent to that script processor.  Note: VBScript an JScript use the #SS command internally, if you change to another style you will have to remove that change manually.
If the Regex option is selected, the trigger state Perl regular expressions for pattern matching instead of the normal zMUD trigger pattern syntax.  Clicking the Convert button will convert a normal zMUD trigger into a Regular Expression trigger.  The regular expression that will be used for a zMUD trigger is shown in the Test page.

Trigger States TabTrigger States Tab

[Pattern tab] [States tab] [Options tab] [Testing tab] [Trigger Patterns]
This Settings Editor dialog page allows you to examine and edit the states of a Trigger.
You can right-click to insert and delete states, as well as toggle whether a state has been triggered.  You select which state is active by double-clicking.
The first column indicates which state is active with an arrow, and which states have been triggerred with a green box.
The second column displays the state number.
Next is the pattern field, this field can be directly typed to.
Then comes the trigger type, letter codes can be used to set this field:
A	Alarm
D	Duration
E	Expression
I	Command Input
L	Loop Pattern
P	Pattern
R	Regular Expression
S	Skip Lines
W	Wait
Any other character will loop through the entire list.
The fifth column shows the Param used with that type of trigger.  For a detailed description of Param and Type usage see the Trigger Types page.  This field can be directly typed to.
Finally is the script column.  You can directly type scripts here, but it is recommended that you use the Value field on the Pattern tab.

Trigger Options TabTrigger Optionstriggers,optionstriggerstrigger,optionstriggerTrigger Options Tab
[Pattern tab] [States tab] [Options tab] [Testing tab] [Trigger Patterns]
This Settings Editor dialog page allows you to edit the properties of a Trigger.
The ID field is used to assign a short name to this trigger.  This short name can be used with the #T+ and #T- commands to enable and disable the trigger, and is very useful for #STATE and #SET when working with multistate triggers.
Normally, triggers are set to a Type of Pattern which indicates that the trigger should fire when the pattern of text is received from the MUD.
There is a page for detailed descriptions of all other Trigger Types, and brief descriptions can be found on the Trigger Command Options page.
The Trigger On options determines whether the trigger pattern is detected at the end of each line (Newline), or after a full buffer of text is received from the MUD (Prompt).  You can select both if necessary, but this may cause a trigger to fire twice in some circumstances.
You can specify the color required for the first character of the line from the MUD by selecting Line Color and then clicking on the color box to the right.  Select the color combination required to fire this trigger.
The Other Options area allows setting
Case Sensitive
Determines whether the pattern matching is case sensitive or not.
ANSI Trigger
Turn this option on to allow patterns to contain ANSI color sequences.  An ANSI color sequence looks like %e[xxm where xx is the ANSI color value. To trigger on specific color patterns, turn this option on, select the line from the MUD output window that contains the pattern you want to match, and paste (Ctrl-V) this line into the trigger pattern field.  If the Ansi Trigger option was on when you pasted the line, any ANSI color codes will be pasted into the Pattern field along with the rest of the text.
Temporary
The trigger is temporary and will be deleted after it is executed once.  Temporary triggers are not saved to your settings file.  Scriptwise this option is only set by the #TEMP command.
Verbatim
Tells zMUD to match the pattern verbatim without parsing any special pattern characters or wildcards in the pattern.
Trigger on Trigger
When on, zMUD executes trigger matching on any output displayed by this trigger.  Care should be used with this option to avoid an infinite loop of trigger matching.

Trigger Testing TabTrigger TestingTrigger Testing Tab
[Pattern tab] [States tab] [Options tab] [Testing tab] [Trigger Patterns]
This Settings Editor dialog page allows you to test the pattern of a Trigger.
The Pattern from the first page is displayed again on this page.  Enter sample text that is received from the MUD into the Sample box and click the Test button to see if the trigger properly executes.  Also, the value of any saved wildcard patterns will be displayed for debugging of trigger commands.

Trigger TypesTrigger Types
Expression triggers evaluate the expression stored in the Pattern field whenever a is changed and execute the commands if the pattern expression is true.
Alarm triggers use the pattern field to specify a time when to execute the trigger.  See the #ALARM command for more information on time pattern values.
Command Input triggers test the command entered on the command line and can change this command before it is sent to the MUD.  See #ONINPUT command for more information about changing the text sent.
Skip Lines is used to skip lines then match the pattern specified.  The Param field specifies how many lines to skip before matching the pattern.  A blank pattern can be used to cause the trigger to fire immediately after last skip line is received.
Wait will delays matching for Param milliseconds after the trigger becomes active.  A blank pattern can be used to cause the trigger to fire immediately after the time is up.
Loop Pattern matches the pattern Param times.
Loop Lines matches pattern whenever received for the next Param lines.  If used with a multistate trigger it will advance to the next state after Param lines irregardless of number of matches.
Loop Exp uses an expression as pattern.  This trigger tests the expression with each line received.  If the expression is false it moves on to the next state, otherwise it fires.  Param can be used to limit the maximum number of times the trigger will fire before moving on to the next state.
Duration type triggers check for a match of pattern with each line.  Every line that matches before Param milliseconds have passed will cause the trigger to fire.  Because the time on the trigger is checked after the pattern the first line received after expiration of the duration can still cause the trigger to fire.
Manual fires and advances to the next when the #SET command is used to mark the state triggered.  If a pattern is specified the script for the trigger will be executed when a match occurs, but it will not advance to the next state.
Within Lines attempts to match the pattern for Param lines.  If a match is made the script is executed and then the next state is activated.  Once the maximum lines are received without a match the trigger is reset to state 0.
MXP triggers match on MXP tags of matching pattern.  If the Newline option is set the trigger matches on the closing tag, and fills %0 with the text between the opening and closing tags.  If the Prompt option is used the trigger will match the opening tag, a NONSECURE tag can then be modified by using the %mxp predefined variable.
Reparse allows you to test another trigger pattern on same line that caused the previous state to fire.  Irregardless of match the triggerwill advance to the next state.
GSL triggers use a single character pattern to match codes sent by Simutronics games.
MCP matches MCP messages.

Trigger States Advanced Triggerstrigger,statestriggerTrigger States

Multistate tirggers are a recent addition to zMud, they allow users to chain together multiple events rapidly.
States are fired sequentially, with only one state active at an given time.  A detailed manual on the usage of this powerful feature is available online at Advanced Triggers.

Some common problems can easily be handled with multistate triggers.  A complex example is included here.
Generic Multiline capture:
Sometime you just need to capture a bunch of lines.  Things like who lists, room descriptions, inventory lists, etc. can be tough to grab with single triggers.  This script captures multiple lines and stores them in whatever format is needed, this is a highly advanced script, and while I will try to explain it thouroughly it may still be difficult to follow.

#ALIAS example {StartLine="Who is on:";StartCapCommand="#GAG";LineCapCommand="#CAP who;#GAG";EndLine="$";EndCapCommand="";#T+ CaptureLines;#ECHO "Who is on:";#ECHO "abc def";#ECHO "[ghi] (jlk)";#ECHO ""}
#CLASS {MultiLineCap} {enable}
#VAR StartLine {} {}
#VAR StartCapCommand {} {}
#VAR LineCapCommand {} {}
#VAR EndLine {} {}
#VAR EndCapCommand {} {}
#TRIGGER "CaptureLines" {@StartLine} {#IF (@StartCapCommand) {<"<">@StartCapCommand>}} "" {disable}
#COND "CaptureLines" {} {#IF ((%line =~ @EndLine)|(%concat(%line,"$")=@EndLine)) {#SET CaptureLines 3 1} {<"<">@LineCapCommand>}} {looplines|param=99|notrig|disable}
#COND "CaptureLines" {} {#NOOP This state is here in case user error caused 99 lines to be captured;#ECHO Warning multiline capture has been active for 99 lines, EndCapCommand not run.;EndCapCommand="";#SET CaptureLines 3 1} {disable}
#COND "CaptureLines" {} {#STATE CaptureLines 0;#RESET MultiLineCap;#T- CaptureLines;#IF (@EndCapCommand) {<"<">@EndCapCommand>}} {manual|disable}
#CLASS 0

The first command creates an alias by the name of example to show how to use the script.  The alias sets all the variables, turns on the capturing trigger, and then echos some example text.

The trigger's first state has a pattern of @StartLine this allows a customizable beginning point, but can not handle wild cards in the pattern.  It then checks to see if the user set @StartCapCommand, and executes the commands it contains by using the <> shortcut. Because anything contained in <> is expanded in the command line, even when used in a literal argument, the opening angle bracket is changed to <"<"> to allow you to copy the whole example to the command line.

The second state is a Loop Pattern type.  It has a blank pattern and will match any line.  First it checks to see if the received line matches the pattern contained in @EndLine, next it checks to see if with a $ added it exactly matches.  This type of matching is used because a null pattern matches everything.  Note the example uses "$" to pick up a blank line.  When the ending line is matched it activates the trigger's final state.  When it doesn't match the user defined @LineCapCommand is executed.

The third state is there as a protection.  The #NOOP is used to hold a comment, and all the state does is provide a warning message then clears the EndCapCommand variable and runs through its deactivation by activating the final state.

The final state is of type Manual.  This type does its script immediately upon activation with the #SET command.  The script for this state sets the trigger back to the first state, clears all variables in the class, then deactivates the entire trigger, and does user commands.

ButtonsbuttonsButton States
[Button States tab] [States tab] [Position/Size tab] [Advanced tab] [Gauge tab]
This Settings Editor dialog page allows you to edit the properties of a Button.
The Kind pulldown sets the type of button.  Here are the available button types:
Push
Sets the button to be a simple push buttons.  A push button has a single state and simply executes the Commands when the button is clicked
Toggle
Toggle buttons have two states: On and Off.  Select the state you wish to edit from the State field.  Each state has its own caption displayed on the button, and commands to execute when the state changes.
Separator
Not really a button, but simply adds a spacer to the button bar to separate other buttons.  Control the width of the separator in the Position/Size tab.
Multistate
Allows you to assign a menu of multiple states to a button.  When this is selected, you will also be able to select the number of states for the button.
Menu
Similar to a Multistate button, but the button states come from a menu class.  The name of the menu class is put into the Value field.
Gauge
Displays an expression graphically on a visual gauge bar.
For each possible button state, the button has a caption and a set of commands that are executed when the button is pressed.  You can change the color of the caption using the Color button to the right of the caption field.  zMud variables and functions can be used in the caption of buttons to further change the text they display.
If the Style is set to Script, the syntax editor will check the syntax and report any errors.  If the Style is set to Text, you can edit the button commands without performing any syntax checking.  If Style is set to VBScript or JScript then the commands will be sent to that script processor.  Note: VBScript an JScript use the #SS command internally, if you change to another style you will have to remove that change manually.

States TabButtons States List Tab
[Button States tab] [States tab] [Position/Size tab] [Advanced tab] [Gauge tab]
This Settings Editor dialog page allows you to edit the properties of a Button.
This tab displays all states for the button, and the caption for that state.  You can edit the captions, Insert or Delete states by right-click menu, and rapidly create additional states for a Multistate button by merely typing another caption at the last line.

Button PositionButton PositionButton Position/Size
[Button States tab] [States tab] [Position/Size tab] [Advanced tab] [Gauge tab]
This Settings Editor dialog page allows you to edit the properties of a Button.
To set the button to the default width and height, select the Auto Size option.  Otherwise you can turn this option off and select your own width and height for the button.  The button on the MUD Window will be updated as you change the size or position if you have the "Show Changes" option selected.
If the button bar is along the top or bottom of the window, buttons are normally displayed to the right of the previous button.  If the button bar is along the left or right edges of the window, buttons are normally displayed below the previous button.  You can change this by turning off the "Auto Position" option and specifying the button position manually.
Selecting a Panel location of None turns off the display of that panel number in the MUD window.  There are four independent button bars for each MUD window.  The Panel value indicates which of these button bars the current button should be displayed on.  You can then change the alignment of each panel from Top, Left, Bottom, or Right side of the MUD window.  Definition of Panel positions can not be exported at this time, but exported buttons will hold thier panel number.

Advanced ButtonAdvanced ButtonAdvanced Button Properties
[Button States tab] [States tab] [Position/Size tab] [Advanced tab] [Gauge tab]
This Settings Editor dialog page allows you to edit the properties of a Button.
The ID field allows you to assign a short name to this button.  This allows you to manipulate the button using the ID instead of the button number.  This is useful with the %btncol, %btnenable, and %btnimage functions.
If a Variable name is assigned to a button, zMUD automatically sets the variable value whenever the button state changes and whenever the variable changes the button state will change and commands for that state will execute.  For toggle buttons 0=off, 1=on.  For multistate buttons, main caption state has a value of zero, and all other states are numbered according to thier order.  You can use the Default field of the Variable to specify the startup state of a button.  Note that using this method will execute commands before a connection to the mud is established.
The Value field is used to specify an expression that determines the state of the button.  When using the Value expression, you cannot activate the button manually...it is only updated under zMUD control and turned on when the expression is true, and turned off when the expression is false.  Using this field with buttons of any type other then Push can produce unpredictable results.
The Bitmap file allows you to assign a .BMP file as the icon for the button.  You should normally use BMP files with only 16 colors.  The Bitmap Margin field specifies the spacing between the bitmap and the caption of the button.  The pulldown icon to the right of the Bitmap field allows you to select from one of the builtin images within zMUD.  There are over 100 builtin images.
The ToolTip property assigns a help string which is displayed whenever the mouse hovers over the button.  This property is expanded whenever you change the value of a scripting variable, so you can use @varname syntax.  However, it will not evaluate every time you pass the mouse over it, so predefined variables will not be updated by simple mouse-over.
Explorer Style
The Explorer-style option sets up a button that is normally flat.  When the mouse is moved over the button, the border of the button is displayed.  This is similar to buttons in the File Explorer in Windows.  
Icon on Top
The Icon on Top option determines whether the Bitmap icon is shown to the left of the caption or on Top of the caption.  
Inset
The Inset option determines whether a rectangle is drawn around the button to make it look inset into the panel.  
Align Right
The Align Right option determines whether the button is aligned to the left or right part of the button bar by default (or the Top and Bottom if the button bar is along the left or right side of the screen).  
Stack
The Stack option forces the button to be stacked below the last button, instead of placed to the right of the previous button.

Gauge tabGauge options
[Button States tab] [States tab] [Position/Size tab] [Advanced tab] [Gauge tab]
This Settings Editor dialog page allows you to edit the properties of a Gauge.
Gauge Value
The expression used to determine the current value of the gauge.
Gauge Max
The expression used to determine the maximum value of the gauge.
Gauge Low
The expression used to determine the low point of the gauge.  If the value of the gauge is less than the Gauge Low expression, then the gauge uses the Low Color, otherwise it uses the normal Gauge Color.
Gauge Backg
This is the color that will fill empty portions of the gauge.

Directionsdirectionsdirections,editingDirections
This Settings Editor dialog page allows you to edit the properties of a room exit or Direction.
Each direction must be assigned to a single speedwalk character, listed in the Direction field.  In order to reverse walk a path, you must also specify the speedwalk character of the reverse direction in the Reverse field.  In the Commands field, enter the MUD commands that are used to specify the direction.  If you want more than one command to trigger the given direction, separate the multiple commands with a vertical bar (|).  For example, if you want the commands n and north and nor to trigger the n direction, put n|north|nor in the Command field.  In the Map field, select the mapper direction that corresponds to this MUD direction.
Tip:  Sometimes you need to open a door while executing a path.  To do this, define a new direction with the character o in both the Char and Reverse Char fields, and then put open door in the Input Field.  Now when you are recording a path and you enter open door, the character o will be added to the path.

Tab Completiontab completiontab completion,editingTab Completion
This Settings Editor dialog page allows you to edit a tab completion word.
The Word field contains the tab-completion word.  These words are automatically expanded on the command line if you enter the first few unique characters and then press the <TAB> key.
Dynamic Tab Completion
A second type of tab completion is used with the Shift-<TAB> key.  The last word larger than the Tab Limit (in the Preferences) that was last displayed in the output window that starts with the last character in the command line is recalled into the command line.  For example, if someone with a really complicated name such as Xenafragilicious talks to you, you can enter the X character into the command line and press Shift-<TAB> to recall the entire word.  You do not need to store words in the settings editor for dynamic tab completion...it is performed automatically.

Speed Menumenusmenus,right-clickspeed menuSpeed Menu
This Settings Editor dialog page allows you to edit the properties of a Speed Menu item.
The Speed Menu is the menu that is displayed when you right-click on the output window.  The Name field contains the name of the menu item.  This value can contain variables or functions since it is parsed before being displayed in the popup menu.  The Commands field gives the commands executed when this menu item is selected from the right-click menu.
To select a default item to execute when you double-right-click on the MUD window, select the "Make this the default" item.  Otherwise you should select the "Use last selected item" to execute the last menu item selected when you double-right-click on the MUD window.
The %selline and %selword variables are very useful in the definition of menu items since they indicate the word and line that were right-clicked.  For example, the definition:
kill %selword
will issue the kill command to the MUD along with the word you right clicked on.  Thus, if you set this as the default action, and double-right-click on the name of a mob, that mob will be killed.  This beats typing in the name of the mob.
If the Style is set to Script, the syntax editor will check the syntax and report any errors.  If the Style is set to Text, you can edit the menu commands without performing any syntax checking.  If Style is set to String List, you can easily edit a list of submenu items for this menu.  Each command in the list will correspond to a string in the Caption string list.  If Style is set to VBScript or JScript then the commands will be sent to that script processor.  Note: VBScript an JScript use the #SS command internally, if you change to another style you will have to remove that change manually.
Submenus
To add an entire submenu to a menu, there are two methods.  First, you can simply use a string list to define the different captions and commands for the menu.  The first caption in the string list will be the menu caption.  The other captions in the list will be the captions of the submenu items.  For example, the caption:
Sort|First Name|Last Name
will define a menu item called "Sort".  This menu will contain a submenu with the two items: "First Name" and "Last Name".  If the Script command was
do first name|do last name
then the command "do first name" would get executed when the "First Name" item was selected, and the "do last name" command would get executed when the "Last Name" item was selected.
Instead of using a string list in the command field, you can define a common command for all items in the submenu.  You can use the system variable %caption to refer to the caption of the item selected.  For example, the command
%caption was selected
would display "First Name was selected" if the First Name item was selected in the submenu.
Menu Classes
The second and more flexible way to define submenus is using a menu class.  A menu class is a special class folder that is marked to contain a submenu.
Normally, zMUD searches through all enabled classes folders and puts all of the menu items that it finds into the popup menu.  However, when zMUD sees a class marked as a Submenu (changed in the Editor for the class folder itself), zMUD skips that folder and does not include the items that are contained within it.  Only when zMUD gets to a menu item that gives the name of the folder in the Subclass field does zMUD then retrieve the menu items stored in that folder.
So, for example, let's say you have the following:
Class: Main
Menu item: Item 1
Menu item: Item 2
Class: Combat
Menu item: Item 3
Menu item: Item 4
If the class Main and the class Combat are both enabled, the right-click popup menu will contain Item1, Item2, Item3, and Item4.  If you disable the Combat class (using #T- Combat), then the popup menu would only contain Item1 and Item2.
Now, let's say you enable both classes, but you mark the Combat class as a Submenu class.  Now the popup menu will only display Item1 and Item2, whether or not the Combat class is enabled or disabled.
Next, if you go to Item 2 and enter "Combat" for the subclass name, you'll now get a popup menu with Item1 and Item2, but Item2 will be shown as a submenu.  When you select Item2 you'll see the submenu with Item3 and Item4 in it.
Using this flexible method of creating menu classes, you can have as many nested levels of menus as you want.

Status Window definitionstatus windowStatus Bars/Window
This Settings Editor dialog page allows you to edit the properties of the status bar and status window.
The Status Line field shows the definition of the status line.  The Window field shows the text displayed in the status window.  Expansion is preformed on both of these fields at the time of display, and everytime a variable is changed the display will update.  You can have several status bar and window definitions, grouped into different classes.  All currently enabled status bar and status window definitions are appended together to form the actual display.
The ID field allows you to assign a name to the Status Setting, so that you can modify the specific setting within a script.
If the Style is set to Script, the syntax editor will check the syntax and report any errors.  If the Style is set to Text, you can edit the status window value without performing any syntax checking.  If Style is set to VBScript or JScript then the commands will be sent to that script processor.  Note: VBScript and JScript use the #SS command internally, if you change to another style you will have to remove that change manually.

Menu Referencereferencereference,menuMenu Reference
Click on the menu command that you want help on.  

File
Open		connect to a new character or host
Reconnect		reestablish connection to current character
Disconnect	disconnect from the current session (must be connected for this item to display)
Close Window	disconnects and closes current window
Close All		close all of the MUD windows and return to the character selections screen.
New Log		open a new log file (same as using #LOG filename new command)
Append Log	append to an existing log file (same as using #LOG filename command)
Log			toggle logging state (same as using #LOG command)
Close Log		close a log file (must have a log file open for this item to display)
Print Setup	setup the current printer
Print		print the current screen, buffer, or selection.  You can also toggle color or B&W.
Exit		disconnect from MUD and leave the program
Edit
Cut			cut text from the input command line
Copy		copy selected text from the input command line
Paste		paste text into the command line
Copy DDE link	copy DDE link information into clipboard
Select All		select the entire contents of the command line
Clear		clear contents of command line
Find		search for a string in the scrollback buffer
View
Preferences	View/edit General, colors, fonts, sounds, special characters, memory, directories.
Statistics		Displays information about the current connection
Classes		View/edit Class settings
Aliases		View/edit Alias settings
Variables		View/edit Variable settings
Paths		View/edit speedwalking paths
Triggers		View/edit Trigger settings
Macro keys	View/edit Macro key settings
Buttons		View/edit Button settings
Tab Completion	View/edit tab completion words
Speed Menu	View/edit speed menu settings
Directions		View/edit speedwalking directions
Status bars	View/edit status bar and status window settings
All Settings	display the settings editor for all settings
Settings
New		clear all settings
Load		load settings from a file
Save		save settings to a file
Save As		save settings to a different file
Edit Settings	edit your current character settings
Global Settings	edit the global settings that control the main menu and toolbar
Import		allows you to import zScript, ASCII, or TINTIN++ script files
Export		Allows you to export macros, aliases, triggers, etc in ASCII format for later importing.
Parse		toggle parsing of command line
Enable Triggers	toggle whether triggers are enabled
Actions
Make Alias		create an alias
Record Alias	record an alias from the command line
Record Path	displays a record path dialog, this dialog automatically updates as you walk
Speed to Path	manipulate paths and control speed walking
Make Trigger	create a trigger action
Define Macro	assign a command to a key
Make Button	create a new button
Add Tab Word	add word to tab completion list
Define Status bar	edit the status bar and status window settings
Tick Timer	manipulate the tick timer
Synch Timer	resynch the tick timer
Send file to MUD	send a text file to the MUD
Execute script	load a text file and execute each line as a script
Layout
AutoTile		set zMUD to automatically tile (dock) new windows as they are created
QuickTile		rearrange all of the current windows and tile (dock) them as needed
Fullscreen		maximize the current window to cover the entire screen
Maximize		maximize the current window but don't cover the menu window
Save Layout	save the current window layout, including docking configuration
Split Window	split the window to view the scrollback buffer
Bring to Front	bring the current MUD window to the front of the screen
Clear Window	erase the screen (but not the scrollback)
Empty Scrollback	clear screen and scrollback buffer
Reset Windows	resize and reposition selected/all windows and bring them to the front of the screen
Windows
AutoMapper	display the automapper window
Command History	display the command history
Database		display the database window
Debugger		display the debugger window
Editor		open the full-window command editor
Status		display the status window
Plugins
Install Plugins	control which plugins are loaded
Help
Contents		show table of contents
Search		search the online help database
Reference		display command reference
Getting Started	display the Getting Started help section
Tutorials		display tutorials in your web browser
Command Wizard	get help and examples of zmud commands
Function Wizard	get help and examples of zmud functions
Check for new version	Query the remote server to see if a new version of zMUD is available.
zMud web page	links to http://www.zuggsoft.com/zuggsoft/zuggsoft.htm
zMud Support Forum	links to General Discussion Forum
Send Feedback	send feedback to the author of zMUD
About		version, credits, and copyright info
[Window] this menu is specific to each window
Task Bar Icon	toggle whether icon for window is displayed in task bar
Dockable		determine if the current MUD window is dockable
Transparent	allows you to set the window partially see through (requires Windows 2K/XP)

Command Referencecommandscommands,referencereferencereference,commandsCommand Reference
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Each command should be preceded by the Command character.  The default command character is # but can be changed in the Preferences dialog.  You can abbreviate each command using the letters shown in boldface.
Loop Structures
#number repeat following text number times
REPEAT repeat commands a given number of times
LOOP execute command several times in a loop
FORALL loop through a string list and execute command for each item
UNTIL execute commands until expression is true
WHILE execute command while expression is true
LOOPDB loops through key values in a database record
LMAP loop through rooms on the map
PRIORITY execute list of commands without processing MUD input
ABORT abort further parsing of the current loop or program block
Conditionals
IF perform a conditional test
CASE select a command from a list
Triggers
ACTION create or display a trigger action
TRIGGER create or display a trigger action
CONDITION add a new state to a trigger
ALARM create an alarm trigger
TEMP create a temporary trigger
ONINPUT create a command input trigger
MXPTRIG create a MXP trigger
REGEX create a unix regular expression trigger
SET set a trigger state
STATE change the current trigger state
Trigger related commands
COLOR change color of the last line of text
CW color the matched word on the last line
PCOL color part of the line
HIGHLIGHT highlight the last line of text
GAG remove last line from screen
UNGAG prevent the line from being gagged
GAGON turn on gagging of text
GAGOFF turn off gagging of text
GAGBLOCK gag a block of text
SUBSTITUTE replace matching text
PSUB substitute text in part of the line
T+ turn on a class or specific trigger
T- turn off a class or specific trigger
CLASS enable or disable a class
SETPROMPT capture values from the MUD prompt
Create/modify settings items
ALIAS create or display an alias
GALIAS create a global alias
RECORD record an alias
PATH save or display the current path
VARIABLE assign a value to a variable
GVARIABLE assign a value to a global variable
FUNCTION create a user-defined function
MATH perform complex math and expression parsing
ADD add a value to a variable
BUTTON trigger a button
GAUGE create a graphical gauge button
KEY define a macro key
STATUS set the definition of the status bar
STW set status window definition
TAB add word to tab completion list
RENAME rename an alias, variable or path
MENU add a speed menu item
DIR add a direction setting
SUSPEND pauses an alarm or wait trigger
RESUME unpuases an alarm or wait trigger
EDITOR edit a given setting
Remove settings items
UNALIAS remove an alias
UNBUTTON remove a button
UNCLASS removes a class
DELCLASS removes a class and deletes settings
UNKEY remove a macro key
UNTRIGGER remove a trigger
UNVAR remove a variable
UNMENU remove a speed menu item
UNDIR remove a direction setting
UNTAB remove a word from the tab list
KILLALL delete all aliases, macros, trigger actions, tab-completion words
Tick Timer
TIMER toggle the timer
TS set the time or origin of the timer
T? display time remaining in timer
TZ zero the tick timer
File Commands
FILE open a file for reading and writing
READ read and execute a script from a file, or read a record from a file
WRITE write a record to a file
ERASE erase a file from the disk
RESET reset the file back to the beginning.
CLOSE close a file
SEND send a text file to the MUD prefixed by a command
TYPE display all or part of a text file to the screen
LOG start a log file or toggle logging
FTP perform file transfers using FTP
IMAGE display an image in a popup window
Debugger Commands
BREAK causes a breakpoint, which stops execution of script and loads the debugger
WATCH adds an expression to the debugger Watch List
UNWATCH removes an expression from the debugger Watch List
Automapper commands
CONFIGURE change the configuration of the mapper
NODIR remove last direction from mapper queue
NOMAP prevent the matched line from being parsed by the mapper
OK confirm a mapper movement
DOOR create a door on the map
MAKEROOM create a new room on the map
MERGE merge rooms on the map together
MOVE move a direction on the automapper
TELEPORT teleport to a location on the map
LOOK reload description of current room on map
FIND find current location on map
MAPQUERY display the Find Room results based upon a query
RECALL teleport to recall location on map
WALK speedwalk to a marked location on the map
LMAP loop through rooms on the map
TAG override the normal automapper detection
DESCRIBE displays the room name, description, and exits
PATHHIGH will highlight a path on the map
PORTAL add a new portal to the mapper
UNPORTAL remove a portal
Speedwalking commands
MARK mark the beginning of a path
PATH save or display the current path
MAP add a direction to the current path
BACKUP remove last direction from current path
RETRACE retrace a path
SLOW execute a path in Slow Walk mode
STEP resume an aborted Slow Walk and step ahead
STOP abort a Slow Walk
OK confirm a Slow Walk step
PAUSE pauses a Slow Walk
Window/Multiplaying commands
SAY echo text to the screen
SHOW echo text to the screen
ECHO echo string to current MUD window
SEND send text to the MUD
SAYPROMPT echo text without newline
SHOWPROMPT echo text without newline
ECHOPROMPT echo text to current window without newline
SENDPROMPT send text to the MUD without a newline
SHOWARR display an array on the screen
NAME change the name of the current window
WINDOW open a new window
MAKEWINDOW create a new window, or redirect text
CLOSE close a window
ALL send a command to all windows
CAPTURE capture lines and send them to the editor or a window
C+ start capturing to a window
C- stop capturing to a window
CLR clear the screen
WRAP set word wrapping
FREEZE split the screen to view scrollback
CR send a new line
IMAGE displays an image file on the screen
MXP send a line to the screen containing MXP commands.
User interface I/O
MESSAGE display a message in a small window
PROMPT prompt for the value of an alias/variable
PICK select commands from a list
YESNO Display a confirmation dialog with buttons
AFK displays a password prompt window and locks zMUD until password is entered
Sounds and external applications
BEEP beep the speaker (or play a wave file)
PLAY play a wave, midi, avi, cd player, or other multimedia
MEDIA send commands to your multimedia device
LAUNCH launch another application
COM execute a method of a COM object
CALL execute a method of a COM object (different syntax from #COM)
URL open URL in your Web Browser
DDE send a DDE macro to a server.
PLUGIN load and unload plugins in memory
Scripting GUI features
MENU execute a menu command
VERBATIM toggle parse mode
IGNORE toggle the processing of trigger actions
HISTORY display the history of previous commands
H+ retrieve the next command in the history buffer
H- retrieve the previous command in the history buffer
INPUT put text into the command buffer
SCROLL display matching lines in scrollback buffer
Session and Character settings
SESSION open a new session
CONNECT reconnect to the current session
DISCONNECT disconnect from the current session
CHARACTER returns the name of your character
PW return your current password
HOST return the name of the current host
Settings and Special Characters
LOAD load a settings file
SAVE save the current settings file
DEFAULT save special characters and reset them to defaults
NODEF restore special chars saved with #DEF
String List Commands
ADDITEM adds an item to a string list
DELITEM deletes an item from a string list
DELNITEM delete the nth item from a string list
Database Variable Commands
ADDKEY adds a keyword and property to a database record
DELKEY deletes a keyword from a database record
SHOWDB displays a database record
LOOPDB loops through key values in a database record
Database Commands
DBLOAD opens a database
DBCLOSE closes a database
DBSAVE saves a database
VIEW sets or defines a database view
FIND filters the database view to find items
QUERY filters the database view to find items
DBRESET resets the view filters
DBGET sets the current database record to a given record
DBPUT stores new values in a database record
DBFIRST sets the current record to the first in the view
DBNEXT sets the current record to the next in the view
DBPREV sets the current record to the previous in the view
DBDELETE deletes a record in the database
LOOPVIEW loop through records in a view
NEW create a new database record
DBOFFLINE work in editor without effecting user interface
DBONLINE work in editor and effect user interface
Miscellaneous
ABORT abort further parsing of the current command line
WAIT delay further processing until next line is received
NOOP nothing
EXEC execute a command
FTP preforms FTP tasks
MSS execute an external script
SCRIPT defines external script
SS defines and executes external script
EVAL evaluate an expression
Leftover TinTin compatibility
VERSION display the current version of zMUD
WIZLIST display the credits for zMUD
HELP get help on commands
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The following functions are defined within zMUD:

Color/Appearance:
ansi return the ANSI codes for the given colors
btncol change the color of a button
btnenable change then enable state of a button
btnimage change the image assigned to a button
color converts a descriptive color into an attribute value
colorname converts an HTML color name to an RGB color value
DDE:
ddeopen open a DDE connection to the specified server and topic
ddeclose close a DDE connection
dde fetch data from a dde server
ddemacro tell the specified dde server to execute the macro in s
ddepoke poke the data in value to a dde server
Lists:
ismember return the word number if s is a member of the given string list, otherwise it returns zero (false)
additem add the string s to the specified string list.  Duplicate items are allowed
delitem delete item s from the given string list.  If there are duplicate items, only the first is removed
delnitem removes the nth item from a string list and returns the new list
replaceitem replaces the nth item in a list
item returns the nth item of the given stringlist
numitems returns the number of items in a stringlist
dups return the list with duplicate items removed
sort returns the list with items sorted in alphabetical order
push adds an item to the start of the list
pop retrieves the first element of a list and removes it from the list
expandlist allows reformatting of a list
Database functions:
db returns the value of the key property of the given database record
iskey returns the key number if the key exists in the record, otherwise returns zero (false)
addkey add a key-value pair to a database record and return the modified record
delkey deletes a key property from the given database record and return the modified record
numkeys returns the number of keys in a database record
countlist count the number of times each item appears in a string list and return a database record with the items as key properties, and the count of each item as the value of the key
dbget retrieves a database record
find returns a list of records matching a query
query returns a list of records matching a query
viewrec returns the specified record from the view
numrec returns the number of records in a view
expanddb allows reformatting of a database variable
Database column functions:
sum return the sum of a column
average returns the average of a column times 100
stdev returns the standard deviation of a column times 100
dbmin returns the minimum of a column
dbmax returns the maximum of a column
count returns the number of non-empty cells in a column
dblist returns the column as a string list
String Manipulation:
len return the length of the string s
pos return the position of pattern p in string s.  Return 0/false if not found
match return the position of string s in trigger pattern p.
regex return the position of string s in regular expression p.
subregex substitute a regular expression in string s with a new string
begins true if string s1 starts with string s2
ends true if string s1 ends with string s2
concat return all strings concatenated together (up to nine parameters)
copy return a portion of string s, starting at character position i, and returning n characters.  Strings are 1-based.
delete return the string s with n characters starting at position I deleted.
remove Remove substring p from string s
insert return the string s with pattern p inserted at position I.
replace return s with all occurrences of p replaced with r
subchar replace a list of characters in a string with a new list
left return the leftmost n characters of the string s
leftback return the leftmost part of s, n characters from the end
right return the rightmost part of s following n characters
rightback return the rightmost n characters of the string s.
repeat return s repeated n times
trim trim spaces from beginning and end of s
trimleft trim leading spaces from s
trimright trim trailing spaces from s
numwords return the number of words in the string s delimited by the substring d.  Default for d is a space.
word return the ith word of the string s delimited by substring d.  Default for d is a space.
stripansi removes ANSI control codes from a string
stripq removes internal quotes from a string
nltocr converts newlines (CR/LF) to just CR characters
crtonl converts CR to newlines (CR/LF)
String Formatting:
upper return the string s in uppercase
lower return the string s in lowercase
proper convert s to proper case (lowercase except for first letter)
quote returns the string s with any special characters quoted with the current quote character
format use a format string to format the values of a,b,c, etc.  
time return the current date/time. 
Arrays:
array create an array
arrget get an element from an array
arrset set an array element to a value
arrhigh return the highest index of an array
User Input:
prompt prompt the user for a value for the variable v. 
pick display a picklist and let the user choose one or more strings from the list. 
yesno Displays question in string s and returns true or false depending upon which button is clicked. 
window return true if the named window is open
File I/O:
filesize returns the number of lines or number of records in the ith file (opened with the #FILE command)
grep search the ith file and return lines that match the pattern in s
read read the specified record from the ith file. 
write write string s to the ith file at record rec.  
Math:
abs return the absolute value of I
max return the maximum value of the parameters
min return the minimum value of the parameters
mod return a modulus b
sqrt returns the square root of a number
random return a random integer
bitand returns the bitwise AND of the two numbers
bitor returns the bitwise OR of the two numbers
bitxor returns the bitwise XOR of the two numbers
bitnot returns the bitwise inverse of the number
Dice functions
dice returns a random dice roll
dicemin returns the minimum possible dice roll
dicemax returns the maximum possible dice roll
diceavg returns the average roll of a dice
dicedev returns the standard deviation of a dice
Conditionals:
if if expression is true, return the true-value otherwise return the false-value
case if I=1, return s1, if I=2, return s2, etc.  Up to 8 strings can be given
Type checking and conversion:
float converts item to floating point number
int converts item to integer
isfloat returns true if item is a floating point value
round converts item to integer, but rounds instead of truncates
norm normalizes a floating point value
string converts item to a string
defined returns true of s is a defined alias, variable, macro, or path
isnumber true if s represents a valid number
null return true if s is the null string
number convert a string to a number
ascii returns the ascii value of the first character of the given string
char return the ASCII character associated with the number I.  This function is also used to translate the system characters (;:@%!.) to their current values if they have been changed.
COM/OLE:
comcreate creates a new COM object and returns it
comactive returns an existing COM object already running on the system
comget returns a property value for a COM object
comset sets a properly value for a COM object
Miscellaneous:
alias expand the value of alias s
expand expand variables and functions with the string s
literal returns the parameters untouched by expansion or evaluation
numbuttons returns the number of defined buttons
trigger return the state of the given trigger class
class return the state of the given class
state returns the current state number of a trigger
clip return or set the text in the clipboard
exec executes arguments as commands and returns results separated by | character
eval evaluate parameter p as an expression and return the result
numparam returns the number of parameters passed to an alias
param return the nth parameter passed to an alias
getglobal return the value of global variable name (stored in the INI file)
setglobal set the value of the global variable name (stored in the INI file)
handle returns the Window handle number of the named window
mss evaluate an expression with external scripting agent
gsl return last value sent in GSL tag
mcp return the last values sent in an MCP command
alarm set or return the time left on an ALARM in milliseconds
Characters:
charcomment set/retrieve the comments for the current character
charnotes set/retrieve the notes for the current character
AutoMapper functions:
lastdir Returns the current direction on the mapper command stack
destroom Returns the key value of the destination room of the last speedwalk.
walkroom Returns key value of current room executing Walk script.
maplocked Return or set the lock state of the map
mapfilter Return or set the current filter for all map functions
mapquery Execute an SQL search and return a string list of matched room IDs
roommode Return or set the mode for map functions
inwalk Returns true if there are still speedwalk directions to be processed
walkactive Returns true if speedwalk is not paused or stopped
walkconfirm Returns true if step confirmed by #OK
parsemode Returns or set the fashion in which speedwalk paths are processed
look sets or returns the "look command" used by the mapper
numrooms Return the number of rooms in the current zone
roomname Return or set the name of the room to string s
roomdesc Return or set the description of the room to string s
mapvnum Converts an absolute room number to a virtual room number
roomvum Converts an absolute room number to a virtual room number
pathfrom Returns a path from one room to another
pathexpand Expands a speedwalk path to a string list
pathcompress Compress a string list into a speedwalk path
pathreverse Reverses a speedwalk path
reversedir Reverses a direction command
portal Return or set the destination of a portal
portalenabled Return of set the status of a portal
nextdir Returns the next direction to be sent in a speedwalk
roomnum Returns or set the virtual number of a room
roomzone Returns or set the zone number of a room
roomcontents Returns or set the contents of a room
roomid Return or set the short name (ID) of the room to string s
roomcom Return or set the command assigned to the room to string s
roomcol Return or set the color of a room
roomnote Return or set the Notes of the room to string s
roomexit Return or set the exit string of the room to string s.
roomobj Return or set the number of objects in the room to i
roommob Return or set the number of mobs in the room to i
roomcost Return or set the cost of entering a room to i
roomkey Return the key number of room i
roomkind Return or set the type of the room to i.
roomload Return or set the Reload flag of the room to i
roomflags Return or set the user-defined flags for a room
roomlink Return or set the link in direction dir to the room number i.  
roomportal Return or set a non-standard exit (portal).  
doorname Return the name of a door in a given direction
walk Return the speedwalk string needed to get to room i
walkmode Return or set the current speedwalk mode
numzones Return the number of zones in the map
zonename Return or set the name of the zone to string s
zonenum Return the number of a zone
zonevnum Return the relative number of a zone
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The system maintained several predefined variables for you to use:

%action	the action executed from the last trigger
%caption	returns menu caption for speedmenus created by list format
%char	the name of your MUD character
%class	name of current default class
%cr	a carrige return character
%crlf	a carrige return and a linefeed character, together they are called newline
%lf	a linefeed character
%ctime	the number of seconds you have been connected to the MUD
%curwin	the name of the active MUD window
%def	current list of special characters
%host	the host name of the current MUD
%i		same as %repeatnum
%ioresult	the result of the last I/O command, 0 if it was successful
%ip	the current IP address of your computer
%key	the current key value of a record variable within the #LOOPDB command
%lastcom	the last command executed
%lastcom2	the command before the last command executed
%lastcom3	the command before %lastcom2
%lastinput	the last line of commands executed
%lastin2		the line before the last line of commands executed
%line	the last line received from the MUD
%line2	the line before the last line received
%line3	the line before the line before the last line received
%linecol	color attribute of the first character in the current line
%mud	retrieve an MXP entity (variable).  For example %mud.hp would retrieve the entity called "hp"
%mxp	retrieve arguments from MXP tag within an MXP Trigger.  For example, <COLOR red> results in %mxp.fore="red"
%names	returns a string list of all open window names
%null	an empty variable value
%param1	the first parameter from the last trigger match
%param2..%param99	the parameters from the last trigger match
%port	the current port connected to
%random	a random number from 0 to 99
%rec	the current database record
%repeatnum	the current index during repeating commands, or loop command
%secs	the number of milliseconds since midnight
%selected	returns the text currently selected in the output or command buffer
%selline	returns line that was right-clicked on
%selpos	returns column number that was right-clicked on
%selword	returns word that was right-clicked on
%session	the current zMUDSession COM object for the current window
%tick	returns the number of seconds on the tick timer
%title	the title of the current MUD
%trigger	the line that caused the last trigger
%val	the current value of a record variable key within the #LOOPDB command
%version	current version of zMUD.  For example, v5.30 is returned as 530
%window	the name of the current window
%zmap	returns whether the zMapper program is active as a plugin
%zmud	the global zMUDApplication COM object
%1..%99	the patterns enclosed in () saved by the trigger or parameters passed to an alias
%%1..%%99	used to keep %nn from being expanded when creating a setting and with =~
%t1..%t99	the patterns enclosed in () from any trigger state saved by the trigger
%x1..%x99	the XStart and XEnd positions of patterns matched in the trigger
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zMUD implements full expressions.  Expressions can contain variables, and most common operators.  Parenthesis can be used to override default operator precedence.  When evaluating an operation, if all parameters of the operation are numeric, then a numeric operation is used, otherwise a string operation is used.  The following operators are recognized (v1 and v2 represent variables, or other expressions).  The list is in precedence order, with the highest precedence operators at the top.

!v1		return the logical NOT of value1
not v1		same as above
-v1		return the negative of value1
v1 * v2		multiply value1 by value2
v1 / v2		divide v1 by v2.  Any fraction is discarded.
v1 \ v2		divide v1 by v2 and return the modulus
v1 + v2		add value1 to value2.  If values are not numeric, the text values are concatenated.
v1 - v2		subtract value2 from value1
v1 = v2		true if value1 is the same as value2
v1 > v2		true if value1 is greater than value2
v1 < v2		true if value1 is less than value2
v1 >= v2		true if value1 is greater than or equal to value2
v1 <= v2		true if value1 is less than or equal to value2
v1 <> v2		true if value1 is not equal to value2
v1 != v2		true if value1 is not equal to value2
v1 =~ v2		true if the string v1 matches the pattern in v2
v1 & v2		returns the logical AND of value1 and value2
v1 and v2	same as above
v1 | v2		returns the logical OR of value1 and value2
v1 or v2		same as above
v1 xor v2	returns the logical XOR of value1 and value2
If the pattern matching=~ operator is used, any saved pattern parameters are available in the true-command or false-command if the expression is part of an #IF.  However, you must use %% in front of the pattern to access wildcards matched by pattern match expression rather than the alias parameters.
The constants: true, yes, on are defined with a value of 1, and the constants: false, no, off are defined with a value of 0.
Keep in mind that the AND, OR, XOR, and NOT operators are logical operators and not bitwise operation. For bitwise operations, use the various bitwise functions in zMUD.  For example: (2 AND 4) is true using the logical operation, but %bitand(2,4) returns zero, which is false!

Pattern Matchingpatternswild cardsPattern Matching
Patterns can contain several special character for wild-card matching.
*		match any number (even none) of characters or white space
?		match a single character
%d		match any number of digits (0-9)
%n		match a number that starts with a + or - sign
%w		match any number of alpha characters (a-z) (a word)
%a		match any number of alphanumeric characters (a-z,0-9)
%s		match any amount of white space (spaces, tabs)
%x		match any amount of non-white space
%y		match any amount of non-white space (same as %x but matches start and end of line)
%p		match any punctuation
%q		match any punctuation (same as %p but matches start and end of line)
%t		match a direction command
%e		match ESC character for ansi patterns
[range]	match any amount of characters listed in range
^		force pattern to match starting at the beginning of the line
$		force pattern to match ending at the end of the line
(pattern)	save the matched pattern in a parameter %1 though %99
~		quote the next character to prevent it to be interpreted as a wild card, required to match special characters
~~		match a quote character verbatim
{val1|val2|val3|...} match any of the specified strings can not use other wildcard inside this
@variable match any of the specified strings or keys works with string lists and record variables
{^string}	do not match the specified string
&nn	matches exactly nn characters (fixed width pattern)
&VarName	assigns the matched string to the given variable (see below for more info)
To save any part of the pattern to the %1..%99 parameters, enclose the part of the parameter in parenthesis.
In specifying a range, you can list specific characters such as [abc] or you can use a range [a-c].
To use a wild card character in the pattern string itself, precede the special character with the ~ quote character.  For example, the pattern ~[test~] will match the string [test] rather than being interpreted as a range wild-card pattern.  Note that the quote character can be changed in the Preferences section.
To match a blank line, use the $ pattern by itself.  To match multiple lines include $ in the middle of the pattern to match the line boundary.
You can also include variables in your pattern, and the name of the variable will be replaced with its value before the pattern match is performed.
Using &VarName
The &VarName syntax deserves a bit more explanation.  It is used to store a matched pattern into a variable directly.  For example, if you have a trigger:
#TRIGGER {You get &Gold coins}
and the MUD displays
You get 1000 coins
Then the value 1000 is automatically put into the @Gold variable with no further action on your part.  By default, the &VarName uses the * wildcard.  To specify a different wildcard, insert the wildcard just after the & character.  In the above example, when the MUD says
You get many coins
the @Gold variable would then contain the string "many".  To restrict the trigger to just match numbers, change the trigger to:
#TRIGGER {You get &%dGold coins}
Now the "You get many coins" will not match the trigger.  You can use any of the wildcard specifiers, and can also use the square brackets [] to define your own wildcard range.
Sometimes there is alphabetic text in the pattern after the string you want to capture.  To delimit this from the variable name, place the variable name in {} brackets.  For example, to capture
You have 1000gp
you would use a trigger:
#TRIGGER {You have &%d{Gold}gp}
which will only match digits and will properly set the @Gold variable to 1000.
The &VarName syntax also works with database records and record variables.  If you have a record variable @char and want to set the Gold property, you would use a trigger of:
#TRIGGER {You get &char.Gold coins}
To set the Gold field of record 7 in the database, you would do
#TRIGGER {You get &7.Gold coins}
To set the Gold field of the current database record, leave out the record number all together with the trigger
#TRIGGER {You get &.Gold coins}
This syntax along with the database provides a powerful way to capture information from the MUD.
NOTE: The patterns matched by the &VarName syntax still count towards the %1..%99 variables and can still be accessed in that manner.  So, in the example:
#TRIGGER {Hp: &HpVar Mana: &ManaVar} {#SHOW %1 %2}
it will automatically set the @HpVar and @ManaVar variables, and the %1 and %2 parameters will also still be set just as if you had put parenthesis around the &VarName.  This is important when you mix &VarName and () in the same trigger.  Always count the &VarName as if it also has a parenthesis around it.

All mapper functions and many commands support using the ShortID in place of vNum.
As vNum's need not be unique it is recommended that %mapfilter and %roommode be used for extensive map scripting.
When %roommode is set ShortID's may still be used in place of roomKey.
When using ShortID current zone is searched first unless the command/function is told to look only in a specific zone.

The first time you log into a new MUD, zMUD tries to automatically detect your character name and password information in order to create triggers to log you in automatically the next time.
If the information shown in this dialog is correct, click Yes and zMUD will create the autolog triggers for you.  If the information is wrong, click No.  If you just created a new character on this MUD, the prompts are different than those given when you log in with an existing character, click No and let zMUD detect the information again when you log in the next time.
If you want to prevent this dialog from appearing, click the Stop Asking button..

black		0
blue		1
green		2
cyan		3
red		4
magenta	5
brown		6
gray		7
yellow		14
white		15
hi		8
bold		128
under		256
blink		512
rev		1024

Foreground is 0-15, background is 0-7*16



A
Advanced Button, 130
aliases, 20, 117
aliases,editing, 117
aliases,introduction, 20
aliases,special, 20
ANSI, 88
auto login, 8, 16
B
Background, 90
Button Position, 129
buttons, 29, 127
buttons,introduction, 29
C
carrige return, 148
character, 13, 114
character database, 14
Character information, 16
character,command, 114
character,creating, 13
character,history, 114
character,movement, 114
character,parameter, 114
character,separator, 114
character,variable, 114
Classes, 116
command entry, 9
Command Parser, 84
commands, 139
commands,reference, 139
conditionals, 150
Connection, 92
Contents, 1
D
directions, 132
directions,editing, 132
Directories, 94
E
Edit Character, 15
Editing your Map, 67
Emulation, 80
expressions, 150
F
features, 3
Files information, 17
fonts, 98
Foreground, 89
functions, 144
functions,predefined, 144
G
getting started, 6
gsl, 109
I
IP Address Lookup, 93
L
Layout, 113
Logging, 81
logging on, 9
login, 8, 16
login,auto, 8, 16
M
macros, 22, 120
macros,editing, 120
macros,introduction, 22
Manual Mapper configuration, 63
mapping, 20, 59, 60, 66
mapping,advanced, 20
mapping,configuration, 60
mapping,usage, 66
Memory, 99
menus, 134
menus,right-click, 134
MSP General, 103
MSP Settings, 104
MUD list, 8
multiplaying, 31
N
Network Setup, 7
New Character, 13
newline, 148
Notes information, 18
P
paths, 73
paths,introduction, 73
patterns, 151
predefined, 144, 148
predefined,functions, 144
predefined,variables, 148
preferences, 77
R
reference, 137, 139, 144
reference,commands, 139
reference,functions, 144
reference,menu, 137
registering, 5
S
settings, 114
Simutronics, 109
slow walking, 100
sounds, 102
spam, 114
Spam Protection, 82
spam,command, 114
spam,count, 114
spam,length, 114
Special Characters, 110
speed menu, 134
speedwalking dialog, 119
Speedwalking with the Map, 74
status window, 136
Syntax, 91
System, 87
T
tab completion, 133
tab completion,editing, 133
tick timer dialog, 111
trigger, 123, 126
Trigger Options, 123
Trigger Testing, 124
trigger,options, 123
trigger,states, 126
triggers, 27, 121, 123
triggers,editing, 121
triggers,introduction, 27
triggers,options, 123
U
User Interface, 78
User Interface Overview, 11
Using Zones, 72
V
variables, 23, 118, 148
variables,introduction, 23
variables,predefined, 148
W
wild cards, 151
windows, 112, 148
windows,naming, 148
wizard, 8
wizard,connect, 8
Word Wrap, 83
 

